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xv 

Before You Begin 

The TapeWare User’s Guide and Technical Reference provides all of the information 
necessary to effectively implement and use all of TapeWare’s advanced features. 
However, we ask you to refer to the TapeWare Installation Guide to install TapeWare. It 
includes system requirements as well as step-by-step instructions. 

TapeWare Documentation 

The following documentation is included with TapeWare to help you install and use all 
of TapeWare’s features and options. 

Note  In the following sections, <dir> represents the platform-specific directory on the 
TapeWare CD-ROM, for example, win (Windows), dos (DOS), lin (Linux) and net 
(NetWare). 

Note  In the following sections, <lng> represents eng (English), fre (French), ger 
(German), ita (Italian), jpn (Japanese) or spa (Spanish).  

Printed Documentation 
The /doc/<lng>/acrobat directory on the TapeWare CD-ROM contains the following 
printed documentation: 

• TapeWare Installation Guide (install.pdf): Contains installation information for each 
supported platform. 

• TapeWare User’s Guide and Technical Reference (usersgd>.pdf): Contains 
information for configuring and using TapeWare. 

• TapeWare Error Code Reference (errcodes.pdf): Lists all TapeWare error codes 
along with possible remedies. 
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• TapeWare Addendum (addendum.pdf): Contains information on additional features 
(English only). 

Note  You can also download these documents from the TapeWare website. 

If you require extra copies of these manuals, you can print the PDF file. They were 
designed to be printed one-sided, with a margin for placing them in a binder. For 
consistency with this manual, the page numbers, page layout, table of contents and index 
are the same (except that the PDF file does not have facing pages or odd/even headers). 

To view or print this documentation, Adobe Acrobat Reader (version 4.0 or higher) must 
be installed on your Windows or X Window (Linux/UNIX) computer. If not currently 
installed, you can install it from the Adobe Acrobat Reader website at 
http://www.adobe.com/products/acrobat/readstep2.html. 

Note  Adobe Acrobat Reader does not offer versions for DOS or NetWare systems. 
Therefore, you can only view or print the TapeWare documentation on Windows or 
X Window (Linux/UNIX) systems. 

To print the documentation, open the appropriate file into Adobe Acrobat Reader. 
Choose Page Setup… from the File menu and set the proper options for your printer. If 
your printer supports it, select the Larger Print Area option. Then choose Print… from 
the File menu and print the document. 

(You can also purchase additional printed and bound copies of this manual. Contact us at 
the numbers listed below for additional information.) 

Release Notes 
Release notes are included with every service pack. Before installing TapeWare, please 
read and print the release notes for additional information. The release notes are available 
in both HTML (/<dir>/read_<lng>.htm) and text (/<dir>/read_<lng>.txt) formats, 
depending on platform. Access the release notes from the directory for your platform on 
the TapeWare CD-ROM. 
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Online Help 
Windows 

To get online help while using TapeWare, select Help Topics from the Help menu. 

For context-sensitive help while using TapeWare: 

• Click on the Help button and then click on the part of the object you want help with. 

• Right-click an object and select What’s this? 

• Use the Tab key to select an area in the TapeWare window and press F1. 

Non-Windows 
You can access online help from most TapeWare screens by pressing F1. 

HTML Help 
You can install the HTML help version of our online help system. Then you can access it 
with a web browser. Please note that TapeWare will not access HTML help topics. 

Note  You can also download the HTML help system from the TapeWare website. 

To install HTML help: 

• Windows: Copy htmlhelp.zip from the \doc\<lng>\htmlhelp subdirectory on the 
TapeWare CD-ROM. Use WinZip or some other file extraction software to unpack it 
onto your computer. 

• X Window (Linux/UNIX): Copy htmlhelp.tgz from the \doc\<lng>\htmlhelp 
subdirectory on the TapeWare CD-ROM. Use tar/gzip or some other file extraction 
software to unpack it onto your computer. 

Note  The HTML help system requires the Java Plug-in. Internet Explorer users must 
enable it. Netscape offers to install the plug-in if it is not installed. 

Note  For best results on X Window (Linux/UNIX) computers, we recommend Netscape 
v6.x. 

To launch HTML help, use your browser to open index.htm. 

 
Help 
button 
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Customer Support 

You can get customer support for TapeWare in one of three ways: 

• Visit our website at www.TapeWare.com and fill out an Online Customer Support 
Form. (For a quick connection, select Web Page from the Help menu.) 

• Fax us at (559) 449-1188. 

• Phone us at (559) 449-8181. Visit our website at www.TapeWare.com for our 
customer support hours. 
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Chapter 1 — TapeWare Overview 

TapeWare provides a powerful, yet cost effective and easy to use, management tool for 
protecting data on network file servers and workstations. TapeWare provides users with 
the capacity to back up and restore data across a network and the ability to administer a 
comprehensive backup plan. 

A complete network backup system consists of three parts: physical peripherals, storage 
management database and backup management program. 

Physical Peripherals 

TapeWare works with your existing computer network. A network connects workstations 
and file servers together in order to allow various users to work together on projects and 
with common files. Networks also allow users to share peripherals, such as disk drives, 
printers, fax machines and modems. Sharing peripherals across a network makes 
economic sense, since multiple workstations can use a single peripheral. Backup devices, 
such as tape drives, which back up or copy files onto tapes or other media, may also be 
shared. 

Sharing a backup device or tape drive makes operational as well as economic sense. 
Rather than back up each workstation individually, a shared backup device on a network 
can back up every workstation and file server on the network. This lowers costs and 
makes it possible to centralize backup operations for the network. Further, a single user, 
such as the network administrator, can have primary responsibility for backing up all the 
file servers and workstations on a network. 

 

For more 
information 
about backup 
device LAN 
location, see 
Strategies for 
Faster Jobs in 
Chapter 10 — 
Tips, 
Techniques 
and Strategies. 
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Backup devices can be 
shared on a network, so that 

you can locate backup 
devices on any workstation or 

file server. 

 
Although sharing a backup device or tape drive on a network makes economic and 
practical sense, it also poses several problems. 

• First, security is an issue. Most networks have elaborate security systems that prevent 
sensitive or confidential data from being accessed by unauthorized users. However, 
unless protective measures are taken, once these files are backed up onto a tape or 
other media, any user in physical possession of the media can gain access to those 
files. Although it is possible to physically store the media in a secure location, a 
complete network backup system will prevent unauthorized viewers from accessing 
confidential or classified information. 

• Second, tracking the location of backed up files is a further issue. While a single user 
may be able to find a file backed up onto a floppy disk by manually searching 
through a stack of disks, this approach is unworkable for large networks. Without the 
appropriate software, locating a given occurrence of a file may be impossible, since 
there may be hundreds of thousands of files backed up on hundreds of tapes created 
over weeks or months. 

Storage Management Database 

To solve the problems of security and tracking files, TapeWare creates and manages a 
storage management database. The TapeWare database keeps track of each tape or 
other media and each file that is on that tape. For each tape, the storage management 
database contains detailed information about the tape, such as when it was created and 
who created it and about the files on the tapes, such as when they were backed up and on 
which tape the file is stored. This is true as well for other media. 

The storage management database also addresses the security complication. Included in 
the database is information about which users can use or view which files. The storage 
management database prevents unauthorized users from accessing files for which they 
have no security clearance. It tracks each user and ensures that only approved users have 
access to files stored on the backup media. 

For more 
information, 
see Managing 
the Storage 
Management 
Database in 
Chapter 10 — 
Tips, 
Techniques 
and Strategies. 
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The database 
tracks jobs and 

media… 

…and handles 
security by 

controlling user 
permissions to 

database objects. 
 

Backup Management Program 

Writing files to the backup media and managing the storage management database 
requires an application program, such as TapeWare. Two of the most important functions 
of TapeWare are managing the storage management database and creating and running 
jobs. TapeWare manages the storage management database to keep track of files and to 
ensure security. TapeWare also creates and runs jobs, such as backup and restore jobs, 
which transfer files back and forth between backup devices (such as tape drives) and file 
servers and workstations. 

Managing the Storage Management Database 
Much of the power and usefulness of TapeWare comes from its extensive capabilities to 
manage the storage management database. There are three important concepts associated 
with the database: objects, properties and storage management zones. 

Objects 
The storage management database collects and organizes information about objects. An 
object is any file, machine, tape or user about which TapeWare needs to store data. 
Examples of objects which TapeWare tracks in its database include tapes, tape drives, 
network servers, occurrences of files, backup jobs, users and so forth. 
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Objects that contain other objects within them are referred to as containers. A simple 
example of a container is a folder. It contains other objects within it, including objects 
that are not containers, such as jobs and files and objects that are containers, such as other 
folders. 

Container objects 
contain other 
objects inside 

them… 

…including other 
objects (like jobs 
and media) and 
other containers 

(such as job 
folders). 

 

Properties 
The information about each object that TapeWare stores in its database are called 
properties. The properties of each object include important information about that 
object, such as what kind of object it is, who has security clearance to use it and its 
relationship to other objects. 

For example, an individual backup tape is an object in the TapeWare database. Some of 
the properties of that tape stored in the storage management database include the name of 
the tape, when it was created, who has clearance to use the tape and whether or not the 
tape can be erased. 

For more 
information on 
property 
sheets, see 
Chapter 12 — 
Objects and 
Properties 
Reference. 
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Use property sheets, such 
as this property sheet of a 
backup job, to set, modify 
and view the properties of 

an object. 

 

Working with TapeWare objects and properties is easy. Even though when you work 
with TapeWare you work primarily with objects and properties, extensive knowledge 
about objects and properties is not necessary. If you know how to use Windows Explorer, 
you already know most of what you need to use TapeWare. 

Storage Management Zones 
TapeWare is not limited to just one database. On a large network, it may be useful to 
have multiple storage management databases, each addressing different storage needs. 
For example, there may be a separate database for each work group or department, even 
though they are all on the same network. 

If your network has multiple TapeWare databases, then you choose which database you 
wish to use by selecting a storage management zone when you log on to TapeWare. 
Choosing a storage management zone is simply a way to select which database you wish 
to use. 

Each TapeWare storage management zone is overseen by a TapeWare administrator. It 
is the TapeWare administrator’s job to manage the security and integrity of the files in his 
or her storage management zone. 
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Storage Management Zones and Security 
Storage management zones also help ensure network security. TapeWare uses storage 
management zones to promote security in two ways: first, by preventing users from 
working with more than one storage management zone at a time and, second, by allowing 
file servers and workstations to be the member of only one storage management zone. 

Note the following about machines, users and storage management zones: 

• Workstations or file servers (called a machine container) can only be the member of 
one—and only one—storage management zone. Because these machines belong to 
only one database, their peripherals, such as disk drives and backup devices, can 
belong to only one storage management database. 

• Tapes or other media created in one storage management zone cannot be used in 
another storage management zone without following special procedures. This ensures 
that there is no improper access to secure files and data. 

• Each storage management zone must have at least one backup device, such as a tape 
drive. Further, that backup device can only belong to one storage management zone: 
it cannot be shared among multiple zones. (However, a storage management zone 
could have multiple backup devices.) 

• From one workstation, a user can work in other storage management zones besides 
the zone his or her workstation belongs to. This means they can remotely administer 
jobs for other storage management zones besides the zone their workstation belongs 
to. They cannot, however, work in multiple storage management zones at the same 
time. 

• A user can work from other machines with other storage management zones besides 
the one to which their machine belongs. Their machine, along with its drives, 
peripherals and accompanying data, however, always remain in a single storage 
management zone. This helps to prevent the unauthorized sharing of data between 
storage management zones. Thus while users can work outside of their database, the 
workstations and file servers they use always stay within their home zone. 

Creating and Running Jobs 
TapeWare creates backup tapes and restores files with jobs. Working with backup 
devices and a network, TapeWare jobs either back up network file servers and 
workstations onto media or restore files from media onto file servers or workstations. 
When you want TapeWare to back up or restore a file, you create and run a job. 

There are three kinds of jobs: backup, restore and verify. Every kind of job you create 
and run has six components: creating the job, permissions, selection, options, scheduling 
and running. 

For more 
information, 
see Chapter 11 
— Permissions 
and Security 
Reference. 
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Creating the Job  You begin by creating a job, either a backup, verify or restore job. Refer 
to Chapter 3 — Creating TapeWare Jobs for more information. 

Permissions  In order to create a job, you must have permissions to the objects that job 
will work with. For example, to create a backup job, you must have permissions to the 
tape drive, the tape and the files you will back up. If you wish to backup files on another 
workstation, you must have permissions to that workstation and to the files on that 
workstation. Individual users are assigned permissions by the TapeWare administrator, 
who is responsible for ensuring the security and integrity of the backup system. Refer to 
Chapter 4 — Permissions for more information. 

Selection  Once you have permissions to a file, you must select it to be included in your 
job. You might select all files, only a few files or perhaps only a single file. You select 
files first by selecting them in the selection window and second by having TapeWare 
‘sort’ them with filters, which apply additional selection criteria, such as date modified, 
type of file and so forth. Refer to Chapter 5 — Selecting Files and Instances for more 
information. 

Scheduling  After selecting files, the job is scheduled to be run. A job may be scheduled 
to run later or to run immediately. It can be scheduled to run regularly or only once. Refer 
to Chapter 6 — Scheduling Jobs for more information. 

Options  After scheduling the job, you specify the job’s option parameters. Some of the 
options you can specify include what backup device to use, what media to use, whether to 
automatically format the media and so forth. Refer to Chapter 7 — Job Options for more 
information. 

Running  Finally, the job is run. Many scheduled jobs are run automatically by 
TapeWare, but you can manually run a job at any time. Refer to Chapter 8 — Running 
Jobs for more information. 

Every time you create a job in TapeWare, your job must include these six components. 
You begin by specifying a type of job. Before you can proceed further however, you must 
be certain that you have permissions to the objects, such as files and tape drives, that you 
wish to use. Your TapeWare administrator will work with you to determine which type of 
permissions you require. Then you select the files for your job, specify the option 
parameters and finally schedule the job to run. 
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Chapter 2 — TapeWare Workplace 

TapeWare is designed to be easy to use. This chapter will familiarize you with all you 
need to know in order to use most of TapeWare’s features, including keyboard shortcuts 
and mouse conventions. 

Note  This manual deals specifically with the graphical user interface available on 
Windows systems and Linux and UNIX systems running X Window. The console 
interface operates basically the same way on DOS, NetWare, Linux and UNIX systems. 

In This Chapter 

• Starting TapeWare 

• Logon Window 

• Main TapeWare Object Window 

• Property Sheets 

• Menus 

• Reports 

• Working with the TapeWare Wizard 

Starting TapeWare 

After you have installed TapeWare, you start it like any other program. 

Windows 
To start TapeWare in Windows, double-click the TapeWare Administrator icon on the 
desktop. 

You can also click the Start button and select TapeWare from the Programs (or All 
Programs) submenu. Then select TapeWare Administrator.  
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NetWare 
To start TapeWare on a NetWare machine, access the server console. Then type 
TWAdmin. It is not necessary to specify a search path. For example: 

SERVER: TWAdmin 

DOS 
To start TapeWare on a DOS machine, access the directory where you installed 
TapeWare. Then type TWAdmin. For example: 

C:\...>TWAdmin 

Linux/UNIX 
To start TapeWare on a Linux or UNIX machine, open a terminal window. Then access 
the directory where you installed TapeWare. Type ./twadmin. For example: 

[root /usr/local/tapeware]# ./twadmin 

Linux/UNIX (X Window) 
To start TapeWare on a Linux or UNIX machine running X Window, open a terminal 
window. Then access the directory where you installed TapeWare. Type ./twxadmin. For 
example: 

[root /usr/local/tapeware]# ./twxadmin 

On Linux systems, you can create a shortcut on your KDE or GNOME desktop. On 
UNIX systems, you can create a shortcut on your CDE desktop. (See the TapeWare 
Installation Guide for more information.) 

Logon Window 

Each time you start TapeWare, you are shown the TapeWare Logon window. 

Logon 
window  

To log on, you must select a storage management server, enter your user name and enter 
your password. 
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Selecting a Storage Management Zone 
When your TapeWare administrator set up TapeWare to run on your network, he 
assigned your workstation to a storage management zone. Your workstation, along with 
its drives and peripherals, can only be the member of one database zone. The name of this 
zone is the default name that appears in the Storage server list box. 

Normally, you should leave the default name in the list box unchanged. This is because 
you will typically want to work with the storage management zone your workstation 
belongs to. 

Occasionally, however, you may wish to work in a different zone. You might be asked by 
a co-worker or your TapeWare administrator, for example, to run a TapeWare job in a 
different storage management zone. 

To select a storage management zone other than the default zone, first click the arrow 
next to the Storage server list box. You will see a list of possible storage management 
zones. Select the storage management zone you wish to use. 

To select a storage 
management zone, 

click on the Storage 
server list box and 
select the storage 

management server 
you wish to use.  

Note  Although you can log on to different storage management servers, you can only 
create and run jobs within a single storage management zone. Further, you can only 
access files and devices in a single storage management zone. This means, for example, 
that you will be unable to restore files backed up from workstations in one storage 
management zone to workstations in another storage management zone. (If you need to 
share data from one storage management zone to a different storage management zone, 
see Import Media in Chapter 9 — The Media, Device and Database Tabs.) 

User Name and Password 
After selecting a storage management zone, type in your User name and Password. 

If you type your name or password wrong, you will be asked to re-enter your name and 
password. 
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In order to log on, your TapeWare administrator must first assign you a user name and a 
password. If you are having difficulty logging on, ask your system administrator to 
specify again the exact spelling of the user name and password assigned to you. 

Note  Passwords are not case-sensitive, e.g., USER1 is the same as user1. 

Changing Your Password 
It is a good idea to regularly change your password, particularly if you are working with 
sensitive and important data. 

To Change Your Password 
1. Click on the Security menu to make it active. 

2. Click on your User Object icon. 

3. Open the User Password window by either 

• Selecting Change Password… from the Security menu, or 

• Right-clicking the user object and selecting Change Password… from the 
shortcut menu. 

4. Type in your old password and then your new password, unless you are logged in as 
the TapeWare administrator. 

5. Confirm your new password and then click OK. 

To change your 
password, highlight your 

User Object icon... 

In the New Password window, 
type in your old password and your 

new password twice. 

…then select 
Change 
Password… from 
the Security 
menu. 

 
When selecting a password, remember that some passwords are notoriously easy to 
break. For example, because many people use their birth date or the name of their spouse, 
these are not good choices for passwords. 
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Tip  The TapeWare administrator can change a user’s password without knowing the 
user’s current password. TapeWare does not even ask you to enter the old password. This 
is useful when the user has forgotten his or her password. 

Logging on the First Time 
The default user name for the TapeWare administrator is ADMIN. There is no default 
password required for this user to log on. 

Warning  TapeWare administrators have unlimited access to all of the objects in the 
database. Any user who logs on as the TapeWare administrator will have complete access 
to all of the files and machines on the database. 

Your first security step should be to change the TapeWare administrator’s password. 
Click on the Security tab. Select the Admin user object. Select Change Password… 
from the Security menu. Type in the new administrator’s password, enter it again to 
confirm and click OK. Do not continue until you have changed this password. 

Grace Logons 
Your TapeWare administrator may have set up your password to expire after a set period 
of time. For example, your password may expire after 60 days. This forces you to change 
your password regularly. 

If your password has expired, TapeWare will prompt you to change your password. If 
you choose not to change your password, TapeWare may still let you log on, even with 
an expired password. Logging on with an expired password is called a grace logon. Your 
TapeWare administrator will determine how many grace logons you are allowed. 

When your password has expired and you have used all of your grace logons, TapeWare 
will ask you to change your password when you log on. 

Logging Out 
On occasions you may want to change the storage management zone you are using or 
want to log on as a different user. Although you could quit TapeWare and restart the 
program, it is quicker and faster to log on again without quitting TapeWare. 

To log on again, choose Log Out from the File menu. You will be presented with the 
TapeWare Logon window and asked to log on again. 



14 TapeWare® User’s Guide and Technical Reference 

 

 

Select Log 
Out from the 
File menu to 

log on to a 
new zone or to 
close the main 

window. 
 

Logging Out and Running Scheduled Jobs 
TapeWare can run scheduled jobs even when no one is logged on. (Only scheduled jobs 
can be performed when no one is logged on to TapeWare.) 

When you leave your workstation, you may need to leave TapeWare open. In order to not 
let any other users have unauthorized access to the network, log out of TapeWare before 
leaving your workstation. Any scheduled jobs will still run, but no unauthorized users 
will be able to work with TapeWare unless they can log on. 

Note  If the TapeWare service is installed and running, you can close TapeWare and your 
scheduled jobs will still run (see Appendix E — TapeWare Service in the TapeWare 
Installation Guide for more information). 

Main TapeWare Object Window 

You use the main TapeWare object window to view, create and manipulate TapeWare 
objects, such as jobs and tapes. 

In addition to the menu bar, the TapeWare window has the following parts: tabs, toolbar, 
the hierarchical or “tree” view area, the object detail area and the status bar. 

For more 
information, 
see Running 
Scheduled 
Jobs in Chapter 
8 — Running 
Jobs. 
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Object 
detail  
area 

Hierarchical 
“tree view” 

area 

Toolbar 

Tabs 

Status bar 

 

Tabs 
At the top of the window are eight tabs which help to group and organize similar sets of 
objects. For example, you use the Backup tab to display and work with backup jobs, the 
Restore tab to display and work with restore jobs and so forth. To display a different tab, 
click on the tab you wish to view. You can also display a different tab by using the View 
menu. 

Toolbar 
The toolbar has a list box and several buttons. Not all buttons are on all tabs and some 
buttons on a tab may be unavailable. When a button is grayed out, it is not available 
because no object that it can work with is currently selected. 

 

List box 

Up One Level 

Properties 

Delete 

Help 

Find Job control buttons 

Display buttons  
• The List box contains the name of the folder (or container) currently displayed in the 

object detail area. 

• The Up One Level button changes the currently displayed folder (or container) to the 
next higher container in the hierarchy, that is, the container that contains the current 
container. 

• The Properties button displays the properties of any object you have selected in the 
object view area. 



16 TapeWare® User’s Guide and Technical Reference 

 

• The Delete button lets you delete any object you have selected in the object view 
area. 

• The Find button lets you search for an object in either the left or right window pane. 

• The Display buttons determine how objects are displayed in the object detail area. 

• The Job control buttons let you start, stop and pause a job. You can also perform a 
variety of tape-specific tasks. 

You can use the View menu to either hide or show the toolbar. 

Object View Areas 
The left window pane displays containers, such as folders. Examples of other container 
objects include networks, workstations and drives. These are displayed in hierarchical or 
“tree” view. This portion of the window is referred to as the tree view area. 

The right window pane is referred to as the object detail area. It displays the contents of 
the container currently selected in the tree view area. If you select an object in the tree 
view area, you will see its contents displayed in the object detail area on the right side of 
the window. 

Contents of the 
container selected 
in tree view area… 

…are displayed in 
the right side of 
the window, the 
object detail area. 

Only containers 
are displayed on 

the left side of the 
window, the tree 

view area. 

 
The object view area is designed to be easy to use and if you have worked with Windows 
Explorer, you probably already know all you need to work with it. If you are new to 
working with objects presented like this, keep the following in mind: 

• The left window pane, the tree view area, only displays containers, that is, objects 
that hold other objects. Objects that do not contain other objects are displayed only in 
the right window pane, the object detail area. 

• To display the objects in a folder or other container, open it by clicking on it in the 
tree view area. 
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• To view the folders within a folder, expand the “tree” by clicking on the expand tree 
icon next to the folder. Alternatively, you can double-click the folder and it will both 
expand and display its contents in the object detail area. 

• To close a folder, click the collapse tree icon next to the folder. Alternatively, you 
can double-click the open folder and it will close. 

Note  You can instruct TapeWare to only show the expand tree icons when a container 
contains other containers within it. Select Preferences… from the File menu and check 
the Smart expandable indicators check box. Before displaying the expand tree icon, 
TapeWare will check to see if that container contains other containers in it. If it doesn’t, 
the expand tree icon will not be displayed. 

There are numerous keyboard shortcuts available that make it easier to work with objects 
in TapeWare. For more information, see Keyboard Shortcuts later in this chapter. 

Status Bar 
The status bar displays short descriptive messages about the menu commands on its left 
side. The middle of the status bar displays the current user’s name and the database zone 
they are currently logged on to. 

 Descriptive messages about menu commands 

Current user and zone Alert button 
 

The Alert button is on the right. This button flashes whenever there is a problem that 
requires your attention. For example, TapeWare might not be able to locate a backup 
device you specified for a job and so it will send an alert to the Alert window notifying 
you of the problem. When you click on the Alert button, TapeWare brings up the Alert 
window so you can view any pending alerts. 

You can use the View menu to either hide or show the Status Bar. 

Working with Objects in the Main TapeWare Window 
You can easily change how objects are displayed in the main TapeWare object window. 
This will assist you in working more effectively and quickly. 

 
Expand tree  
icon 

 
Collapse tree  
icon 
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Arranging Objects 
In the object detail area, you can arrange the objects in several different ways using either 
buttons on the toolbar or the Arrange Icons submenu on the View menu. Depending on 
the tab, you can sort the objects by name, date or type. You can also 

• Drag the icons to arrange them when working with either large or small icons; and, 

• Use the column head at the top of the object detail area to change how the objects are 
displayed when working in detail view. 

 Use these buttons to arrange 
icons in the object detail area. 

In an icon view, drag 
icons to arrange them. 

Detail 
view 

Click column 
heads in object 
detail view to 
sort objects by 
name, size, etc. 

Large 
icon 
view 

 

Keyboard Shortcuts 
Although you may find using the mouse to be the most intuitive way to work with objects 
in the main TapeWare window, there are several keyboard shortcuts that will help speed 
up your work. The next time you work with TapeWare, try these keyboard shortcuts. 

• The TAB key will move the active or highlighted area to a different area of the 
window. 

• The PLUS SIGN (+) on the numeric keypad or the RIGHT ARROW key expands the tree 
in the tree view area. 

• The MINUS SIGN (-) on the numeric keypad or the LEFT ARROW key collapses the tree 
in the tree view area. 
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• The ASTERISK key (*) on the numeric keypad will expand the tree as far as possible. 

• The ARROW keys also select objects in the tree view area and in the object detail area, 
as well as change the active tab. 

Shortcut Menus 
When you right-click in most windows, the shortcut menu appears. The shortcut menu 
list commands that pertain to the particular portion of the screen you clicked on. This is 
often the fastest and easiest way to create new objects and modify existing objects. 

 

Click the right 
mouse button to 
bring up a context-
sensitive shortcut 
menu. 

 

Find Button 
The Find button lets you locate objects in the database quickly without searching through 
multiple volumes and directories. 

To use the Find command, click on the Find button, select Find... from the Edit menu or 
press CTRL+F. In the Find window, type in the name of the object you wish to find. 
TapeWare will search through the database, attempting to locate that object. When the 
object is found, it will be displayed and highlighted. 

Note that the Find command is not case-sensitive; additionally, you may use the wildcard 
characters ? and *. 

Property Sheets 

Every object in the TapeWare database has a property sheet associated with it. Each 
property sheet has two or more tabbed pages on it that display the properties of that 
object. 

 
Find button 
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Examples of property 
sheets for a job folder… 

…a network 
server… 

…and a 
backup job. 

 

Opening Property Sheets 
You can display the property sheet of an object in one of three ways: 

• Select the object with the mouse or keyboard and then click the Properties button on 
the toolbar. 

• Right-click the object to display a shortcut menu, then select Properties. 

• Select the object and press ALT+ENTER. 

 
Properties 
button 
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…or selecting  
Properties 
from the 
shortcut 
menu. 

You can view 
the properties of 
an object either 

by selecting it 
and clicking the 

Properties 
button on the 

toolbar… 

 

Note  Property sheets work just like other windows, except that their size cannot be 
changed. You can leave them open when you return to working in the main TapeWare 
object window and you can have multiple property sheets open at once. 

Menus 

You will find the menus easy and intuitive to use. Most of the menu commands are 
discussed in some detail in later chapters of this book. 

If you are having difficulty with a particular command, look in the index of this manual 
under the name of the menu. The Status Bar also displays a short description of the 
highlighted menu command. Alternatively, select Help Topics from the Help menu. 
Then type the name of the command with which you are having difficulty in the list box 
on the Index tab of the TapeWare Help window. 
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You can get help on any 
menu command by typing the 

name of the command on 
Index tab of the Help Topics 

window. 

 

Reports 

TapeWare has a series of helpful diagnostic and summary reports available. To run a 
report, select Print report from the File menu. In the Report type list box, you will see a 
list of the reports available. When you select a report, a short description appears in the 
Description field. 

Report type lists 
the name of the 
selected report. 

The Description 
field has a short 
description of the 
report. 

Indicate the object 
in the Storage 
Management 

database 
hierarchy to begin 

the report with in 
this field. 

To save the report 
as a file instead of 
printing it, check 
this option. 
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Before printing a report, specify which objects you want the report to cover by selecting a 
Starting object. The report will generate information for all of the objects in the 
TapeWare hierarchy that are below the object specified in the Starting object field. You 
can change the starting object by clicking on the Browse button and selecting a new 
object. 

You can also specify the font the report will be printed in by clicking on the Font… 
button. 

Note  These reports can output many hundreds of pages. Therefore, we recommend that 
you select the Save report to a file instead of printing option. Then you can use a text 
editor to print the appropriate report information. 

You can print the following reports: 

Objects At Risk  The Summary and Detail versions of this report lists the files, 
directories and volumes that have not been sufficiently backed up. Therefore, they are at 
risk unless additional backups are performed. 

Media Information  The Summary report lists general information about the media, 
including read and write statistics. The Detail report lists the summary as well as the 
files, directories and volumes that have been backed up to the media. 

Database Listing  The Summary and Detail reports list all objects in the storage 
management database. Select a different Starting object to only list data for particular 
objects, such as users or media. For example, to list database information about Users and 
Groups, set Starting object to the Security folder. 

Diagnostics  This report lists diagnostic information about each device. 

Printer Test  This sample report lets you verify operation of a specific printer. 

Additional Report Capabilities 
Besides its reporting capabilities, TapeWare has several advanced features to help you 
track and compile necessary information. 

• The Instructions command on the Tools menu lets you check to see which media 
and devices are required for the scheduled jobs. See Viewing and Printing Scheduled 
Job Instructions in Chapter 8 — Running Jobs for more details. 

• The Email (SMTP or MAPI) option allows you to email the logs of jobs to any valid 
email address. For more information, see Email Support for Job Logs in Chapter 8 — 
Running Jobs. 
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• You can also create audit logs for files, directories and volumes in order to monitor 
the backup and restore activity for these objects. See Audit Logs in Chapter 8 — 
Running Jobs for additional information. 

Working with the TapeWare Wizard 

The TapeWare Wizard gives you a fast and quick way to perform most tasks. You can 
use the TapeWare Wizard to create and schedule backup jobs, restore jobs and verify 
jobs. You can also create and edit reports from the Wizard tab. The TapeWare Wizard 
will guide you through each step necessary to create and run a job or create a report. 

Wizard 
 tab 

 
The name of each TapeWare Wizard option indicates what task that wizard helps you 
perform. The descriptions are self-explanatory. The backup, restore and verify options 
create jobs; for additional information about creating these jobs without the TapeWare 
Wizard or about the jobs the TapeWare Wizard created, consult chapters 3 through 8 of 
this manual. The Media Content wizard is a specialized implementation of the Query 
Filters window, discussed in greater detail at the end of chapter 9 and in chapter 12. The 
Instructions and Logs wizard tells you which media and devices are required for 
scheduled jobs and results of previously executed jobs; for additional information, 
consult Viewing and Printing Scheduled Job Instructions in Chapter 8 — Running Jobs. 
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If an option is not listed on a screen, e.g., Disaster Recovery on the Wizards tab or SQL 
Connector on the Tools | Configurations submenu, it may be caused by one of the 
following: 

• The option has not been installed. For example, you must install the Disaster 
Recovery option for it to appear. 

• The option is not available due to your license agreement. For example, you must 
purchase a license to back up more than one file server. 

• An error occurred when starting TapeWare. Examine the twtrace.txt file located in 
your TapeWare directory. 
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Chapter 3 — Creating TapeWare Jobs 

To transfer files back and forth from backup devices, such as tape drives, to network 
workstations and file servers, you create and run jobs. You organize and store these jobs 
in folders you create on job tabs in the main TapeWare administrator window. 

In This Chapter 
• Backup, Restore and Verify Jobs 

• Creating New Jobs 

• Renaming, Deleting and Moving Jobs 

• Organizing Jobs with Folders 

Overview 

You use backup jobs in order to protect against loss of data due to disasters or equipment 
malfunction, to archive important files and to create permanent historical records. Restore 
jobs allow you to transfer stored files on media back to file servers and workstations. 
Verify jobs compare the version of a file stored on media, such as tapes, with current 
versions of the file stored on machines on a network. 

You can create folders to store these jobs in on one of the job tabs. These folders and the 
jobs stored within them can be renamed, deleted and moved to new locations. 

Backup, Restore and Verify Jobs 

TapeWare can create and run three types of jobs: backup jobs, restore jobs and verify 
jobs. 
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Backup Jobs 
Backup jobs copy selected files from workstations and file servers to various media, such 
as tapes. This media can then be stored, preserving a copy of the file for future use. You 
might create and run a backup job for one of the following reasons: 

• To ensure the integrity of data should a disk drive on a workstation or file server fail. 

This is perhaps the most common type of backup job. Its purpose is to protect 
valuable information in case of a disastrous data loss. This type of backup allows 
a company or organization to return to work quickly, even after the failure of a 
main file server. To be effective, these backup jobs must be run regularly 
(normally daily) without exception in order that recent changes to files can be 
safely restored. This type of backup job is for disaster protection. 

• To remove files from a workstation or file server that are infrequently used. 

Some files are important to keep, but are never or rarely used. For example, you 
may wish to keep a copy of correspondence from last year for legal reasons, but 
have no regular need to access these files under normal circumstances. By 
backing up the files onto a tape or other media, you safely store the media, 
preserving a copy of the file and then delete the file from the workstation or file 
server. TapeWare will keep track of which files you have backed up and which 
tape they are located on. As long as the media is undamaged and safely stored, 
you will be able to retrieve the file if necessary. This type of backup job is called 
an archive job. 

• To store a copy of a particular historical version of a file. 

Sometimes you may wish to keep a permanent record of a particular version of a 
file. For example, you may need to preserve a copy of company records as they 
exist on a certain date or before they are converted for use in a new program. 
You can store a copy of the file as it exists on a certain date and instruct 
TapeWare to make certain that this file and media it is on are not overwritten 
with other data. TapeWare will keep track of the file and the media in its 
database and you will be able to retrieve it if necessary. Unlike an archive job, 
the file that was backed up is not deleted from the file server or workstation. This 
type of backup job is sometimes called a historical backup. 
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Restore Jobs 
Restore jobs copy files from backup devices to workstations and file servers. You might 
create and run a restore job when files on a workstation or file server have been lost 
because of a disk crash, when you need to view a file that has been archived (backed up 
onto a tape and then deleted) or when you need data from a particular historical version 
of a file. 

Verify Jobs 
Verify jobs compare a file on some media, such as a tape, with a file at a workstation or 
file server. These jobs verify that the two files are in fact the same file. A verify job is 
useful when you wish to make sure a particular file, such as a program file, has not been 
corrupted or modified. 

Job and Database Tabs 
The three different job types each have their own tab. You create, modify and run backup 
jobs with the Backup tab selected, restore jobs with the Restore tab selected and verify 
jobs with the Verify tab selected. 
 Job tabs 

Jobs only 
appear on their 
own tabs, in this 
case, a restore 
job on the 
Restore tab. 

 
Note that a job only appears on its own type of job tab. For example, backup jobs are 
displayed on the Backup tab, but not on the Restore or Verify tabs. 

However, you can also view all three types of jobs on the Database tab. But because the 
Database tab keeps track of all of the objects in the TapeWare database, it may appear 
very cluttered. Normally, when working with jobs, make the appropriate job tab active. 
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Creating New Jobs 

There are three ways to create new jobs: with the wizard, from the job tab and by copying 
old jobs. 

Creating Jobs with the Wizard 
The TapeWare wizard will help guide you through all of the steps necessary to create and 
run a backup, restore or verify job. This is often the fastest way to create a new job, 
especially when you are inexperienced using TapeWare. After you answer a few 
questions, the TapeWare wizard will create the job for you. You can then work with this 
job in the database just like any other job. 

The fastest way to activate the TapeWare wizard is to click on the Wizard tab. Then 
click on the appropriate button to create either a new backup, restore or verify job. You 
can also create reports from the Wizard tab which will help you monitor how jobs have 
run and the backup status of various files and databases. 

Use the 
Wizard tab 

to create 
new backup, 
restore and 
verify jobs. 

 
You can also create a new job with the TapeWare wizard by either 

• Selecting Wizard... from the Job menu, 

 
Wizard button 
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• Typing CTRL+W, or 

• Clicking the Wizard button on the toolbar. 

Creating New Jobs from a Job Tab 
Commonly, you will create jobs while working with one of the three job tabs (Backup, 
Restore, Verify) in the main TapeWare object window. When you create a job this way, 
TapeWare opens the property sheet of the new job so you can name the job, select files 
and schedule it to run. Selecting files and scheduling a job to run is covered in detail in 
chapters 5 through 7. 

The type of job created depends 
on which job tab is active. 

When you create a new job, its property 
sheet automatically opens. 

 
Which type of job you create depends on which job tab is active. Where TapeWare keeps 
track of the job depends on which folder is open in the tree display area. 

For example, if the Backup tab is active, TapeWare will create a new backup job. If a 
personal or workgroup folder is open, TapeWare stores the job in the open folder. 
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To Create a New Job from a Job Tab 
1. Make either the Backup, Restore or Verify tab active by clicking on it. This 

determines what type of job TapeWare will create. 

2. Open the folder in the tree view area where you want to store the job. The contents of 
that folder are displayed in the object detail area. TapeWare will store your new job 
here. 

3. Create the new job by either 

• Selecting New Object… from the File menu and then selecting the appropriate 
job from the New Object window, or 

• Right-clicking in the TapeWare object detail area and selecting New…Job from 
the shortcut menu, or 

• Clicking the New Object button on the toolbar and selecting the appropriate job 
from the New Object window. 

4. Type in the name of the new job in the Name box. 

To create a new job, right 
click the mouse and select 

New…Job from the 
shortcut menu. 

New jobs are stored in 
the folder open in the 

tree view area. 

 

Creating New Jobs by Copying 
Creating a new job by copying an existing job is sometimes a useful method of creating a 
job. In particular, copying an existing job is appropriate when you want your new job to 
be like the old job in every way except for a few minor changes. 

To Create a New Job by Copying an Existing Job 
1. Copy the existing job you wish to duplicate by either 

• Holding down the CTRL key as you drag the existing job to a new location, then 
skip to step 4 below, or 

• Selecting the existing job (with the mouse or keyboard) and pressing CTRL+C, or 

 
New Object  
button 
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• Right-clicking the existing job and selecting Copy from the shortcut menu, or 

• Selecting Copy from the Edit menu. 

2. Open the folder you want the new job to be stored in by selecting it in the tree view 
area. (To store the job in the same folder as the existing job, skip this step.) 

3. Right-click the folder where you want the new job to be pasted and select Paste from 
the shortcut menu. Alternatively, highlight the location where you want the job 
pasted; then select Paste from the Edit menu or press CTRL+V. 

4. Change the name of the new job. 

Note  TapeWare copies all job properties, including job logs, to the new job. 

Renaming, Deleting and Moving Jobs 

You can change the names of jobs or move them to new folders. Or, if you don’t plan to 
use a job again in the future, you can delete it. 

You rename, delete and move jobs by either 

• Selecting the appropriate command from the Edit menu, or 

• Right-clicking the job and selecting the appropriate command from the shortcut 
menu. 

To move a job, drag it to a new location. You can also use the DELETE key and the Delete 
button to delete jobs. 

Right-click an object to 
display the shortcut 

menu to Copy, Move, 
Delete and Rename 

objects. 
 

Note  When you run a backup job, TapeWare uses its storage management database to 
keep track of the files you have backed up and the name of the tape on which they are 
stored. Deleting a job does not affect how the storage management database tracks files 
and tapes. TapeWare continues to track these files and tapes even after the job that 
created them has been deleted. 

 
Delete button 
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Organizing Jobs with Folders 

Every backup, restore and verify job is stored by TapeWare inside a folder. You can 
create new folders to help organize your jobs or you can use existing folders. 

When the TapeWare administrator added you as a user, TapeWare created a personal 
folder for your use. Generally, because there may be many users in your TapeWare 
storage management zone, it is a good idea to store your personal jobs in your personal 
folder. Alternatively, you can store workgroup jobs in the appropriate group folder. 

Types of Folders 
There are three types of folders: User/Group folders, Job folders and Media folders. 
Each of these folders is a container, that is, they store other objects within them. They 
differ from each other according to the type of object that can be stored within them. 

• User/Group folders can only be stored in a special folder, called the Home folder. 
These folders can have either Job folders or Media folders within them; additionally, 
you can store jobs or media “loose” in these folders. 

• Job folders can only be stored in User/Group folders or in other Job folders. These 
folders usually have jobs stored within them, although you can also store additional 
job folders within them. 

• Media folders can only be stored in User/Group folders or in other Media folders. 
These folders usually have media stored within them, although you can also store 
additional Media folders within them. Media folders are discussed further in Chapter 
9 — The Media, Device and Database Tabs. 

User/Group 
folders 

Job 
folders 

Media 
folders 
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Folders and Job Tabs 
Job folders are unlike jobs in one important way: Job folders appear on all the job tabs 
and on the database tab. Jobs, on the other hand, only appear on one tab (backup jobs on 
the Backup tab and so forth) and on the Database tab. When you create a new job folder, 
that folder appears on all the job tabs and on the database tab. 

Similarly, User/Group folders appear on every job tab, as well as the Media tab and the 
Database tab. 

Media folders, however, only appear on the Media and Database tabs. 

The 
same 

folder… 

…displays 
different jobs, 
depending on 
which tab is 
active. 

 
Because every folder is seen on every job tab, you may not need or want to have separate 
folders for different types of jobs. For example, a folder that stores only backup jobs will 
appear on all three job tabs, including the Restore tab and Verify tab. For this reason, it 
is better to name the folder after your workgroup or yourself, than by the type of job 
stored in it. Again, a single folder can store all of your personal or workgroup jobs. 

Don’t name job folders after 
type of job, since they 
appear on every tab. 
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Home, Admin and Everyone Folders 
Three folders play a special role in every database: the Home folder, the Admin Folder 
and the Everyone Folder. 

Home, Admin and 
Everyone folders  

The Home folder is the folder that stores all of the User/Group folders within it. It is 
always at the top of the hierarchy in the tree view area of a job tab. You are not allowed 
to store jobs “loose” in the Home folder, only inside other folders. 

The Admin Folder is a special folder used by the TapeWare administrator. Normally, 
only the TapeWare administrator has permissions to the Admin Folder. If you don’t see 
it inside your Home folder, this is because the TapeWare administrator has not given you 
permissions to view it. 

The Everyone Folder is a folder to which every TapeWare user has permission. Your 
TapeWare administrator may place jobs in this folder to which he wants everyone to have 
access. 

Everyone Folder and Permissions 
Because of the way TapeWare assigns permissions to new objects, if you create a new 
object inside the Everyone Folder, normally everyone will have at least some 
permissions to it. For example, if you create a new backup job and store it in the 
Everyone Folder, it is likely that every TapeWare user will have permissions to that 
folder and thus to the job. 

To restrict the permissions of other TapeWare users to a job or folder, the best strategy is 
to use a folder to which only you or your workgroup have permission. Granting 
permissions are covered in detail in the Chapter 4 — Permissions. 

For more 
information, 
see Chapter 4 
— Permissions. 
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Creating Job Folders 
Usually, the best strategy for organizing your personal jobs or the jobs of your 
workgroup is to create a special folder in which to store them. This is particularly true 
because it makes it easier and quicker to manage permissions to those jobs. 

When the TapeWare administrator adds a user or group, TapeWare creates a personal 
folder for that user or group. If you have the proper permissions, you can also create as 
many additional new job folders as you need and organize them in whatever way is 
convenient. You can create additional job folders either inside your personal or 
workgroup folder or inside the Everyone Folder. 

You can create 
additional job 

folders inside your 
personal folder.  

To Create a New Folder 
1. Select the existing folder in which you want to store the new job folder. (It cannot be 

the Home folder.) 

2. Create the new folder by either 

• Selecting New Object… from the File menu and then selecting New Job Folder 
from the New Object window, or 

• Right-clicking in either the tree view or object detail area and selecting New Job 
Folder from the shortcut menu, or 

• Clicking the New Object button and selecting New Job Folder from the New 
Object window. 

TapeWare creates the new folder inside the selected folder. 

3. Type in the name of the new folder on its property sheet. 

Tip  After creating a new folder, be certain to specify which users have permissions to it. 
This is the simplest and fastest way to assign permissions to multiple objects stored in the 
folder. 

 
New Object  
button 



38 TapeWare® User’s Guide and Technical Reference 

 

Moving, Renaming and Deleting Folders 
You can move, rename or delete a folder just like you can any other TapeWare objects, 
such as jobs; however, you cannot copy folders. When moving, deleting or renaming 
folders, keep the following in mind: 

Moving Folders  Contents of a folder move with the folder to the new location. This may 
change the permissions of the objects stored in that folder. 

Renaming Folders  Only the name of the folder is changed. TapeWare still treats that 
folder and any objects associated with it in the same manner. 

Deleting Folders  Deleting folders also deletes their contents, including any other folders 
or jobs contained in that folder. Before deleting a folder, be certain that you wish to 
delete all of its contents. 

Warning  Once a folder has been deleted, its contents cannot be recovered. Be certain 
either that the folder is empty or that you no longer need the contents of the folder before 
deleting it. 

Modifying Folders 
You can rename, delete and move folders using one of these methods: 

• Selecting the appropriate command from the Edit menu, or 

• Right-clicking the job and selecting the appropriate command from the shortcut 
menu, or 

• Clicking and dragging the folder to a new location. 
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Chapter 4 — Permissions 

Security is an important issue when managing a network. One of the most important 
functions of the TapeWare storage management database is to handle security. The 
storage management database prevents unauthorized users from working with objects to 
which they have not been granted security clearance. To ensure only authorized users can 
access sensitive data, TapeWare tracks the permissions of each user. The TapeWare 
administrator can grant different types of permissions to various users to ensure the 
security and integrity of the network data while efficiently implementing a productive 
backup program. 

In This Chapter 
• Overview 

• Users and Groups 

• Effective Permissions 
• Types of Permission 

• Two Examples of Permissions 

• Granting Permissions to Other Users 

Overview 

Before you can work with any object (directory, file, user, etc.) in the TapeWare storage 
management database, you must have effective permissions to that object. 

Different types of permissions restrict what type of operations can be performed on an 
object. For example, some permissions allow users to write to an object (such as a file, a 
tape or a workstation) or create new objects (such as folders or jobs). Sometimes a user is 
granted unlimited permissions to an object or all objects. Usually, however, to protect the 
integrity of the data and for security reasons, most users have only limited effective 
permissions to some (not all) of the objects in the TapeWare database. 



40 TapeWare® User’s Guide and Technical Reference 

 

Maintaining the security of data on a network is the primary responsibility of the 
TapeWare administrator. Because of this, this chapter is only an overview of security and 
permissions. This chapter will help the typical user understand how TapeWare handles 
security and permissions so that you can work efficiently with your TapeWare 
administrator. More detailed information on permissions is covered in Chapter 11 — 
Advanced Permissions and Security. 

Users and Groups 

The TapeWare administrator grants permissions to objects in the TapeWare database to 
either a user or to a group. Individual TapeWare users have effective permission to an 
object either as a user or as the member of a group. A group is a set of users that are all 
granted permissions in the same way and at the same time. For example, the TapeWare 
administrator may grant permission to read the files on a tape to users individually, to a 
group of users or both to users and to groups. 

Users and groups 
can be granted 
permissions to 

any object, in this 
case a tape. 

 
Individual TapeWare users can be the member of more than one group or of every group, 
depending on how the TapeWare administrator arranges the storage management 
database security. The number of groups the TapeWare administrator creates and the 
assignment of members to those groups depends on the security needs of your particular 
network. 

Everyone Group 
Normally most TapeWare users are a member of a special group, the Everyone group. 
Whenever a new user is added to a TapeWare storage management zone, TapeWare 
automatically assigns that user to the Everyone group. Typically, only limited 
permissions are granted to the Everyone group, although users can be granted more 
extensive permissions either individually or as members of other groups. 

For more 
information on 
setting up 
users and 
groups, see 
Adding New 
Users and 
Groups in 
Chapter 11 — 
Permissions 
and Security 
Reference. 
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Effective Permissions 

The permissions you have to an object in the TapeWare storage management database are 
called your Effective permissions. You can view your effective permissions to an object 
on the General tab of that object. 

The current user’s effective 
permissions to an object are 

shown on the General tab 
of that object. 

 

Determining Effective Permissions 
A user is assigned effective permissions to an object through by direct permissions or 
inherited permissions. 

A user has direct permissions to an object if they are listed on the Permissions tab of the 
object, if they are equivalent to a user who has direct permissions to the object or if they 
are a member of a group that is listed on the Permissions tab of that object. 

A user has inherited permissions to an object if they do not have direct permission, but 
they have effective permissions to the container that contains the object. If you do not 
have direct permissions to an object, you must have effective permissions to the container 
in which the object is stored. 

Note  Your effective permissions to a container object can be either direct or inherited. 
All that matters is that you have effective permissions to the container. 

When determining a user’s effective permissions to an object, TapeWare checks if the 
user has direct permission; if not, TapeWare checks if they have inherited permission. 

For example, if a user has the Read direct permission, but the group has the Access 
permission, the user’s effective permission is Access. 
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Examples of Determining Effective Permissions 
The following two examples illustrate how TapeWare determines the effective 
permissions a user has to an object. 

Effective Permissions Example #1 

In this example, a user named Galen Clark has direct permissions only to the User/Group 
folder named Galen Clark’s Folder. 

Clark has direct permissions to this 
folder. 

 
When determining the effective permissions Clark has to Galen Clark’s Folder, 
TapeWare first looks to see if he has direct permission to the folder. Because Clark is 
listed as a user on the Permissions tab of the folder’s property sheet, Clark has direct 
permission to the folder. TapeWare uses this information to determine Clark’s effective 
rights. TapeWare does NOT look to see if there are any inherited permissions to the 
folder. 

When determining the effective permissions Clark has to the backup job named Clark’s 
Personal Backup Job stored in Galen Clark’s Folder, TapeWare first looks to see if he 
has direct permission to the job. Because Clark does not have direct permissions, 
TapeWare checks to see if Clark has effective permissions to the container that contains 
the job. In this case, TapeWare checks to see if Clark has effective permissions to Galen 
Clark’s Folder; because Clark has effective permission to this folder, TapeWare uses 
this information to calculate the effective permissions Clark has to the job. 

Effective Permissions Example #2 

In this example, a user named Stephen Mather has direct permission to the User/Group 
folder named Conservationist Workgroup Folder as a member of the Conservationist 
Workgroup and to the Job folder named Mather’s Personal Jobs as a user. 

Mather has effective 
permissions to this folder as 

a member of the 
conservationist group… 

…and to this folder 
as a user. 
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When determining the effective permissions Mather has to the Conservationist 
Workgroup Folder, TapeWare first looks to see if he has direct permission to the folder. 
Because Mather is a member of the Conservationist Workgroup which has direct 
permissions to the folder, Mather also has direct permissions to the folder. TapeWare 
uses this information to determine Mather’s effective permissions. TapeWare does NOT 
look to see if there are any inherited permissions to the folder. 

When determining the effective permissions Mather has to the Job folder named 
Wawona Workgroup Folder stored in the Conservationist Workgroup Folder, 
TapeWare first looks to see if he has direct permission to the folder. Because no users or 
groups have direct permissions to this folder, TapeWare checks to see if Mather has 
effective permissions to the container that contains this folder. In this case, TapeWare 
checks to see if Mather has effective permissions to the Conservationist Workgroup 
Folder; because Mather has effective permission to this folder, TapeWare uses this 
information to calculate the effective permissions Mather has to the Wawona 
Workgroup Folder. 

Similarly, TapeWare determines the effective permissions Mather has to the folder 
named Mather’s Personal Jobs by the direct permissions Mather has to that folder. Note 
that when determining the effective permissions to this folder, it makes no difference that 
Mather also has effective permissions to the Wawona Workgroup Folder which 
contains this folder. 

When determining the effective permissions Mather has to the job Mather’s Archive 
Job contained in the Mather’s Personal Jobs folder, TapeWare checks to see if Mather 
has direct permissions. Because he does not, TapeWare checks to see if Mather has 
effective permissions to the container that contains the job. Because Mather has effective 
permissions to the Mather’s Personal Jobs folder, TapeWare uses these effective 
permissions to determine his effective permissions to Mather’s Archive Job. 

Note especially that the effective permissions Mather has to Mather’s Archive Job are 
determined ONLY by Mather’s effective permissions to the Mather’s Personal Jobs 
folder—and NOT by his effective permissions to the Conservationist Workgroup 
Folder or the Wawona Workgroup Folder. 

Mather’s permisssions 
to Mather’s Archive 

Job are determined by 
his effective permissions 

to this folder… 

…but NOT 
by his 
effective 
permissions 
to this folder. 
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How Moving Objects Affects Permissions 
When an object is moved from one container to another, TapeWare determines the 
effective permissions of the object based on its new location. 

For example, suppose a user has effective permissions to a job because that job is stored 
in his or her User/Group folder, a container to which the user has been granted direct 
permission. If the job is moved from that folder to a new folder, the user’s effective 
permissions to the job may change. If the job were moved to the Admin folder, the user 
would lose permission to it because he or she does not have permission to the Admin 
folder. On the other hand, if the job were moved to the Everyone folder, the user will 
still be able to access the job, although the effective permissions might be different. 

 
If Clark’s 
permissions to 
this job are 
inherited from his 
User/Group 
folder, then they 
will change when 
it is moved to the 
Admin folder. 

 

Types of Permission 

TapeWare controls access to objects in its database with seven different types of 
permission. The type of permission determines what actions a user can perform on an 
object. Users and groups can be granted all seven types of permission, only some of the 
permissions or none of the permissions. 

The seven types of permission are Supervisor, Access, Create, Modify, Delete, Read 
and Write. 
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Users or groups 
can have any of 
seven permissions 
to an object. 

 

Supervisor 
This is the most powerful permission. Supervisor permission grants the user three specific 
abilities: 

• First, a user with supervisor permission to an object is automatically granted the other 
six permissions to that object; 

• Second, a user with supervisor permission to an object automatically has effective 
permission to all the objects in the storage management database below that object; 
and 

• Third, a user with supervisor permission to an object cannot be denied any of the 
seven permissions to any object in the storage management database below that 
object. 

The TapeWare administrator is automatically granted supervisor permission to the 
highest container in the TapeWare storage management database hierarchy (called the 
System Container). This means that the TapeWare administrator has full permissions to 
all the objects in the TapeWare database and that none of these permissions can be 
denied. 

Often, only the TapeWare administrator will be assigned supervisor permission. 

Access 
A user with Access permission to an object can grant other users and groups permissions 
to that object. For example, if you wish to grant a co-worker permissions to a tape you 
have created, you must have Access permission to that tape. 
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Access permission can be very powerful, since it allows a single user the ability to grant 
all other users in the TapeWare database extensive permissions to an object. For this 
reason, your TapeWare administrator may not grant you Access permission to objects 
even though you have other permissions to them. For example, your TapeWare 
administrator may grant you permission to read and write from a particular tape. Without 
Access permission however, you will not be able to grant other users or groups that same 
ability. 

You can only grant permissions to other users or groups if you have Access permission. 
If you want other users to have permissions to an object, such as a job or tape, and do not 
have Access permission to that object, ask your TapeWare administrator to grant the 
permissions for you. 

Create 
This permission allows a user to create new objects within a container object. For 
example, to create a new job within a folder, a user must have Create permission to the 
folder. Note that the Create permission applies to the folder, not to the job: it grants the 
user permission to create new objects within that folder. 

If you want to create new folders or jobs, your TapeWare administrator must grant you 
Create permission. Your permission to create new jobs or folders might be limited to a 
single folder. For example, you may have Create permission only to the Everyone folder 
or to a personal folder that your TapeWare administrator has created for you or your 
workgroup. 

If you can’t create a new job or folder, first make sure you have selected a folder in the 
tree view area to which you have Create rights. If you still cannot create a new job or 
folder, ask your TapeWare administrator to grant you Create permission to a folder. 

Modify 
This permission allows a user to change the name and location of an object, such as a job, 
in the TapeWare storage management database. Modify permission also allows a user to 
change or modify the property sheets of an object. If you have this permission, you will 
be able to move, rename and change the property sheets of objects. For example, to 
change the name of job, a user must have Modify permission to that job. You must also 
have Modify permission to move a job from one folder to another. 

Delete, Read and Write 
These three permissions control user access to objects, such as tapes, devices and files, 
that are read, deleted or written to. These permissions are necessary in order to run 
backup, restore and verify jobs as specified below. 



Chapter 4 — Permissions 47 

 

• To complete a backup job, a user must be granted Read permission to the files to be 
backed up and Write permission to both the media and the backup device. If the 
backup job will overwrite the media with the new data (as opposed to merely 
appending the new data), the user must also have Delete permission to the media. 

• To complete a restore job, a user must be granted Write permission to the volumes 
(disk drives) on which the files are going to restored and Read permission to the 
media and backup device. If the restore job will overwrite or replace old files, the 
user must have Delete permission to those files. 

• To complete a verify job, a user must be granted Read permission to the files on the 
workstation or file server to be verified, to the media and to the backup device. 

Examples of Permissions 

The following two examples illustrate how the permissions work with each other. 

Permissions Example #1 

In this example, a user named Galen Clark has effective permissions to a folder named 
Clark’s Jobs, to a drive (or volume) named Clark’s 2 Gig Drive and to a tape named 
Clark’s Personal Backup Tape.  

Database Object Effective Permissions 

 Clark’s Jobs (Job folder) [––CMDRW] 

 Clark’s 2 Gig Drive (Volume) [–––––R-] 

 Clark’s Personal Backup Tape (Media) [–––––R-] 
 

These permissions allow Clark to do the following: 

• Because Clark has Create permission to the Clark’s Jobs folder, he will be able to 
create new job folders within that folder and to create backup, restore and verify jobs 
inside that folder. The Modify permission allows him to move these jobs between 
folders, to change the name of the job and to change the property sheets of these jobs. 
The Delete permission allows him to delete any jobs or folders inside this folder. 
Clark also has Read and Write permissions to the Clark’s Jobs folder and will have 
these same permissions to any object stored in that folder. 
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• Because Clark also has Read permission to the volume named Clark’s 2 Gig Drive, 
he will be able to select files from that drive for backup. He will also be able to select 
files for restoring. 

• Because Clark has Read permission to both the tape and to the volume, he will be 
able to create and run verify jobs—if he also has Read permission to the backup 
device. 

These permissions do NOT allow Clark to do the following: 

• Although Clark will be able to create a backup job, he will not be able to run the 
backup job because he does not have Write permission to the tape. The job must be 
run by the TapeWare administrator or some other user the TapeWare administrator 
grants Write permission to the tape. 

• Similarly, although Clark will be able to create a restore job, he will not be able to 
run the restore job because he does not have Write permission to the disk drive. If 
Clark wants to run the restore job, he must ask the TapeWare administrator to run it 
for him or to grant him the permissions necessary to run it. 

• Clark is prevented from granting permission to other users to his folder, to his drive 
and to his tape because he lacks Access permission to these objects. 

Permissions Example #2 

In this example, a user named Stephen Mather has effective permissions to a drive named 
Mather’s 1 Gig Drive and to a tape named Mather’s Personal Backup Tape. He is also 
a member of the Conservationist group which has effective permissions to a folder 
named Conservationist Workgroup Jobs. 

Database Object Effective Permissions 

 Mather’s 1 Gig Drive (Volume) Mather: [–––––R–] 

 Mather’s Personal Backup Tape (Media) Mather: [–––––RW] 

 Conservationist Workgroup Jobs (Folder) Conservationists: [––CMDRW] 

 

These permissions allow Mather to do the following: 

• Because he is a member of the Conservationist group, Mather will be able to create 
jobs and folders within the Conservationist Workgroup Jobs folder. He will also be 
able to modify and delete any jobs or folders in that folder. 
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• Because Mather has Modify permission to the folder and Read permission to the 
drive named Mather’s 1 Gig Drive, he will be able to select files from that drive to 
backup. Similarly, Mather will be able to select files for restoring because he has 
Read permission to the tape named Mather’s Personal Backup Tape. 

• Unlike Clark, Mather will be able to run backup jobs because he has Write 
permission to the tape. (This assumes he also has Write permission to a tape drive.) 

• Mather will also be able to create and run Verify jobs. 

These permissions do NOT allow Mather to do the following: 

• Although Mather will be able to create and run backup jobs, he will not be allowed to 
restore files from those tapes onto his drive because he has not been granted Write 
permission to his disk drive. 

• When Mather runs a backup job, he will be prevented from overwriting old files on 
the tape with new files because he does not have Delete permissions to the tape. Thus 
the backup jobs he creates and runs must all be append jobs. 

• Mather, like Clark, is prevented from granting permission to other users to either his 
drive or his tape because he lacks Access permission. 

Other members of the Conservationist group also have some permissions to the jobs and 
folders inside the Conservationist Workgroup Folder, including those created by 
Mather. This affects them in the following ways: 

• They will be able to view the folders and jobs Mather creates in the Conservationist 
Workgroup Folder. Because they have Modify permission, members of the 
Conservationist group will be able to modify the properties of any jobs or folders 
Mather creates inside the Conservationist Workgroup Folder. 

• Because members of this group lack Read permission to Mather’s drive and tape, 
they will be unable to change the files Mather selected for backing up or restoring—
even if they have Modify permission to a job Mather created. 

• No other members of this group can run one of Mather’s jobs unless the TapeWare 
administrator grants them the appropriate Read and Write permissions. 
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Granting Permissions to Other TapeWare Users 

If your TapeWare administrator has given you Access permission to an object, you will 
be able to grant other users and groups permissions to that object. Generally your 
TapeWare administrator will only grant you Access permission to objects in the 
TapeWare database when he or she wants you to be able to share this data with other 
users. 

For example, if your TapeWare administrator has given you Access permission to an 
archive tape, you will be able to grant other users Read permission to the tape. This 
would allow other users to restore files from this tape to any drive they have Write 
permission to. 

To Grant Permission to Other TapeWare Users 
1. Open the properties window of the object to which you wish to grant users or groups 

permission. 

2. Click on the Permissions tab. (If you don’t have Access permission to an object, the 
Permissions tab will not appear on the object’s property sheet.) 

3. Click the Add… button. 

4. Select a user or group to add in the Browse window and then click OK. 

5. Select the appropriate Permissions check boxes at the right of the window. 
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To grant 
permissions 

to another 
user, begin 
by clicking 
the Add… 

button… 

…then 
select a 
user or 

group in the 
Browse 

window… 

…and check the 
appropriate 
permissions. 

 

Restricting User Permissions 
In most cases you can restrict the permissions a user has to an object in the same way you 
grant permissions—by clearing the appropriate check boxes on the Permissions tab of 
that object. If the user or group is not listed on the Permissions tab of the object, you 
must first add that user or group to the list of users or groups that have direct permissions 
to that object. 

To Restrict Permissions of Other TapeWare Users 
1. Open the properties window of the object to which you wish to restrict user or group 

permissions. 

2. Click on the Permissions tab. (If you don’t have Access permission to an object, the 
Permissions tab will not appear on the object’s property sheet.) 

3. If the user is not listed on the Permissions tab, first add the user or group by clicking 
the Add… button and then selecting a user or group to add in the Browse window. 

4. Select the user or group to whom you wish to deny permissions on the Permissions 
tab. 

5. Clear the appropriate Permissions check boxes at the right of the window. 
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To deny a user 
permissions to an 
object, add that 
user to the object’s 
Permissions tab 
and clear all of the 
Permissions check 
boxes. 

 
When you restrict a user’s direct permissions to a container, you also change that user’s 
effective permissions to objects within that container—but only when the user’s effective 
permissions to those objects are inherited from that container’s effective permissions. For 
example, if you deny a user direct Modify permission to a job folder by clearing the 
Modify check box under that user’s name, you also deny that user effective Modify 
permission to jobs stored in that folder—unless that user has direct permissions to those 
jobs. 

Normally, your TapeWare administrator will have arranged the security of your storage 
management zone to prevent unauthorized permission to files and tapes. However, if you 
believe another user’s permission to an object should be restricted and you cannot restrict 
it yourself, notify your TapeWare administrator. 
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Chapter 5 — Selecting Files and Instances 

You use the Selection tab of a job’s property sheet to select files for backing up, restoring 
and verifying. TapeWare’s powerful selection filters allow you to select exactly the files 
you want and to automatically update your selection before the job is run. 

In This Chapter 

• Overview 

• Backup Selection Concepts 

• Selecting Files for Backup Jobs 

• Restore Selection Concepts 

• Selecting Files for Restore Jobs 

• Restoring Files with New Names and Locations 

• Verify Selection Concepts 

• Selecting Files for Verify Jobs 

Overview 

When you select files for a job, you want to select only those files which are necessary 
for your job and not any others. However, you also want your selection criteria to be 
flexible enough to automatically select new files that meet your criteria. 

TapeWare allows files to be selected in several ways: by directly selecting volumes, 
folders and files; by using filters to sort through selected files; and by additional 
automated filters used by TapeWare when your job is run. For restore jobs, you can also 
specify which instance or version of a file you wish to restore, what name that new file 
will have and what folder or directory the file will be restored to. 
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By specifying your selection criteria carefully, when TapeWare automatically updates the 
selected file list each time your job is run, you can be certain that the job will work with 
those files you intended to select. 

This chapter discusses how to select files for separately each type of job: backup jobs, 
restore jobs and verify jobs. For each type of job, there is a discussion of concepts you’ll 
need to correctly and carefully select files. Be certain to read this section before 
proceeding. 

Backup Selection Concepts  

You use the Selection tab of a job to select files for that job. 

Files are selected for backup in three steps. In the first step, the appropriate files are 
selected by marking them with a check. In the second step, these marked files are sorted 
through using filter selection criteria. This step is optional. In the last step, as the job is 
run, TapeWare checks to see if it will back up all the files or only those files that have 
changed since the last backup job. 

Marking Files for Backup 
A file is selected for backup when the selection box next to the file is checked. 

When the box next to a folder or other container is gray, it means that this folder or 
container contains selected files, even though it is not selected itself. When the box next 
to a folder or other container is grayed and checked, the folder itself is selected and may 
also contain selected files within it. 

Grayed selection boxes 
without checks mean that 
there are selected objects 

in the container. 

Grayed selection boxes 
with checks mean that the 
container itself is selected 

and may also contain 
selected objects within it. 

A checked 
selection box 
indicates the 
file is selected.  



Chapter 5 — Selecting Files and Instances 55 

 

You can select or deselect a file for backup by checking or clearing the selection box next 
to the file. You can also select the folder that contains the file and not the file itself. 
Notice that when you mark a container, such as a folder or volume, all of its contents, 
including all the folders and containers it contains, are also marked. 

When you select 
a folder… 

…its contents 
are automatically 
selected as well. 

 

Selecting Folders vs. Selecting Files 
You can select the contents of the folder in one of two ways: either by individually 
marking the selection box of each object in that folder one-by-one or by marking the 
selection box of the folder itself. Which method you choose is important because it 
affects which files TapeWare includes in the selection list after changes have been made 
to that folder. 

If you select the contents of the folder individually, when new objects such as files are 
added to the folder, TapeWare does not select them for backup. However, if you select 
the folder itself, when new items are created in that folder, TapeWare also selects these 
files for backing up. 

When you 
select a 
folder… 

…new objects 
created in that 
folder are 
automatically 
selected.  

In general, when selecting files for backup, especially for jobs designed for disaster 
protection, begin by selecting containers at the top of the TapeWare hierarchy. Then 
deselect containers or files lower in the hierarchy that you do not need to back up. 

For example, you could begin by selecting the network container icon at the top of the 
hierarchy. This will automatically select all of the machines on the network and all of the 
volumes on those machines. If there are machines, volumes or folders you do not want 
backed up, unselect them by clearing their selection box. When new machines or 
volumes are added to the network (that is to the current storage management zone), 
TapeWare will automatically select these machines and volumes. 
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There is an additional reason to select containers rather than the objects in the containers: 
to ensure that you don’t miss any files stored loose in the container. 

For example, suppose you want to back up a folder named 1995 Fire Study Data & 
Reports and the folder named 1995 Reports that is in it, but not the folder named Field 
Data. If you check only the 1995 Reports folder, your job will not back up any files in 
the 1995 Fire Study Data & Reports folder that are not in the 1995 Reports folder. 
Instead, check the 1995 Fire Study Data & Reports folder and then clear the Field Data 
folder. This selects all files in both the 1995 Fire Study Data & Reports and 1995 
Reports folders. 

When you 
select a 

container… 

…all of its contents 
are also checked, 

including loose files. …loose 
objects 
are not 
selected. 

But when you 
select the 
contents of a 
container… 

 

Selecting Files with Filters 
Selection filters let you identify specific volumes, folders and files to exclude from the 
backup, restore or verify job. Click the Selection Filters button on the toolbar. Then 
specify the filter criteria for the job. 

Note  The selection filters you specify are applied to all of the volumes, folders and files 
that have been marked for the job. You cannot apply different filters to different folders 
or volumes in the same job. 

How Selection Filters Work 
By default, TapeWare backs up all volumes, folders and files that have been marked for 
the job. Selection filters let you identify specific criteria for excluding one or more of 
these marked objects. TapeWare applies these filter criteria at runtime, in effect 
unmarking any objects that do not meet the criteria. 

 
Selection 
Filters button 



Chapter 5 — Selecting Files and Instances 57 

 

For example, suppose you want to exclude all files that were created before 2002. Access 
the Date Range window for the Create range field. Select On or after for the Range 
type. Enter 1-Jan-2002 for the Starting date. When you run the job, TapeWare 
temporarily deselects all files with a creation date before 2002. They will be excluded 
from the backup. 

You can change the filter criteria at any time. You can also mark or unmark objects 
before running the job. TapeWare does not apply the filter criteria to any marked object 
until it runs the job. 

Note  You cannot use selection filters to add unmarked objects to the job set. Selection 
filters are only used to exclude marked objects from the job set. 

Filters and Grayed Folders 
When you apply a filter to a marked folder, this may result in no files from that folder 
being selected. Although no files in that folder are selected, the folder will still appear 
with a grayed selection box next to it. The grayed selection box indicates that if any new 
files which meet the filter criteria are created in that folder, they will be selected for the 
job. 

Grayed folders 
indicate that any files 

contained in the 
folder that meet the 

selection filter’s 
criteria will be 

selected.  

Selecting Changed Files Only 
When you run a job repeatedly, particularly backup jobs designed for disaster protection, 
many times you only want to back up files that have changed since the last time you ran a 
backup job. TapeWare handles this with the backup mode setting. 

If you want to back up all selected files, use the Full backup mode setting; TapeWare 
does not deselect any selected files. 

If you only want to back up files that have changed since the last full backup, use the 
Differential backup mode setting; TapeWare automatically deselects all the files that 
have not changed since the last full backup. 
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If you only want to back up files that have changed since the last backup, use the 
Incremental backup mode setting; TapeWare automatically deselects all the files that 
have not changed since the last backup. 

The job then runs with this updated selected file list. 

Automatically Selecting New Files for Backup 
When you set up a job to run repeatedly, you want that job to adjust to changes made to 
any of the directories on your computer or any machine in your storage management 
zone. Sometimes these changes include the addition of new files and directories that were 
not originally selected when the job was created. It may even include the addition of new 
machines on the network or any volumes on these machines that were not previously 
selected for backup. 

If your selection criteria was carefully specified, TapeWare will also select these new 
files, folders, volumes and machines for backup. In general, a new file or container is 
selected for backup if (1) it is in a container selected for backup and (2) it meets the 
selection filter criteria. 

For example, a new folder will be included in the backup selection list if it is in a selected 
container. If you create a new folder at the root level on a volume, that folder will be 
selected for backup if the volume was marked for backup. The files in that folder that 
pass through the selection filter criteria will be included in the backup job. However, if 
the volume itself was not selected, the new folder will not be selected. 

If you’ve 
selected 

the folder 
itself… 

…any new 
objects created 
in it will be 
automatically 
selected. 

 
If you want to see what files will be backed up, open up the Selection tab on the job’s 
property sheet. Whenever this tab is opened, TapeWare recalculates which files should be 
selected for backup. Check the display to see that the files you intended to be backed up 
are selected. 

Note  The Selection tab shows all files that will be backed up by a full backup job. It does 
NOT indicate which files will not be backed up by a differential or incremental backup.  
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Selecting Files for Backup Jobs 

To select files for backup jobs 
1. Open the property sheet of the backup job and click on the Selection tab. 

2. Check the selection boxes next to the files, folders or other containers you wish to 
include in the job. 

3. Click on the Selection Filters button on the toolbar and specify filter selection 
criteria. (You can skip this step if you don’t wish to apply any selection filters.) 

4. Examine the tree view and object detail areas on the Selection tab to see that the files 
you intended to select are marked for backup. 

Applying Filter Criteria 
When you click on the Selection Filters button, the Selection Filters window appears. 
This window has multiple selection filters you can apply to the files you have selected. 

Selection 
Filters 

window for 
backup jobs 

 

Note  Each filter criterion works independently. To be selected for backup, each file must 
pass every filter criterion specified. For example, if you specify that every file selected 
must have been created after January 1, 2002 and must have .doc as its extension, 
TapeWare will only select files which meet both selection criteria. 

 
Selection 
Filters button 

 
Selection 
Filters button 
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Filter Selection Criteria 
This section contains a brief description of each selection filter TapeWare applies to the 
files and folders marked for backup. 

Note that some of the selection criteria are operating system-specific. Your storage 
management zone may include multiple machines working with files created by different 
operating systems. If you select a filter criterion that is operating system-specific, files 
from other operating systems will be automatically excluded from the backup. This 
affects, in particular, the Required attributes and Exclude attributes filters. 

Note  TapeWare figures the century dates using the following algorithm: if the year is 70 
or smaller, the century is set to 20 (21st century); if the year is 71 or greater, the century 
is set to 19 (20th century). For example, if you set the date to 01-Jun-33, TapeWare 
calculates the date as June 1, 2033. If the date is set to 05-Apr-81, TapeWare calculates 
the date as April 5, 1981. 

Backup Range 
The backup date is the date a file or other object was last backed up. Each time a file is 
backed up, TapeWare changes the backup date to match the current date. Each file has 
exactly one backup date. You can use this filter for files that have been backed up on 
specific dates. More often, however, you would use this filter to filter out files that have 
been recently backed up. 

To select files that have specific backup dates, click on the Filter Change button next to 
the Backup range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Date Range 
window  

 
Filter Change 
button 
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Modify Range 
Each time a file is modified, its modified date is updated. You can use this filter to 
backup files whose modified date matches your criteria. TapeWare checks the directory 
information on the volume to see if the file should be included for backup. For example, 
you can select only those files that were modified after a certain date and time or, 
alternatively, those that were modified before a certain date and time. 

To select files that have specific modify dates, click on the Filter Change button next to 
the Modify range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Create Range 
When a file is first created, it is assigned a create date. You can use this filter to select 
only those files that match your criteria. TapeWare checks the created date for each file 
stored in the directory of the volume and uses this to select files for backing up. 

To select files that have specific creation dates, click on the Filter Change button next to 
the Create range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Note  Since DOS does not support create dates, TapeWare ignores this filter on DOS 
volumes. 

Access Range 
Each time a file is read, whether or not it is modified, its access date is updated. You can 
use this information to select files for backup. For example, you might want to back up 
only those files which have been accessed (opened or read) in the past two months. 
Alternatively, you could back up only those files which have not been accessed in the 
past two months. 

To select files that have specific access dates, click on the Filter Change button next to 
the Access range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Note  Since DOS does not support access dates, TapeWare ignores this filter on DOS 
volumes. 

Size Range 
This filter lets you select files for backup according to their sizes. You might want to 
select only smaller files, larger files or files between two sizes. 

 
Filter Change 
button 

 
Filter Change 
button 

 
Filter Change 
button 
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To specify a filter that sorts files according to their sizes, click on the Filter Change 
button next to the Size range field and then select the appropriate criteria in the Size 
Range window that appears. 

Size Range 
window  

Instance Range 
Each time TapeWare backs up a file, it creates a new instance of that file. For example, a 
file named Expense Account Reporting Form may have been backed up several times 
during the previous months and years. Typically, each instance of the file is stored on the 
backup media of a different job. TapeWare tracks each instance of a file separately in its 
storage management database. 

You can use this filter to instruct TapeWare to not back up files for which you already 
have multiple instances. For example, you may not want any more than three instances of 
a particular file backed up. When you set the Range type to At most and Maximum 
instances to 3, TapeWare only backs up those files with less than three instances. 

Note, however, that having multiple instances of a file does not ensure that the instances 
you have reflect the latest changes to the file. It may have been modified after the last 
time you backed it up. If so, your latest instance may not match the file’s current form. 

To specify a filter that selects files according to their number of instances, click on the 
Filter Change button next to the Instance range field and then select the appropriate 
criteria in the Instances Range window that appears. 

Instances 
Range 
window  

 
Filter Change 
button 

 
Filter Change 
button 
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Wildcard Type 
Select which wildcard format you wish to use from the list box. You can use any of the 
following formats: 

• DOS: Uses the 11-character name format with the eight-character primary name and 
the three-character extension, e.g., filename.txt. 

• Long: Uses the 256-character name format with a long primary name and an 
extension with multiple characters, e.g., Monday_backup.txt. 

• UNIX: Uses UNIX search expression format, e.g., [Mm]onday. 

Must Match 
TapeWare lets you use wildcard matches to include files. Only files that match the 
wildcard indicated in the Must match field are included in the backup set. For example, 
if you enter *.exe, TapeWare will only back up those files with the .exe file extension. 

You can specify multiple wildcards by separating each with a semicolon (no spaces). For 
example, if you enter *.exe;*.doc in the Must match field, TapeWare selects all files that 
have either the .exe extension or the .doc extension. 

Cannot Match 
This wildcard field works just like the Must match field except that it excludes any files 
that match the wildcards. You can specify multiple wildcards by separating them with a 
semicolon (no spaces); if you specify multiple wildcards, TapeWare excludes any file 
that matches any one of the wildcards you specify. 

Required Attributes 
Operating systems track certain features of files called attributes that they use to manage 
these files. You can use these same attributes as a selection filter. In the Required 
attributes field, if an attribute is checked, TapeWare only selects those files which have 
these attributes. For example, if you check Hidden, TapeWare only selects those files 
which the operating system has assigned the Hidden attribute. 

You can select multiple attributes. In this case, TapeWare only selects those files that 
meet all of the required attributes. 

Note that some of these attributes are only supported by certain operating systems. If you 
specify an attribute that is specific to a particular operating system, then only files created 
under that operating system will be selected for backup. 
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Exclude Attributes 
This field works like the Required attributes field except that TapeWare excludes files 
that match these attributes. For example, if you have checked the Execute Only box, 
TapeWare will exclude from the backup job any files with the Execute Only attribute. 

You can select multiple attributes. A file that has any one of these attributes will be 
excluded. For example, if you mark the Hidden and System attributes, any file that has 
either attribute will be excluded. 

Parents 
When this option is checked, TapeWare backs up the directory information for the parent 
along with the file. This option must be checked in order for folders and other directory 
data to be backed up. When this option is not checked, TapeWare will not back up any 
parent information for any file backed up. 

Children 
When this option is checked, TapeWare backs up the selected files. If you want only to 
back up the marked directories, however, you can clear this option. When the Children 
box is unchecked and the Parents box is checked, TapeWare backs up the directory 
structure, but not the files stored in the directories (that is, in the folders). 

This option can be useful for replicating a complex directory structure. Begin by marking 
the directory structure you wish to duplicate. Then clear the Children option. TapeWare 
will back up only the directory structure. You can then replicate that directory structure to 
any volume by restoring the directory to that volume. 

Media 
TapeWare tracks instances of files and the media on which those instances are stored. 
You can use this information to sort files according to the media on which they appear. 
Only files with instances on the media in the Media field will be selected for the backup 
job. For example, if you select media named “Daily Set:1,” TapeWare will only include 
files in the backup job which have a valid instance on the media named “Daily Set:1.” 

To sort files according to the media on which they appear, click the Add... button and 
select the media from the Browse window. Note that you must select a Media object, not 
a Media folder or User/Group folder. If there are multiple media shown in the Media 
filter field, only files which have a valid instance on all the media listed will be selected. 
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This filter has limited applications for backup jobs. One way to use it, however, would be 
in the case of media you know is corrupt or damaged. To back up a new instance of every 
file on that damaged media, begin by creating a new job and then selecting the 
appropriate Network or Machine object on the Selection tab. Then open the Selection 
Filters window by clicking on the Selection Filters button. Add the damaged media to 
the Media field. Then set the Backup mode on the job’s Options tab to Snapshot. When 
TapeWare runs the job, it will only back up files which had an instance on the damaged 
media shown in the Media field. 

Restore Selection Concepts 

You select files for restoring the same way you select files for backing up; however 
besides selecting which files you wish to restore, you can also change the name of the 
restored file, restore it to a new location and create a new folder in which to restore the 
file. Additionally, when you select a file for restoring, you must specify which instance of 
the file you wish to restore. 

Files are selected for restoring in four steps. In the first step, you modify the file tree to 
look the way you want it to appear when you restore the files. For example, you might 
make a new folder to store the restored files in. Second, the appropriate files are selected 
by marking them with a check and selecting the appropriate instance. In the third step, 
these files are filtered using multiple selection criteria. In the last step, you can specify 
new names and locations for the restored files. 

Selecting Files for Restoring 
A file is selected for restoring when a check mark appears in the selection box next to the 
file. 

When the box next to a folder or other container is gray, it means that this folder or 
container contains selected files, even though it is not selected itself. When the box next 
to a folder or other container is grayed and checked, the folder itself is selected and may 
also contain selected files within it. 
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Grayed selection boxes 
without checks mean that 
there are selected objects 

in the container. 

Grayed selection boxes 
with checks mean that the 
container itself is selected 

and may also contain 
selected objects within it. 

A checked 
selection box 
indicates the 
file is selected.  

You can select or deselect a file for restoring by checking or clearing the selection box 
next to the file. You can also select the folder that contains the file and not the file itself. 
Notice that when you mark a container, such as a folder or volume, all of its contents, 
including all the folders and containers it contains, are also marked. 

When you select 
a folder… 

…its contents 
are automatically 
selected as well. 

 

Note  The tree view and object detail areas are different for restore jobs than for backup 
jobs. For restore jobs, the files displayed in the tree view and object detail areas are the 
files for which TapeWare has instances in its storage management database. For backup 
jobs, on the other hand, the files displayed are those currently present on the file servers 
and workstations in the current database zone. 

Selecting Instances of Files 
Each time a file is backed up, an instance of that file is created. There may be multiple 
instances of files stored on different media created by different backup jobs. TapeWare 
keeps track of all the instances of each file in its storage management database and the 
media on which each instance is stored. When media is overwritten or deleted, TapeWare 
deletes those instances from its storage management database as well. 
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When you select a file for restoring, TapeWare automatically selects the <Latest> 
instance. If you want to select an instance other than the latest instance of a file backed 
up, you must select that instance in the Instances of... window. When you open the 
Instances of... window, the Available instances field shows a list of the instances of the 
file and the media on which those instances are stored. Select which instance you want to 
restore by highlighting it. For more information about a particular instance of a file, click 
on the Details button. TapeWare displays various details it uses to manage the file in its 
storage management database, including its backup date and its modify date. 

Instances 
window  

If you select the <Latest> parameter, TapeWare will restore the most recent instance of 
that file or folder. 

In general, if you want to restore a specific instance of the file, you must select that file 
directly and specify which instance you wish to restore in the Instances of… window. 

Note that when you specify an instance date for a container, such as a folder or a volume, 
only those files which have matching instance dates will be selected. If a file does not 
have an instance date that matches the date of the container, it will not be selected. On the 
other hand, if you want only certain files to be restored, you can specify the instance date 
of a container to only select those files with matching instance dates. 

Selecting Instances of Folders 
When you select a folder, TapeWare automatically selects the <Latest> instance for that 
folder and for every file within that folder. If you wish to specify another instance, open 
the Instances of… window and highlight the instance date to select it. 

TapeWare uses the instance you specified when you selected the folder to also select files 
contained within that folder. Specifically, a file is selected for restoring only if an 
instance matches the folder instance. 

Note  When you specify an instance date for a folder, volume or other container, files 
stored in that container are only selected when they have an instance date that matches 
the instance date of the container. Many times, files will not have instance dates that 
match the dates of the containers they are stored in, for example, when you select an 
instance date from an incremental or differential backup job. To be sure you select all of 
the files inside a container, select the <Latest> instance for that container. 



68 TapeWare® User’s Guide and Technical Reference 

 

Consider these two examples: 

In the first example, by selecting the <Latest> instance of the folder, all of the files 
contained within the folder are selected because each of these files has a <Latest> 
instance. Note that these instances may be from different dates and different backup jobs, 
but because each file has a <Latest> instance, each one will be restored. 

When you select 
the <Latest> 
instance of a 

folder… 

…every object in it 
will be selected.  

In the second example, another instance besides the <Latest> instance was selected. In 
order for the files within the folder to be selected for restoring, they must have an 
instance date that matches that selected for the folder. In this example, some files are not 
selected for restoring because they do not have an available instance which matches the 
instance date selected for the folder. 

When you select 
an instance date of 
a folder other than 

the <Latest>… 

…some objects in that 
folder may not be selected if 
they do not have a matching 

instance date.  
In general, if you want to restore a specific instance of the file, you must select that file 
directly and specify which instance you wish to restore in the Instances of… window. 

Selecting Folders vs. Selecting Files 
You can select the contents of the folder in one of two ways: either by individually 
marking the selection box of each object in that folder one-by-one or by marking the 
selection box of the folder itself. Which method you choose is important because it 
affects which files TapeWare includes in the selection list after changes have been made 
to that folder. 
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For example, if you select a folder for restoring by marking its selection box, all of the 
contents of that folder are restored. If a new backup job is run before the restore job is 
run, TapeWare selects files for restoring using the new folder’s contents. So, for example, 
if a new file is created in that folder, TapeWare will also restore that file. Additionally, if 
you have selected the <Latest> instance of the folder, TapeWare will use the latest 
instance of each file in its storage management database. These files may be newer than 
the files you originally selected. 

Instances and Filters 
You cannot use filters for selecting instances. The Selection Filters window can be used 
to sort through the instances you have otherwise specified in the Instances of... window, 
but filters will not change the selected instance date. 

Selecting Files with Filters 
Selection filters let you identify specific volumes, folders and files to exclude from the 
restore job. Click the Selection Filters button on the toolbar. Then specify the filter 
criteria for the restore job. 

Note  The selection filters you specify are applied to all of the volumes, folders and files 
that have been marked for restore. You cannot apply different filters to different folders 
or volumes in the same job. 

How Selection Filters Work 
By default, TapeWare restores all volumes, folders and files that have been marked for 
restore. Selection filters let you identify specific criteria for excluding one or more of 
these marked objects. TapeWare applies these filter criteria at runtime, in effect 
unmarking any objects that do not fit the criteria. 

For example, suppose you want to exclude all files that were created before 2002. Access 
the Date Range window for the Create range field. Select On or after for the Range 
type. Enter 1-Jan-2002 for the Starting date. When you run the job, TapeWare 
temporarily deselects all files with a creation date before 2002. They will be excluded 
from the restore. 

You can change the filter criteria at any time. You can also mark or unmark objects 
before running the job. TapeWare does not apply the filter criteria to any marked object 
until it runs the job. 

Note  You cannot use selection filters to add unmarked objects to the restore set. 
Selection filters are only used to exclude marked objects from the restore set. 

 
Selection 
Filters button 
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Changing the Name and Location of Restored Files 
When you restore a file, you may wish to restore the file with a new name or in a new 
location. If you restore a file to its original location using its original name, if that file 
currently exists there, TapeWare overwrites the current file with the restored file. 

You can avoid overwriting current files by giving the file a new name or by restoring the 
file to a new directory. For example, to avoid replacing the current file named Project 
List with a previous, older instance of the file, you can rename the file before restoring it 
or restore it to a different folder. 

You can either select a different folder or, alternatively, TapeWare lets you create a new 
folder in which to restore the files. 

Selecting Instances of Files for Restore Jobs 

Each time you mark a selection box of a file or folder for restoring, TapeWare 
automatically selects the <Latest> instance. If you want to specify a different instance, 
use the Instances of… window to select which instance of the file you wish to restore. 

You can also specify a particular instance of a file or folder by highlighting it in the tree 
view or object detail areas and then clicking the Select Instance button on the toolbar. 
TapeWare will show you the Instances of… window with a list of the available instances 
for that file. 

Be certain to specify carefully which instance of a file you wish to restore. A single 
TapeWare restore job can restore files backed up over a period of months or years on 
media created by many different backup jobs. You can easily restore all of the latest 
instances of the files by selecting <Latest> in the Instances of… window. However, if 
you want instances of files that were created on different dates, you must select each 
instance of each file individually. 

Note that you cannot restore multiple instances of the same file in a single restore job. If 
you want to restore more than one instance of a file, you must create and run a separate 
job for each instance. 

To select instances of files for restore jobs 
1. Open the Properties sheet of the restore job and click on the Selection tab. 

2. Check the selection boxes next to the files, folders or other containers you wish to 
include in the job. 

 
Select Instance 
button 
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3. To select a specific instance of the objects you selected, highlight the folder or file 
and click the Select Instance button. In the Instances of… window that appears, 
select the appropriate date of the instance you wish to restore. If you want to include 
all of the files in a folder or on a volume, select <Latest>. 

4. Click on the Selection Filters button on the toolbar and specify filter selection 
criteria. (You can skip this step if you don’t wish to apply any selection filters.) 

5. Examine the tree view and object detail areas on the Selection tab to check that the 
files you intended are marked for restoring. 

Additionally, you can change the names of the files and store them in new locations. This 
is discussed in Restoring Files with New Names and Locations later in this chapter. 

Applying Filter Criteria 
When you click on the Selection Filters button, the Selection Filters window appears. 
This window has multiple selection filters you can use to sort through the files you have 
selected for restoring. 

Selection 
Filters 

window for 
restore jobs 

 

Note  Each filter criterion works independently. To be selected for restoring, each file 
must pass every filter criterion specified. For example, if you specify that every file 
selected for restoring must have been created after January 1, 2002 and must have .doc as 
its extension, TapeWare will only select files which meet both selection criteria. 

 
Select Instance 
button 

 
Selection 
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Filter Selection Criteria 
This section contains a brief description of each selection filter TapeWare applies to the 
files and folders marked for restoring. 

Note that the Selection Filters window for restore jobs is similar to the Selection Filters 
window for backup jobs. This allows you to use the same filters to select the files for 
restoring that you used for selecting files for backing up previously. This allows you to 
create a restore job that selects the same files as a backup job, no matter how widely 
distributed over the network these files may be. 

Note  TapeWare figures the century dates using the following algorithm: if the year is 70 
or smaller, the century is set to 20 (21st century); if the year is 71 or greater, the century 
is set to 19 (20th century). For example, if you set the date to 01-Jun-33, TapeWare 
calculates the date as June 1, 2033. If the date is set to 05-Apr-81, TapeWare calculates 
the date as April 5, 1981. 

Backup Range 
When a file is backed up, TapeWare stores in its storage management database the date 
the file was backed up. This is called the backup date. Each time you back up a file, 
TapeWare changes the backup date to the date of the backup. (You can view this 
information for all of the available instances in the Instances of… window in the Backed 
up field list.) You can use this information to filter files for restore jobs. 

To select files that have specific backup dates, click on the Filter Change button next to 
the Backup range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Date Range 
window  

 
Filter Change 
button 
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Modify Range 
Each time a file is modified, its modified date is updated. You can use this filter to restore 
files whose modified date matches your criteria. TapeWare checks the directory 
information on the volume to see if the file should be included in the restore job. For 
example, you can select only those files that were modified after a certain date and time 
or, alternatively, those that were modified before a certain date and time. 

To select files that have specific modify dates, click on the Filter Change button next to 
the Modify range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Create Range 
When a file is first created, it is assigned a create date. You can use this filter to select 
only those files that match your criteria. TapeWare checks the created date for each file 
stored in the directory of the volume and uses this to select files for restoring. 

To select files that have specific creation dates, click on the Filter Change button next to 
the Create range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Note  Since DOS does not support create dates, TapeWare ignores this filter on DOS 
volumes. 

Delete Range 
This filter gives you an easy way to select files to restore that have been deleted from the 
volume, but for which TapeWare has valid instances stored in its storage management 
database and on valid media. 

When files that have once been backed up are later deleted, TapeWare marks these files 
with a special icon, indicating that they have been deleted. In addition, TapeWare assigns 
the file a delete date, which you can view on the General tab of that file’s property sheet. 
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Files that have been 
backed up and then 

deleted show special 
icons on the 

Selection tab of a 
restore job. 

Any object that has 
been backed up and 

then is deleted will 
show a Deleted date 

on its General tab. 

 
This filter instructs TapeWare to only restore files which have a delete date that matches 
the criteria you have set. Note that if a file has not been deleted from the volume, it will 
be excluded by this filter and thus will not be selected for restoring. 

You can easily select every file deleted for restoring by first marking the selection box of 
the volume and selecting the <Latest> instance. This will cause all of the files to be 
selected initially. Then, click on the Filter Change button next to the Delete range field 
and then select On or before from the Range type list box. Next select a random future 
date, for example, February 6, 2106. TapeWare will exclude all of the files that have not 
been deleted from the set of files to be restored. When you return to the Selection tab, 
only those files that have been deleted will be checked. 

On the other hand, you can also not restore files that have been deleted. In this case, set 
the Delete range filter to On or before some random early date, such as January 1, 1980. 
Any file that has been deleted will be filtered out by this filter, so that no deleted files 
will be restored. This can be useful if you don’t want to unnecessarily restore files that 
were properly deleted in the first place. 

 
Filter Change 
button 
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Access Range 
Each time a file is read, whether or not it is modified, its access date is updated. You can 
use this information to select files for restoring. For example, you might want to restore 
only those files which have been accessed (opened or read) in the past two months. 
Alternatively, you could restore only those files which have not been accessed in the past 
two months. 

To select files that have specific access dates, click on the Filter Change button next to 
the Access range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Note  Since DOS does not support access dates, TapeWare ignores this filter on DOS 
volumes. 

Size Range 
This filter lets you select files to restore according to their sizes. You might want to select 
only smaller files, larger files or files between two sizes. 

To specify a filter that sorts files according to their sizes, click on the Filter Change 
button next to the Size range field and then select the appropriate criteria in the Size 
Range window that appears. 

Size Range 
window  

Instance Range 
Each time TapeWare backs up a file, it creates a new instance of that file. For example, a 
file named Expense Account Reporting Form may have been backed up several times 
during the previous months and years. Typically, each instance of the file is stored on the 
backup media of a different job. TapeWare tracks each instance of a file separately in its 
storage management database. 

You can use this filter to instruct TapeWare to select files according to the number of 
instances that exist in the database. You might, for example, instruct TapeWare to restore 
all of the files for which there is only one instance. When you set Range type to At most 
and Maximum instances to 1, TapeWare only restores those files with a single instance. 
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Note, however, that having multiple instances of a file does not ensure that the selected 
instances reflect the latest changes to the file. If it was modified after the last time you 
backed it up, your latest instance may not match the file’s current form. 

To specify a filter that sorts files according to their number of instances, click on the 
Filter Change button next to the Instance range field and then select the appropriate 
criteria in the Instances Range window that appears. 

Instances 
Range 
window  

Wildcard Type 
Select which wildcard format you wish to use from the list box. You can use any of the 
following formats: 

• DOS: Uses the 11-character name format with the eight-character primary name and 
the three-character extension, e.g., filename.txt. 

• Long: Uses the 256-character name format with a long primary name and an 
extension with multiple characters, e.g., Monday_backup.txt. 

• UNIX: Uses UNIX search expression format, e.g., [Mm]onday. 

Must Match 
TapeWare lets you use wildcard matches to include files. Only files that match the 
wildcard indicated in the Must match field are included in the restore set. For example, 
if you enter *.exe, TapeWare will only restore those files with the .exe file extension. 

You can specify multiple wildcards by separating each with a semicolon (no spaces). For 
example, if you enter *.exe;*.doc in the Must match field, TapeWare selects all files that 
have either the .exe extension or the .doc extension. 

Cannot Match 
This wildcard field works just like the Must match field except that it excludes any files 
that match the wildcards. You can specify multiple wildcards by separating them with a 
semicolon (no spaces); if you specify multiple wildcards, TapeWare excludes any file 
that matches any one of the wildcards you specify. 

 
Filter Change 
button 
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Required Attributes 
Operating systems track certain features of files called attributes that they use to manage 
these files. You can use these same attributes as a selection filter. In the Required 
attributes field, if an attribute is checked, TapeWare only selects those files which have 
these attributes. For example, if you check Hidden, TapeWare only selects those files 
which the operating system has assigned the Hidden attribute. 

You can select multiple attributes. In this case, TapeWare only selects those files that 
meet all of the required attributes. 

Note  Some attributes are only supported by certain operating systems. If you specify an 
attribute that is specific to a particular operating system, then only files created under that 
operating system will be selected for restore. 

Exclude Attributes 
This field works like the Required attributes field except that TapeWare excludes files 
that match these attributes. For example, if you have checked the Execute Only box, 
TapeWare will exclude from the restore job any files with the Execute Only attribute. 

You can select multiple attributes. A file that has any one of these attributes will be 
excluded. For example, if you mark the Hidden and System attributes, any file that has 
either attribute will be excluded. 

Parents 
When this option is checked, TapeWare restores directory information for any selected 
folder or volume. For example, if you have marked a folder, TapeWare will restore that 
folder only if this option is checked. When this option is not checked, directory 
information about folders and volumes is not restored. 

Children 
When this option is checked, TapeWare restores files. When this option is unchecked, 
TapeWare does not restore files. This is useful if you want to restore a complex directory 
structure, but not the files in that directory. To restore a directory structure, but not the 
files (children) stored in the directories, begin by marking the directory for restoring. 
Then clear the Children option. TapeWare will restore only the directory structure to the 
volume you specify. 
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Media 
TapeWare tracks instances of files and the media on which those instances are stored. 
You can use this information to sort files according to the media on which they appear. 
Only files with instances on the media in the Media field will be selected for the restore 
job. For example, if you select media named “Daily Set:1,” TapeWare will only include 
files in the restore job which have a valid instance on the media named “Daily Set:1.” 

To sort files according to the media on which they appear, click the Add... button and 
select the media from the Browse window. Note that you must select a Media object, not 
a Media folder or User/Group folder. If there are multiple media shown in the Media 
filter field, only files which have a valid instance on all the media listed will be selected. 

This filter can be useful for restore jobs if you want to restore files only from a particular 
media. For example, you may have imported media from another storage management 
zone and may wish to limit the files restored to those on that particular media. In this 
case, you can ensure that only files on that media are selected by adding that media to the 
Media field. 

Note, however, that under ordinary circumstances, you should let TapeWare track the 
instances of particular files and restore files not according to the media on which they 
appear, but rather according to their instance date. For example, if you want to restore 
the most recent version of a file, simply select the file. TapeWare will automatically 
select that file and identify the proper media on which that instance is stored. TapeWare 
will then prompt you for the correct media when the job is run. 

Restoring Files with New Names and Locations 

You can change the name and location (folder) of a file when it is restored. You can also 
create a new folder in which to store the file. 

Restoring a File with a New Name 
After a file has been selected for restoring, you can rename the file. When you rename the 
file, TapeWare restores the file with the new name. This can be useful for not overwriting 
versions of the file that currently exist on disk. 

To rename a file, right-click the file name, select Rename from the shortcut menu and 
type the new name. You can also click its name again and type the new name. 

To restore a file with a new name, 
select it, click it again and type 

the new name. 
 

For more 
information, 
see Import 
Media in 
Chapter 9 — 
The Media, 
Device and 
Database 
Tabs. 
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Note that when you rename an instance, you are only renaming that file for the purposes 
of restoring it with this particular restore job. Only the current restore job will assign the 
new name to that file. When you create a new restore job, you will see the file displayed 
with its original name. Similarly, the Database tab always displays files with the names 
they had when they were backed up. 

Restoring Files to a Different Folder 
You can also restore files to different folders. When TapeWare restores the file, it creates 
a new file in the new location. Similarly, you can restore folders in new locations as well. 
This is useful in order to prevent overwriting files and folders that currently exist on disk. 

To restore a file to a different folder, drag the file in the tree view area to the new folder. 
Alternatively, right-click the file name and select Move… from the shortcut menu. In the 
Confirm Move window, select a target location. TapeWare will move the file to the 
location you specify in the Target field. 

To restore a folder 
or file to a different 
folder, select it and 

then drag it to the 
new folder… 

…and then confirm 
the move in the 
Confirm Move 

window. 

 
You can also restore folders and volumes in new locations. The contents of these 
containers move with them and are restored, along with the folder or volume, in the new 
location. 

Note that when you move an instance on the Selection tab of a restore job, the changes 
you make are only recorded for that restore job. Only the current restore job will assign 
the file or folder the new location. When you create a new restore job, you will see the 
files and folders in their original locations. Likewise, the Database tab will continue to 
display files in their original locations. 
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Restoring Files to a New Folder 
You can also create a new folder and restore files to that new folder. When TapeWare 
restores the files, it creates the new folder and restores the files you specified to that new 
location. Similarly, you can restore folders and their contents in new folders you create. 

To create a new folder in which to restore the file or folder, first highlight the location 
you want to create the new folder in the tree view area. Then click on the New Object 
button on the Selection tab’s toolbar. You can also right-click the container and select 
New Directory from the shortcut menu. TapeWare creates the new folder in the specified 
location. Give the folder a new name and then drag the files and folders to restore into the 
new folder. 

To restore a file or folder to a new folder, 
right-click the container in which you 

want to create the new folder and select 
New Directory from the shortcut menu. 

Next, drag the folder or file 
you want to restore to the 

new folder you created. 
 

Note that any new folder you create on the Selection tab of the restore job is only created 
in the restore job currently opened. Only the current job will show this new folder. When 
you create a new restore job or open another restore job, the new folder you created in the 
current job will not be displayed. Likewise, the new folder you created will not be 
displayed on the Database tab either. 

Verify Selection Concepts 

You select files for verifying the same way you select files for backing up or restoring, 
including selecting which instance to verify. 

Files are selected for verifying in two steps. In the first step, the appropriate files are 
selected by marking them with a check and selecting the appropriate instance. In the 
second step, these files are filtered using multiple selection criteria. 
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Tip  You can quickly check to see if a file was verified when it was backed up by opening 
the Instances of… window for that file. The Status field will show either Verify 
complete, Verify failed or Not verified depending on whether or not that file was 
successfully verified or not when the job was run. 

Selecting Files for Verifying 
A file is selected for verifying when a check mark appears in the selection box next to the 
file. 

When the box next to a folder or other container is gray, it means that this folder or 
container contains selected files, even though it is not selected itself. When the box next 
to a folder or other container is grayed and checked, the folder itself is selected and may 
also contain selected files within it. 

Grayed selection boxes 
without checks mean that 
there are selected objects 

in the container. 

Grayed selection boxes 
with checks mean that the 
container itself is selected 

and may also contain 
selected objects within it. 

A checked 
selection box 
indicates the 
file is selected.  

You can select or deselect a file for verifying by checking or clearing the selection box 
next to the file. You can also select the folder that contains the file and not the file itself. 
Notice that when you mark a container, such as a folder or volume, all of its contents, 
including all the folders and containers it contains, are also marked. 

When you select 
a folder… 

…its contents 
are automatically 
selected as well. 
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Note  The tree view and object detail areas are different for verify jobs than for backup 
jobs. For verify jobs, the files displayed in the tree view and object detail areas are the 
files for which TapeWare has instances in its storage management database. For backup 
jobs, on the other hand, the files displayed are those currently present on the file servers 
and workstations in the current database zone. 

Selecting Instances of Files 
Each time a file is backed up, an instance of that file is created. There may be multiple 
instances of files stored on different media created by different backup jobs. TapeWare 
keeps track of all the instances of each file in its storage management database and the 
media on which each instance is stored. When media is overwritten or deleted, TapeWare 
deletes those instances from its storage management database as well. 

When you select a file for verifying, TapeWare automatically selects the <Latest> 
instance. If you want to select an instance other than the latest instance of a file backed 
up, you must select that instance in the Instances of... window. When you open the 
Instances of... window, the Available instances field shows a list of the instances of the 
file and the media on which those instances are stored. Select which instance you want to 
verify by highlighting it. For more information about a particular instance of a file, click 
on the Details button. TapeWare displays various details it uses to manage the file in its 
storage management database, including its backup date and its modify date. 

Instances 
window  

If you select the <Latest> parameter, TapeWare will verify the most recent instance of 
that file or folder. 

In general, if you want to verify a specific instance of the file, you must select that file 
directly and specify which instance you wish to verify in the Instances of… window. 

Note that when you specify an instance date for a container, such as a folder or a volume, 
only those files which have matching instance dates will be selected. If a file does not 
have an instance date that matches the date of the container, it will not be selected. On the 
other hand, if you want only certain files to be verified, you can specify the instance date 
of a container to only select those files with matching instance dates. 



Chapter 5 — Selecting Files and Instances 83 

 

Selecting Folders vs. Selecting Files 
You can select the contents of the folder in one of two ways: either by individually 
marking the selection box of each object in that folder one-by-one or by marking the 
selection box of the folder itself. Which method you choose is important because it 
affects which files TapeWare includes in the selection list after changes have been made 
to that folder. 

For example, if you select a folder for verifying by marking its selection box, all of the 
contents of that folder are verified. If a new backup job is run before the verify job is run, 
TapeWare selects files for verifying using the new folder’s contents. So, for example, if a 
new file is created in that folder, TapeWare will also verify that file. Additionally, if you 
have selected the <Latest> instance of the folder, TapeWare will use the latest instance 
of each file in its storage management database. These files may be newer than the files 
you originally selected. 

Selecting Files with Filters 
Selection filters let you identify specific volumes, folders and files to exclude from the 
verify job. Click the Selection Filters button on the toolbar. Then specify the filter 
criteria for the verify job. 

Note  The selection filters you specify are applied to all of the volumes, folders and files 
that have been marked for verify. You cannot apply different filters to different folders or 
volumes in the same job. 

How Selection Filters Work 
By default, TapeWare verifies all volumes, folders and files that have been marked for 
verification. Selection filters let you identify specific criteria for excluding one or more 
of these marked objects. TapeWare applies these filter criteria at runtime, in effect 
unmarking any objects that do not fit the criteria. 

For example, suppose you want to exclude all files that were created before 2002. Access 
the Date Range window for the Create range field. Select On or after for the Range 
type. Enter 1-Jan-2002 for the Starting date. When you run the job, TapeWare 
temporarily deselects all files with a creation date before 2002. They will be excluded 
from the verify. 

You can change the filter criteria at any time. You can also mark or unmark objects 
before running the job. TapeWare does not apply the filter criteria to any marked object 
until it runs the job. 

 
Selection 
Filters button 
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Note  You cannot use selection filters to add unmarked objects to the verify set. Selection 
filters are only used to exclude marked objects from the verify set. 

Selecting Instances of Files for Verify Jobs 

Each time you mark a selection box of a file or folder for verifying, TapeWare 
automatically selects the <Latest> instance. If you want to specify a different instance, 
use the Instances of… window to select which instance of the file you wish to verify. 

You can also specify a particular instance of a file or folder by highlighting it in the tree 
view or object detail areas and then clicking the Select Instance button on the toolbar. 
TapeWare will show you the Instances of… window with a list of the available instances 
for that file. 

Be certain to specify carefully which instance of a file you wish to verify. A single 
TapeWare verify job can verify files backed up over a period of months or years on 
media created by many different backup jobs. You can easily verify all of the latest 
instances of the files by selecting <Latest> in the Instances of… window. However, if 
you want instances of files that were created on different dates, you must select each 
instance of each file individually. 

Note that you cannot verify multiple instances of the same file in a single verify job. If 
you want to verify more than one instance of a file, you must create and run a separate 
job for each instance. 

To select instances of files for verify jobs 
1. Open the property sheet of the verify job and click on the Selection tab. 

2. Check the selection boxes next to the files, folders or other containers you wish to 
include in the job. 

3. To select a specific instance of the objects you selected, highlight the folder or file 
and click the Select Instance button. In the Instances of… window that appears, 
select the appropriate date of the instance you wish to verify. If you want to include 
all of the files in a folder or on a volume, select <Latest>. 

4. Click on the Selection Filters button on the toolbar and specify filter selection 
criteria. (You can skip this step if you don’t wish to apply any selection filters.) 

5. Examine the tree view and object detail areas on the Selection tab to check that the 
files you intended to select are marked for verifying. 

 
Selection 
Filters button 

 
Select Instance 
button 

 
Select Instance 
button 
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Applying Filter Criteria 
When you click on the Selection Filters button, the Selection Filters window appears. 
This window has multiple selection filters you can use to sort through the files you have 
selected for verifying. 

Selection 
Filters window 

for verify jobs 
 

Note that each filter criterion works independent of every other. In order to be selected 
for verifying, each file must pass every filter criterion specified. For example, if you 
specify that every file selected for verifying must have been created after January 1, 2002 
and must have .doc as its extension, TapeWare will only select files which meet both 
selection criteria. 

Filter Selection Criteria 
This section contains a brief description of each selection filter TapeWare applies to the 
files and folders marked for verifying. 

Note that the Selection Filters window for verify jobs is similar to the Selection Filters 
window for backup jobs. This allows you to use the same filters to select the files for 
verifying that you used for selecting files for backing up previously. This allows you to 
create a verify job that selects the same files as a backup job, no matter how widely 
distributed over the network these files may be. 

 
Selection 
Filters button 
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Note  TapeWare figures the century dates using the following algorithm: if the year is 70 
or smaller, the century is set to 20 (21st century); if the year is 71 or greater, the century 
is set to 19 (20th century). For example, if you set the date to 01-Jun-33, TapeWare 
calculates the date as June 1, 2033. If the date is set to 05-Apr-81, TapeWare calculates 
the date as April 5, 1981. 

Backup Range 
When a file is backed up, TapeWare stores in its storage management database the date 
the file was backed up. This is called the backup date. Each time you back up a file, 
TapeWare changes the backup date to the date of the backup. (You can view this 
information for all of the available instances in the Instances of… window in the Backed 
up field list.) You can use this information to filter files for verify jobs. 

To select files that have specific backup dates, click on the Filter Change button next to 
the Backup range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Date Range 
window  

Modify Range 
Each time a file is modified, its modified date is updated. You can use this filter to verify 
files with a modify date that matches your criteria. TapeWare checks the directory 
information on the volume to see if the file should be included in the verify job. For 
example, you can select only those files that were modified after a certain date and time 
or, alternatively, those that were modified before a certain date and time. 

To select files that have specific modify dates, click on the Filter Change button next to 
the Modify range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Create Range 
When a file is first created, it is assigned a create date. You can use this filter to select 
only those files that match your criteria. TapeWare checks the created date for each file 
stored in the directory of the volume and uses this to select files for verifying. 

 
Filter Change 
button 

 
Filter Change 
button 
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To select files that have specific creation dates, click on the Filter Change button next to 
the Create range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Note  Since DOS does not support create dates, TapeWare ignores this filter on DOS 
volumes. 

Access Range 
Each time a file is read, whether or not it is modified, its access date is updated. You can 
use this information to select files for verifying. For example, you might want to verify 
only those files which have been accessed (opened or read) in the past two months. 
Alternatively, you could verify only those files which have not been accessed in the past 
two months. 

To select files that have specific access dates, click on the Filter Change button next to 
the Access range field. In the Date Range window that appears, select the appropriate 
range type and the starting and ending dates and times. 

Note  Since DOS does not support access dates, TapeWare ignores this filter on DOS 
volumes. 

Size Range 
This filter lets you select files for verifying according to their sizes. You might want to 
select only smaller files, larger files or files between two sizes. 

To specify a filter that sorts files according to their sizes, click on the Filter Change 
button next to the Size range field and then select the appropriate criteria in the Size 
Range window that appears. 

Size Range 
window  

 
Filter Change 
button 

 
Filter Change 
button 

 
Filter Change 
button 
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Instance Range 
Each time TapeWare backs up a file, it creates a new instance of that file. For example, a 
file named Expense Account Reporting Form may have been backed up several times 
during the previous months and years. Typically, each instance of the file is stored on the 
backup media of a different job. TapeWare tracks each instance of a file separately in its 
storage management database. 

You can use this filter to instruct TapeWare to select files according to the number of 
instances that exist in the database. You might, for example, instruct TapeWare to verify 
all of the files for which there is only one instance. When you set Range type to At most 
and Maximum instances to 1, TapeWare only verifies those files with a single instance. 

Note, however, that having multiple instances of a file does not ensure that the instances 
you have reflect the latest changes to the file. It may have been modified after the last 
time you backed it up. So your latest instance may not match the file’s current form. 

To specify a filter that sorts files according to their number of instances, click on the 
Filter Change button next to the Instance range field and then select the appropriate 
criteria in the Instances Range window that appears. 

Instances 
Range 
window  

Wildcard Type 
Select which wildcard format you wish to use from the list box. You can use any of the 
following formats: 

• DOS: Uses the 11-character name format with the eight-character primary name and 
the three-character extension, e.g., filename.txt. 

• Long: Uses the 256-character name format with a long primary name and an 
extension with multiple characters, e.g., Monday_backup.txt. 

• UNIX: Uses UNIX search expression format, e.g., [Mm]onday. 

Must Match 
TapeWare lets you use wildcard matches to include files. Only files that match the 
wildcard indicated in the Must match field are included in the verify set. For example, if 
you enter *.exe, TapeWare will only verify those files with the .exe file extension. 

 
Filter Change 
button 
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You can specify multiple wildcards by separating each with a semicolon (no spaces). For 
example, if you enter *.exe;*.doc in the Must match field, TapeWare selects all files that 
either have the .exe extension or the .doc extension. 

Cannot Match 
This wildcard field works just like the Must match field except that it excludes any files 
that match the wildcards. You can specify multiple wildcards by separating them with a 
semicolon (no spaces); if you specify multiple wildcards, TapeWare excludes any file 
that matches any one of the wildcards you specify. 

Required Attributes 
Operating systems track certain features of files called attributes that they use to manage 
these files. You can use these same attributes as a selection filter. In the Required 
attributes field, if an attribute is checked, TapeWare only selects those files which have 
these attributes. For example, if you check Hidden, TapeWare only selects those files 
which the operating system has assigned the Hidden attribute. 

You can select multiple attributes. In this case, only files which have all of the specified 
attributes will be selected. 

Note that some of these attributes are only supported by certain operating systems. If you 
specify an attribute that is specific to a particular operating system, then only files created 
under that operating system will be selected for verifying. 

Exclude Attributes 
This field works like the Required attributes field except that TapeWare excludes files 
that match these attributes. For example, if you have checked the Execute Only box, 
TapeWare will exclude from the verify job any files with the Execute Only attribute. 

You can select multiple attributes. A file that has any one of these attributes will be 
excluded. For example, if you mark the Hidden and System attributes, any file that has 
either attribute will be excluded. 

Parents 
When this option is checked, TapeWare verifies the directory information for any 
selected folder or volume. For example, if you have marked a folder, TapeWare will 
verify that folder only if this option is checked. When this option is not checked, 
directory information about folders and volumes is not verified. 
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Children 
When this option is checked, TapeWare verifies files. When this option is unchecked, 
TapeWare does not verify files. This is useful if you want to verify a complex directory 
structure, but not the files in that directory. To verify a directory structure, but not the 
files (children) stored in the directories, begin by marking the directory for verifying. 
Then clear the Children option. TapeWare will verify only the directory structure on the 
volume you specify. 

Media 
TapeWare tracks instances of files and the media on which those instances are stored. 
You can use this information to sort files according to the media on which they appear. 
Only files with instances on the media in the Media field will be selected for the verify 
job. For example, if you select media named “Daily Set:1,” TapeWare will only include 
files in the verify job which have a valid instance on the media named “Daily Set:1.” 

To sort files according to the media on which they appear, click the Add... button and 
select the media from the Browse window. Note that you must select a Media object, not 
a Media folder or User/Group folder. If there are multiple media shown in the Media 
filter field, only files which have a valid instance on all the media listed will be selected. 
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Chapter 6 — Scheduling Jobs 

TapeWare offers flexible job scheduling. For ease of use and maximum security, you can 
use one of TapeWare’s built-in job schedules. Or, alternatively, you can customize a 
job’s schedule to efficiently meet your specific needs. 

In This Chapter 

• Overview 

• Backup Job Scheduling Concepts 

• Selecting a Backup Schedule 

• Customizing Schedules 

• Manual Backup Jobs 

• Scheduling Restore Jobs 

• Scheduling Verify Jobs 

Overview 

This chapter covers the Schedule tab of a TapeWare job, which controls when and how 
often a job is run. 

Although the Schedule tab is relevant to all job types, the Schedule tab is especially 
important for backup jobs. The Schedule tab allows you to set up a comprehensive 
backup program many years into the future or, alternatively, to run a job just once or 
occasionally. 

The first part of this chapter reviews scheduling concepts for backup jobs, while the 
second part explains how to create and modify backup job schedules. The final part of 
this chapter reviews these concepts for restore and verify jobs. 
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Backup Job Scheduling Concepts 

This section explains some concepts and terminology helpful for choosing and selecting 
backup job schedules. It reviews media rotation, backup mode and backup job type. 

Backup Job Schedule Type 
TapeWare jobs can be scheduled in four distinct ways, either as Not Scheduled, Manual 
Rotation, Automatic Rotation with Built-in Schedule or Automatic Rotation with Custom 
Schedule. This flow chart compares the different types of schedules: 

 Job is a 
Not Scheduled job 

Job is a Rotation job 

Is the job scheduled 
or unscheduled? 

Is the schedule a 
custom or built-in 

schedule? 

Is the media 
rotated manually 
or automatically? 

Scheduled 

Unscheduled 

Job is a 
Manual Rotation job Manually 

Job is an Automatic 
Rotation job 

Automatically 

Custom  
Job is a 

Custom Schedule job 

Built-in 

Job is a 
Built-in Schedule job 
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The four schedules differ from one another in the following ways: 

• Is the job scheduled or unscheduled? 

Backup jobs are either not scheduled or scheduled. Some jobs, such as archive or 
historical backups, may run once or only occasionally. These jobs are not scheduled 
because they only run when you instruct them to do so. 

Scheduled jobs are also called rotation jobs. These backup jobs are generally 
designed for disaster protection and differ from not scheduled jobs in two ways. First, 
backup jobs for disaster protection are run routinely, normally daily, and thus are 
scheduled. Second, these jobs rotate media, while unscheduled jobs typically do not. 

• If scheduled, is the media rotated manually or automatically? 

Rotation jobs fall into two categories: manual rotation and automatic rotation. For 
manual rotation jobs, the user is responsible for creating the rotation sets and for 
selecting media for rotation (overwriting); for automatic jobs, TapeWare handles 
these functions by using predefined rotation sets and rotation algorithms. 

For example, to create a five-day manual rotation, you add a new backup job for each 
day of the week, assigning a different media set to each job. TapeWare backs up to 
the appropriate media set on its scheduled backup day, overwriting the data from the 
previous week. 

Generally, most jobs designed for disaster protection use automatic rotation. Manual 
rotation capability increases the flexibility of TapeWare and is useful in special 
circumstances. Normally, however, if you wish to create and run rotation jobs, 
choose an automatic rotation schedule. 

• If automatic rotation, is the schedule a custom schedule or a built-in schedule? 

Automatic rotation jobs divide into two categories: custom schedule or built-in 
schedule. 

The difference between a custom schedule job and a built-in schedule job is whether 
the user or TapeWare controls the backup mode and the set count. With a custom 
scheduled job, the user specifies the backup mode and set count; with a built-in 
schedule job, TapeWare handles these functions using predetermined, “built-in” 
schedules. 

Backup Mode 
Backup jobs differ according to whether they back up all files or only changed files. 
Whether a job backs up all the files or only changed files is referred to as the backup 
mode. 
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TapeWare runs backup jobs in one of four backup modes: full, differential, incremental 
or snapshot. A job run in full backup mode backs up all selected files. A differential job 
backs up all selected files that have changed since the last full backup. An incremental 
job backs up all selected files that have changed since the last backup. A snapshot job 
backs up all selected files, but has no effect on any future scheduled jobs. Full backup 
jobs are the largest and usually take the longest to run, while incremental and differential 
jobs are shorter and usually take less time to run. 

Note  The snapshot backup mode is only available with Manual jobs. 

Normally, all media in a set will be created with the same backup mode. For example, all 
media in the Weekly set will be created from jobs run in full backup mode. The Daily 
set, on the other hand, is created in incremental backup mode. 

Media Rotation 
Backup jobs performed for disaster protection are often run daily. Rather than use new 
media each time a job is run, TapeWare recycles or reuses the oldest media. This is 
efficient because it keeps costs down by limiting the amount of media needed and still 
provides for data security. 

Note  Media rotation only applies to custom and built-in schedules. 

The process of recycling or reusing media is referred to as media rotation. When 
TapeWare rotates media, it recycles the oldest media by overwriting it with new data. 

For example, suppose three backup jobs were run on Monday, Tuesday and Wednesday. 
On Thursday, it overwrites the oldest media (Media1), which contains Monday’s backup. 
On Friday, TapeWare overwrites Tuesday’s backup (Media2), which is now the oldest. 

Media3 (Wed.) 
 

Media2 (Tues.) 
 

Media1 (Mon.) 

The oldest 
media in a 

rotation set... 

…will be the next to be 
overwritten with new data. 

Media2 will be overwritten 
on Friday. 

Media1 (Thurs.) 
 

Media3 (Wed.) 
 

Media2 (Tues.) 

 
Rotation Set  A rotating media set is referred to as a rotation set. Each job group (Daily, 
Weekly, Monthly, Yearly) can contain one or more media sets, each of which can 
contain one or more media. When TapeWare runs a job, it overwrites the oldest media set 
in the job group. As a result, it becomes the newest media set with the most recent 
backup. 
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Media Set Count  Each job group requires a certain number of media sets to provide full 
data recovery and historical snapshots. When you configure your backup schedule, you 
identify the Count of media sets for each group. For example, the Yearly group might 
consist of two media sets, whereas the Daily group might consist of eight media sets. 

 

Each job group can 
contain one or more 
media sets. 

The Count is the 
number of rotating 
media sets specified 
for each job group. 
Each media set can 
contain more than 
one media. 

 

Selecting a Backup Job Schedule 

Whether or not you schedule a job and the type of schedule you select depends on several 
factors. Before proceeding, consider the following questions: 

• What is the purpose of this job—to protect from disasters, to archive files or to make 
a historical record? 

• What degree of risk to the data on the network is reasonably allowable? 

• Will the amount of traffic on the network require that backup jobs be scheduled to 
run during non-peak periods? Are there certain days of the week when running 
lengthy jobs will interfere with other uses of the network? 

• Are there times when the tape drive will be unavailable? 

• Will someone monitor the job as it runs? 

• How large will a full backup job be? 

• How much data does the media hold? How much media does my budget allow me? 
Or, alternatively, how many tapes does my autoloader hold? 
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Not Scheduled Backup Jobs 
Some jobs, such as archive or historical backups, may run once or only occasionally. 
These jobs are not regular, so they are considered to be not scheduled. They only run 
when you instruct them to do so. 

By default, backup jobs are not scheduled. To specify that a job is not scheduled, be 
certain that Not Scheduled is selected in the Type box on the job’s Schedule tab. 

 When you want a job to run only 
once or occasionally, select Not 
scheduled in the Type box on 
the job’s Schedule tab. 

 

Caution  Backup jobs designed to protect data from disaster should always be scheduled. 
This is the most effective way of insuring that your data will be safely stored on media 
with regular backups. 

Built-In Schedules for Backup Jobs 
Backup jobs designed for disaster protection are run routinely, normally daily. TapeWare 
has several types of built-in schedules. Each of these built-in schedules will ensure the 
security of your data, that is, disaster protection, the ability to recover and reconstruct 
data after some catastrophic loss. 

The built-in schedules also provide some archive and historical backup functions, 
although you may design separate backup programs for these purposes. The built-in 
schedules vary from each other according to the number of tapes each uses and how far 
back historical and archival copies of files are kept. For example, some schedules use as 
few as four tapes, while others use as many as 30. Some schedules keep copies of some 
historical files available for as long as two years, while others only provide access to files 
from the past couple of days. 
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Which Built-In Schedule to Select 
There are eight built-in schedules. The schedules vary in three ways: the number of days 
for which full data recovery is available, the level of access to historical files provided 
and the minimum number of tapes or other media needed. 

The eight 
automatic rotation, 

built-in schedule 
types.  

Full Data Recovery Period 
All the built-in schedules provide for full data recovery in case of disaster. The full data 
recovery period is the number of days prior to the data loss for which any and every file 
backed up can be recovered. You will also be able to reconstruct the data for any 
particular day during that period. 

Different schedules provide full data recovery periods for varying numbers of days prior 
to the last backup. For example, a GFS 30-tape job can reconstruct the data from any day 
of the past three weeks, while a Simple 4-tape job only provides for reconstruction of the 
past two days. 

Access to Historical Files 
Jobs also vary according to how much access to historical files they provide. Historical 
files are “snapshots” of the data at particular times such as the end of the week or the end 
of the month. 

Because they are only “snapshots,” not all files from previous weeks and months may be 
available. For example, you may have a historical “snapshot” of your data at the end of 
April 2002 and May 2002. Files that were created and deleted during May will not be 
available on either one of these historical tapes. 

Different schedules will give you different levels of historical access to previous weeks, 
months and years. For example, a GFS 30-tape job has eight weekly tapes, seven 
monthly tapes and two yearly tapes. This provides the user with historical snapshots of at 
least the end of the week for the past eight weeks, the end of the month for the past seven 
months and the end of the year for the past two years. On the other hand, a Simple 4-tape 
job only provides end-of-week snapshots of the last two weeks. 
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While these historical tapes cannot replace true historical backups, they do provide for 
some level of available access to historical data. Consider, for example, the yearly tapes. 
Each of the three GFS built-in schedules has two yearly backup tapes. The first time you 
run one of these jobs, you create a yearly tape. The next yearly tape is made at the end of 
the current calendar year. The following year, the first tape is recycled, that is, its data is 
overwritten with the new data and information about the files backed up is deleted from 
the storage management database. This process continues with the second tape being 
recycled the following year and so forth. 

Note  Yearly tapes only provide you with access to files present at the time the files were 
backed up. No copy exists for files that were created after the oldest yearly backup and 
then deleted before the most recent yearly backup. To preserve a copy of these files, you 
must archive them before deleting them. 

Minimum Number of Tapes or Media 
The name of each built-in schedule indicates the minimum number of tapes or other 
media needed for that schedule type. 

Note that the actual number of tapes needed may be more, depending on the amount of 
data to be backed up during a full backup and the size of your tape. If the total size of a 
full backup is larger than the capacity of the tape, additional tapes are required. For 
example, if a tape holds 1 GB, two tapes are required to back up more than 1 GB of data, 
three tapes to back up more than 2 GB and so forth. 

Because incremental and differential backup jobs usually back up fewer selected files 
than full backup jobs, additional tapes may not be required. Your historical usage is the 
best guide to determining how many tapes these jobs will require. 

If you wish to run jobs with no one monitoring the tape drive and you are not using an 
autoloader, be certain that you are using tapes with a capacity that is larger than the total 
size of the files selected for backup. 
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Built-In Schedules Compared 
The following table compares the historical files and full data recovery capabilities of 
each of the built-in jobs. (This table assumes that no job uses more than one tape.) 

Built-In Backup  
Job Type 

Full Data Recovery Available  
for Previous… 

Historical “Snapshots”  
Available for Previous… 

GFS 30-tape three 5-day weeks or 
two 7-day weeks 
(15 business days) 

eight end-of-weeks 
eight end-of-months 
two end-of-years 

GFS 25-tape two 5-day weeks  
(10 business days) 

eight end-of-weeks 
seven end-of-months 
two end-of-years 

GFS 20-tape one 7-day week  
(7 business days) 

six end-of-weeks 
six end-of-months 
two end-of-years 

Simple 12-tape five days  four end-of-weeks 
four end-of-months 

Simple 11-tape five days four end-of-weeks 
three end-of-months 

Simple 10-tape five days four end-of-weeks 
two end-of-months 

Simple 5-tape five days one end-of-week 

Simple 4-tape two days two end-of-weeks 

Scheduling Backup Jobs with Built-In Schedules 
To use the built-in schedules, you must select a schedule and then specify a start time, 
select which days of the week the job will run and which day is the end of the week. 

To schedule a job with a built-in schedule 
1. Select a built-in schedule by selecting it from the Type list on Schedule tab of the 

backup job’s property sheet. 

2. Specify a time for the job to begin running in the Start time box. TapeWare will 
attempt to run the job at this time. 

3. Select which days of the week you wish the job to run by clicking on the day of the 
week buttons at the top of the calendar on the Schedule tab. 
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4. Specify which day is the final day of the week by selecting it from the End of week 
list. On this day, TapeWare schedules Weekly backups. 

To schedule a job with 
a built-in schedule, 

begin by selecting the 
appropriate schedule 

in the Type list box. 

Specify when you want 
the job to run in the 

Start time box. 

Select which days you wish the 
job to run by selecting the 

appropriate weekday buttons. 

Specify which day you 
want to run weekly 

backups in the End of 
week list box. 

 
Note that you can have a backup job run as frequently as every day or only once per 
week. To best protect your data, select every day of the week in which new and important 
data is generated (that is, every business day). 

Customizing Schedules  

You can also create customized schedules to meet your unique backup needs. To create a 
customized scheduled, you can modify built-in schedules or, if needed, create an entirely 
new backup schedule. 

It is strongly recommended that you use the built-in schedules for disaster protection 
backup. These schedules are specially designed to secure your data against catastrophic 
loss. If you need a custom schedule, try making a few modifications to a built-in 
schedule, rather than creating an entirely new schedule. 

Creating Custom Schedules 
You can customize the schedule of a job in one of three ways: by modifying a built-in 
schedule, by modifying the Custom schedule or by using the Manual schedule. This 
section covers how to modify built-in schedules and the Custom schedule; working with 
the Manual schedule is covered in Manual Backup Jobs later in this chapter. 
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Both modified built-in schedules and the Custom schedule allow you to change when 
monthly and weekly backups are made. However, only the Custom schedule will allow 
you to specify the set count and the backup mode, that is, the number of tapes belonging 
to each type of tape (Daily tapes, Weekly tapes and so forth) and whether those jobs are 
Incremental, Differential or Full backups. 

Only the Custom 
schedule lets you 

change the 
Backup mode of 
each rotation set 

and the set 
Count. 

 

Modifying Built-In Schedules 
You can change when Daily, Weekly, Monthly and Yearly jobs are run. This is helpful 
when the standard schedules do not fit your particular business needs or when a job fails 
to run because of a network problem or malfunction. 

For example, you may wish to change the date when the Monthly backup is run from the 
last business day to the last calendar day of the month. In the following example, the 
Monthly backup was changed from the last business day of the month to the last calendar 
day. 

To change the day the 
Monthly job is run, click 

and drag the Monthly 
calendar tile to the 
appropriate date… 

…or click the right mouse 
button on appropriate date 

and select Monthly from 
the shortcut menu. 

 
In another example, a Weekly backup job for some reason has failed to run when 
scheduled. It is important that this job be run as soon as possible or else full data recovery 
may not be possible. In the following example, the Weekly backup job that was 
scheduled to run on Saturday is rescheduled to run on Monday by changing Monday 
from a Daily backup to a Weekly backup. 
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You can change the day of 
the week that weekly backup 
jobs are run by changing the 
day name in the End of week 
list box.  

You modify the built-in schedules by changing the color-coded tiles on the Schedule tab. 
Drag the color coded tiles from the Legend to the appropriate calendar date or right-click 
the calendar and select the appropriate backup type from the shortcut menu. 

Modify the built-in 
schedules by 

dragging tiles to the 
appropriate date… 

…or clicking the right 
mouse button and 

selecting the 
appropriate rotation 

set from the shortcut 
menu.  

Modifying the Custom Schedule 
When you select Custom from the Type list on the Schedule tab, TapeWare sets the 
calendar to the GFS 25-tape built-in schedule. However, unlike the GFS 25-tape built-in 
schedule, the Custom schedule allows the user to indicate the backup mode of the Daily, 
Weekly, Monthly and Yearly jobs and the number (Count) of each type of media or 
tape. 

Changing the Tape Count 
The Custom schedule is particularly useful when you wish to change either the length of 
the full data recovery period or the level of access to historical “snapshots.” By 
modifying the tape count, you can lengthen or shorten the period in which full data 
recovery is available or the period of time for which historical “snapshots” are available. 

For example, you may wish to increase the number of yearly historical tapes available 
from two to three or more. To do so, change the number in the Yearly Count box on the 
Schedule tab to the desired number of historical backups. 
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With the Custom schedule, 
you can modify the Yearly 
rotation set Count in order 
to increase the number of 
historical tapes. 

 
Alternatively, you may wish to expand the full data recovery period, while limiting the 
number of historical backups. In the following example, the full data recovery period has 
been expanded to four five-day weeks (20 business days), with only limited monthly and 
yearly historical tapes. 

 

In this example, the full data 
recovery period has been extended 
to 20 business days with limited 
historical jobs: four incremental and 
one weekly for each week. 

 

Changing the Backup Mode 
TapeWare runs backup jobs in one of four backup modes: full, differential, incremental 
or snapshot. A job run in full backup mode backs up all selected files. A differential job 
backs up all files changed since the last full backup. An incremental job backs up files 
changed since the last backup. A snapshot job backs up all selected files, but does not 
affect any future scheduled jobs. Full backup jobs are the largest and take the longest to 
run, while incremental and differential jobs are shorter and take less time to run. 

To change the backup mode, select the new backup mode from the appropriate Backup 
mode list box on the Schedule tab of the job. 

Determining the Length of the Full Data Recovery Period 
Full reconstruction of data can be accomplished in two ways. The first method requires 
the most recent full backup tape and all of the incremental backup tapes since the full 
backup tape. The second method requires the most recent full backup tape and a 
differential job from the previous day. 

For example, to reconstruct the data for a Wednesday, you will require one of two sets of 
tapes: either, the full backup tape from the previous end of week and all of the 
incremental tapes from that week (that is, Monday’s, Tuesday’s and Wednesday’s); or, 
the full backup tape from the previous end of week and the differential tape from 
Wednesday. (In some circumstances, the preceding full backup tape will be a monthly or 
yearly job and not a weekly job.) As long as none of these tapes have been overwritten, 
full data recovery is possible. 
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The length of the data recovery period is determined both by the number of daily 
incremental or differential tapes and the number and frequency of full backup jobs 
(usually weekly jobs). 

Incremental Jobs and Full Data Recovery 
Incremental jobs are the shortest and smallest jobs to run, but they do pose some risk to 
full data recovery. The difference between an incremental and a differential backup is 
important because full data recovery is always available from a differential backup tape 
and a full backup tape, even when the differential tapes are being rotated (overwritten). 
However, when incremental tapes are overwritten or recycled, there is the possibility of 
data loss. Full data recovery cannot be guaranteed with incremental jobs. 

Using incremental backup jobs to ensure full data recovery after a disaster is not 
recommended, unless you are using a built-in schedule. However, if your particular 
network needs to limit the amount of time available to run backup jobs, you can safely 
work with incremental jobs if you are careful to follow these guidelines: 

• Have at least as many incremental tapes as there are days between full or differential 
backup jobs. For example, if you run full backup jobs every five days, have at least 
four incremental tapes; if you run full backup jobs every seven days, have at least six 
incremental tapes. 

• Never recycle incremental tapes between differential or full backup jobs. If you wish 
to run more than one incremental job in a row, be certain to not recycle any of the 
tapes used during this string of incremental jobs. 
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Manual Backup Jobs 

Manual rotation jobs differ from unscheduled jobs because they can be scheduled. 
However, unlike automatic rotation jobs, the schedule does not specify the backup mode 
or set count. 

Automatic rotation jobs allow the user to specify in the schedule the number of media in 
a set, which set is being used and the mode of the set. For manual jobs, however, these 
features of the backup plan are the responsibility of the user. The user must keep track of 
the media sets and what media are to be overwritten. Furthermore, the user must specify 
the backup mode on the Options tab of the job. 

The Manual schedule is provided for specialized uses; do not select this option for 
backup jobs intended for disaster protection. 

Because the user is 
responsible for rotating the 

media, the Manual schedule 
should be used only for special 

purposes—not disaster 
protection.  
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Scheduling Restore Jobs 

Restore jobs are either unscheduled or scheduled with the Manual schedule. In general, 
if you want to schedule a job to run, even if it is only once, select Manual. If you only 
want your job to run when you instruct it to run, select Not scheduled. 

There are only two 
schedule types for 
Restore jobs: Not 

scheduled and 
Manual. 

 
If you want to run a restore job on regular occasions, select Manual schedule. You can 
specify which days it is to run by modifying the calendar. For example, you can turn off 
certain days of the week by clicking on the day of the week buttons on the top of the 
calendar. To turn a particular day off or on, right-click it and select either None or Daily 
from the shortcut menu. 

To modify the 
Manual schedule of 
a restore job, begin 

by turning the day of 
week tiles on or off… 

…and then use the 
Shortcut menu to 

turn particular days 
on or off.  
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If you want a job to run only once, but need to schedule it to run during non-peak hours, 
try this method. Turn off all of the days of the week by clicking on the day of week name 
tiles. The calendar will be all white. Then right-click the day to run the job and select 
Daily. This will be the only day the job runs. Be certain to adjust the time you want the 
job to run in the Start Time box. 

Scheduling Verify Jobs 

Verify jobs are either unscheduled or scheduled with the Manual schedule. These are the 
only two types of schedules available for verify jobs. In general, if you want to schedule 
a verify job to run, even if it is only once, select Manual. If you only need your job to 
run when you instruct it to run, select Not scheduled. 

There are only two 
schedule types for 

Verify jobs: Not 
scheduled and 

Manual. 
 

If you want to run a verify job on regular occasions, select Manual schedule. You can 
specify which days it is to run by modifying the calendar. For example, you can turn off 
certain days of the week by clicking on the day of the week buttons on the top of the 
calendar. To turn a particular day off or on, right-click it and select either None or Daily 
from the shortcut menu. 
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To modify the Manual 
schedule of a verify 

job, begin by turning 
the day of week tiles 

on or off… 

…and then use the 
shortcut menu to turn 
particular days on or 

off. 
 

If you want a job to run only once, but need to schedule it to run during non-peak hours, 
try this method. Turn off all of the days of the week by clicking on the day of week name 
tiles. The calendar will be all white. Then right-click the day to run the job and select 
Daily. This will be the only day the job runs. Be certain to adjust the time you want the 
job to run in the Start Time box. 
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Chapter 7 — Job Options 

TapeWare uses parameters on a job’s Options tab to control various features necessary 
for running a job. TapeWare’s default values are designed to be easy and secure to use, 
but you can modify the job option parameters to meet your particular needs. 

In This Chapter 

• Overview 

• Backup Job Options 

• Advanced Options 

• Restore Job Options 

• Verify Job Options 

Overview 

This chapter covers an important tab on the property sheet of a TapeWare job: the 
Options tab. This tab controls various features of the job, such as what media is used, 
what backup device is used, whether files can be overwritten and how alerts are handled. 

Although this tab is relevant to all job types, the Options tab is especially important for 
backup jobs. Some types of backup schedules, such as automatic rotation jobs, treat 
certain job option parameters differently than do others, such as manual rotation jobs. 

The first part of this chapter focuses on backup job options, while the second part 
explains the advanced options parameters used by backup and verify jobs. Finally, these 
concepts are reviewed for both restore and verify jobs. 
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Backup Job Options 

The Options tab on the property sheet of each backup job controls various parameters 
important to how TapeWare runs a backup job. Although there are numerous choices, the 
default values have been chosen to provide the maximum degree of security and ease of 
use. Use the default values unless your particular backup needs require different settings. 

Backup job 
Options tab 

 
The following section describes each option parameter and some of the possible ways 
each might be used. 

Number of Passes 
This parameter determines how many times TapeWare will try to open a file for backup 
before it skips it and continues with the next file. The default is 3. 

The Number of passes is the 
number of times an attempt will 

be made to access a file that 
may be in use by another user. 

The Delay between 
passes is the number of 
seconds between each 
of these attempts.  

Sometimes when TapeWare is trying to back up a file, the file may already be open, that 
is, in use by another user, a software program or the operating system. Because the file 
could change, TapeWare waits until the file is not in use. Each attempt to open a file is 
called a pass. When TapeWare cannot back up a file on the first pass, it tries to back up 
the file on subsequent passes. 
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On the last pass, TapeWare opens the file in shared mode and backs it up. If the user 
changes the file between backup and verification, TapeWare indicates a file backup 
failure. If the file did not change, TapeWare indicates a file backup complete. 

For example, suppose the number of passes is set to five. On the first pass, TapeWare 
tries to back up all of the files in the file selection list. If, on the first pass, it encounters 
any open files, it skips them and tries to back them up on the second pass. If, on the 
second pass, these files are still open, TapeWare schedules them for the third pass and so 
forth until the final pass. On the final pass, in this case the fifth pass, any file not 
previously backed up is opened in shared mode, regardless if it is currently being used by 
other users. As long as the file has not changed, it will be backed up successfully. 

If your historical usage shows that many files are open during backup, or if the backup 
job will run when other users are likely to be working with the files to be backed up, set 
the value to a higher number. This will increase the number of times TapeWare attempts 
to open a file and may result in fewer files being opened in shared mode during the final 
pass. 

Delay Between Passes 
This determines how many seconds TapeWare waits before trying the next pass. If your 
historical usage suggests that many files are being opened on the last pass, consider 
increasing this parameter to a higher number. 

Log Options 
The Log options is either None, Log only failed, Log only completed or Log all. 

Log 
options 
list box  

TapeWare keeps a log of which files are backed up while running a job. After a job is 
run, you can view or print the log to see which files were successfully or unsuccessfully 
backed up. The default value is Log only failed, which writes in the log any files which 
were not successfully backed up. This is particularly useful for locating any problems 
with running the backup job. 

None  This parameter instructs TapeWare to not keep a log of the backup job as it runs. 

Log only failed  This parameter instructs TapeWare to log the name of any selected file 
that was not backed up. Use this option to check if a backup job is running correctly. 

Log only completed  This parameter instructs TapeWare to log the name of any file 
selected for backup and successfully backed up. You might use this option to produce a 
list of files backed up for archive purposes. 
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Log all  This parameter instructs TapeWare to log the name of every file selected for 
backup and whether or not that file was successfully backed up. You can use this option 
to be certain that a backup job is running correctly as you planned. 

Backup Mode 
The Backup mode is either Full, Incremental, Differential or Snapshot. For scheduled 
automatic rotation jobs, TapeWare uses the backup mode for each backup set as indicated 
on the Schedule tab; for unscheduled or manual jobs, TapeWare uses the parameters set 
by the user. For more information, see Backup Options Automatically Updated later in 
this chapter. 

Backup mode 
list box 

 
Full  This parameter instructs TapeWare to back up all selected files. For each file, 
TapeWare resets the incremental bit in the storage management database and the archive 
bit on disk.  

Differential  This parameter instructs TapeWare to back up all selected files that have 
changed since the last full backup. When a file changes, its differential bit has been set. 
TapeWare does not reset any bits. 

Incremental  This parameter instructs TapeWare to back up all selected files that have 
changed since the last backup. For each file, TapeWare resets the incremental bit in the 
storage management database and the archive bit on disk. 

Snapshot  This parameter instructs TapeWare to back up all selected files, but it has no 
effect on any future scheduled job. (A snapshot backup job does not reset the archive bit 
after backing up all the selected files.) Use this option when you wish to make a record of 
files or systems at a particular time, but do not wish to disrupt the normal backup 
schedule. 

For more information on the differences between incremental and differential backup 
jobs and the importance between them for data recovery, see Chapter 6 — Scheduling 
Jobs. 

Change Mode 
The Change mode is either Skip device, Force to append or Prompt. This option 
determines what action TapeWare will perform when it fails to find the media it was 
expecting to use for a job. When TapeWare runs a job, if the job uses specific media, 
TapeWare scans the network for devices with that media. If it does not find the media it 
expects, its response is determined by the Change mode parameter. 



Chapter 7 — Job Options 113 

 

Change 
mode list box  
Skip device  This parameter instructs TapeWare to skip the designated device when it 
does not find the proper media, e.g., if the wrong media is loaded or the device has 
malfunctioned. TapeWare looks for the proper media on other devices on the network. 
TapeWare will not continue the job until it finds the correct media. As a result, the job 
may never run if the correct media is not found. 

Force to append  This parameter instructs TapeWare to append data to whatever media it 
finds in the designated backup device, as long as the media is in the storage management 
database. If it cannot find the correct media, TapeWare appends data to whatever media 
is available. This option will ensure that the job runs, if the media contains enough room 
to complete the job. 

Prompt  This parameter instructs TapeWare to continue to scan for the expected media 
and to send an alert warning that the proper media has not been found. This option will 
not allow a job to run with any other media except with the expected media. Additionally, 
this option will not search for another device that might contain the proper media. 

Write Mode 
The Write mode is either Append to all tapes, Append to 1st tape, overwrite others or 
Overwrite all tapes. For scheduled automatic rotation jobs, TapeWare defaults to 
Overwrite all tapes; for unscheduled and manual jobs, TapeWare uses the parameters set 
by the user. For more information, see Backup Options Automatically Updated later in 
this chapter. 

Write mode 
list box 

 
This mode determines whether the old data on the media is overwritten with new data or 
whether the new data is appended to the end of the old data. When media is overwritten, 
all of the data previously stored on it is lost. Appending data will preserve the old data. 

Unless the media is meant to be stored permanently, select Overwrite all tapes. This is 
because when tapes or media are rotated (reused), TapeWare overwrites it. If you have 
appended data to the media, overwriting will result in the loss of not just the oldest 
material, but all of the data on the media, including the most recent. For this reason, use 
Overwrite all tapes for media you wish to reuse through rotation, such as tapes that are 
part of a set of daily incremental backups, and Append to all tapes or Append to 1st 
tape, overwrite others for media meant for permanent storage. 
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Appending is useful if the number of tapes is limited or if the tapes are several times 
larger than the size of the job. For example, a one gigabyte tape could hold the contents 
of four jobs that are less than 250 Mbytes if these jobs were appended. However, if 
overwrite mode is selected, only one job will be stored on a tape at once. Similar 
comments apply to other types of media. 

Append to all tapes  This parameter instructs TapeWare to append all data to the end of 
the media. No data is overwritten. Select this parameter for permanent storage. 

Append to 1st tape, overwrite others  This parameter instructs TapeWare to append data to 
the end of the first media, but to overwrite all media that follows. For example, 
TapeWare will not overwrite the first tape inserted, but will overwrite the second, third 
and later tapes. This parameter is useful if you have a set of media with old data you no 
longer need. By selecting this option, TapeWare preserves your most recent data on the 
first media, but overwrites older, unneeded media. 

Overwrite all tapes  This parameter instructs TapeWare to overwrite all media. All data on 
media that is overwritten is lost. Use this option for tapes that are going to be recycled. 

Auto Verify Mode 
The Auto verify mode is either No verify, Full verify or Quick verify. 

After TapeWare backs up a file onto a tape, it can verify that the file was backed up 
correctly. TapeWare reads the file from the tape and compares it to the original file (Full 
verify mode). If any discrepancies between the two files are found, the file is considered 
to have failed the backup. 

Auto verify 
mode list box  

It is strongly recommended that the Auto verify mode be set to Full verify. Verification 
that data has been correctly written to the tape is an essential part of a comprehensive 
backup program. Also, verifying the files ensures that the tape and the tape drive are 
working correctly. Restoring data after a disaster is no time to discover that the data was 
incorrectly stored to begin with. 

No verify  This parameter instructs TapeWare to skip the verification step. It is not 
recommended. 

Full verify  This parameter instructs TapeWare to compare every selected file stored on 
the media with the original file from the workstation or file server. This default option is 
strongly recommended. 



Chapter 7 — Job Options 115 

 

Quick verify  This parameter instructs TapeWare to be certain that every file backed up 
onto the media is in readable condition. It does not verify that the data is correct, only 
that the data stored on the media (incorrect or not) can be read. While selecting this 
option can save time, it is nonetheless not recommended. 

Compression Type 
The Compression type is either None, Standard, System or Both. 

Compression 
type list box  

This parameter controls how TapeWare compresses or maintains the compression of files 
and directories. 

None  This parameter instructs TapeWare to write all data to the tape in a decompressed 
format. If the file is stored on disk in a compressed format, the file will be decompressed 
before writing. This option is useful if the device supports hardware data compression 
and the files are to be restored to a different operating system. 

Standard  This parameter instructs TapeWare to write all data to tape in the TapeWare 
compression format. If the file is stored on disk in a compressed format, the file will be 
decompressed before being re-compressed by TapeWare. This option is useful if the tape 
device does not support hardware data compression and the files are to be restored to a 
different operating system. 

System  This parameter instructs TapeWare to write all data to tape in the same mode it is 
stored on disk. If the file is stored on disk in compressed format, TapeWare will write the 
data in the host’s compressed format. If the file is not compressed on disk, TapeWare will 
store the file on tape in a non-compressed format. This option is useful if the hardware 
supports data compression and the files are to be restored to the same operating system. 
This option also gives better performance. 

Note  If the backup device supports hardware compression, be sure to select the System 
option. Then enable Hardware compression on the Advanced Options window. 

Both  This parameter instructs TapeWare to write all compressed data in its compressed 
format. Any uncompressed files will be stored in the TapeWare compression format. This 
option is useful if the hardware does not support data compression and the files are to be 
restored to the same operating system. 
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Auto Format Mode 
The Auto format mode is either No auto format, Auto format blank media or Auto 
format all. 

Auto format 
mode list box  

This mode determines whether or not TapeWare will format the tape automatically. 
Before data can be written to a media, the media must be formatted. When a media is 
formatted, any data on it is lost. Tapes and other media are formatted when TapeWare 
does not recognize the media, that is, when it has no information in its storage 
management database about that particular media. This will occur when the media is 
blank, it has been erased, it is first used or it has been deleted from the storage 
management database. 

Auto formatting speeds up jobs and allows jobs to be run with no one attending them. On 
the other hand, disabling auto format can help ensure that no data is lost by accidentally 
formatting a tape. 

No auto format  When this parameter is selected, if TapeWare encounters media that 
needs to be formatted (either blank or unrecognized media), it sends an alert to the alert 
window. While waiting for a user reply, TapeWare scans the network for devices with the 
media it was expecting. When this parameter is selected, TapeWare waits for a reply to 
the alert before formatting unrecognized media. 

Auto format blank media  This parameter instructs TapeWare to automatically format all 
new or blank media. However, if TapeWare encounters unrecognized media, it sends an 
alert to the alert window and then scans the network for the media it was expecting. This 
parameter can help prevent data from being accidentally destroyed by formatting, while 
not needlessly querying the user before formatting a blank media. Under almost all 
circumstances, setting the Auto format mode to this parameter is sufficient protection 
against data loss and is preferable to No auto format. 

Auto format all  This parameter instructs TapeWare to automatically format all of the 
media inserted into the tape drive which require formatting. With this parameter selected, 
TapeWare will automatically format all new (or blank) media and all unrecognized 
media. Select this option to create a job that will run unattended with media whose data 
can be erased. 

Note  TapeWare only formats media automatically if it can be overwritten, that is, if you 
selected Append to 1st tape, overwrite others or Overwrite all tapes for the Write 
mode. Otherwise, it appends the new data to the end of the media. 
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New Media Location 
The New media location is the folder in which TapeWare will store any new media 
created while the job is running. By default, TapeWare stores media in the current 
User/Group folder; the media will appear there on the Media and Database tabs. You 
can also store the media in a separate media folder inside the User/Group folder. 

Select the folder in which to store any new media by clicking the Browse… button. Then 
select the folder from the Browse window. If the folder does not exist, use the Media tab 
to create it first. Then you can select the New media location. 

By default, any new 
media is created in the 

current  user/group 
folder… 

…but you can use the 
Browse window to 

select a different 
location. 

 
When TapeWare runs any scheduled automatic rotation job, it automatically creates new 
media folders for the job. The folders are organized by the name of the job and the 
various rotation sets in that job. There is no reason to create these folders manually. 
TapeWare will automatically create these folders for you. 

All media and media 
folders are automatically 
created when you select 

an automatic rotation job. 
 

Note  TapeWare does not automatically create new media folders for manual jobs. 
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New Media Name 
The New media name is the name TapeWare gives to any new media it creates while 
running the job. For scheduled automatic rotation jobs, TapeWare automatically updates 
this parameter to match the media’s place in the rotation schedule. For example, if the 
media is the first media in the yearly rotation set, TapeWare names it “Year Set 1:1”. 
(This means the media was used with a yearly backup job and that it was the first tape in 
the first set.) 

Rotation jobs 
automatically create 

media folders and 
assign media names. 

 
For manual rotation and unscheduled jobs, TapeWare assigns any new media it creates 
the name listed in this field. This is also true for automatic rotation jobs that are “forced” 
to run. For more information, see Backup Options Automatically Updated later in this 
chapter. 

Device 
The Device option specifies which tape drive or other removable media device TapeWare 
will use to run the backup job. 

By default, the Device option is 
set to the Network container 

and will use any devices 
available on the network. 

You can specify a 
particular device to use 
by adding it to the 
Device list. 

 
By default, TapeWare sets this parameter to the network container. When running the 
job, TapeWare will use whatever devices it finds on the network. If there is only one 
device in your storage management zone or if you only have permissions to one device, 
there is no reason to change this parameter. 

However, if there are several devices on your network and you need to select a specific 
device, specify which device the job should use by selecting it from the Device list. (If a 
machine has only one device, you can just select the machine and not the device.) 
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Note that TapeWare automatically tries to use multiple devices whenever there are 
multiple backup streams. Using multiple devices can speed up a backup job 
tremendously. TapeWare can send up to eight backup streams to a single device. If you 
have multiple devices, TapeWare sends the first eight streams to the first device, then the 
next eight streams to the second and so on. 

If you want a job to use a specific device or exclude a particular backup device, use the 
Device list to specify the devices a job should use. 

Note  If you are using an autoloader, the physical machine will have two or more drivers 
associated with it: the device drivers and the autoloader driver. You may specify either in 
the Device list. To use all devices associated with an autoloader, select the autoloader. 
TapeWare automatically backs up to all autoloader devices, depending on number of 
backup streams. To use a single device in the autoloader, select the device itself. 
TapeWare only backs up to the select device. Note that you must manually load and 
unload media when using a single device. 

To use a device that is not shown in the Device list, click the Add… button and select the 
new device from the Browse window. Then select the undesired network container from 
the Device list, click Delete and confirm the deletion. 

Media 
The Media option specifies the folder in which the tape or other removable media are 
stored. TapeWare will look here for media to use with this job. 

The default media 
folder is the current 
user/group folder… 

…but you can specify 
another one by adding 
it to the Media list. 

 
The default folder is the current User/Group folder. If you wish to use media from 
another folder, specify the folder by selecting it from the Media list. 

To use a folder that is not shown in the Media list, click the Add… button and select the 
new folder from the Browse window. Then select the undesired default folder from the 
Media list, click Delete and confirm the deletion. 

Media Password… 
When a job creates new media, you can assign that media a password. A password 
prevents the media from being imported into another TapeWare storage management 
database and can be an important part of your overall security plan. 

For more 
information on 
using multiple 
streams, see 
Maintaining the 
Flow of Data in 
Chapter 10 — 
Tips, 
Techniques 
and Strategies. 
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To have the job assign a password to the new media, click the Media Password… button 
and type and confirm your password. 

Media 
password 

window  
Note that passwords can only be assigned when media is formatted. Additionally, media 
passwords are only required when importing media. 

Backup Options Automatically Updated 
The parameters shown on the Options tab fall into two categories: first, parameters that 
are updated automatically when TapeWare runs a scheduled automatic rotation job 
(built-in or custom), but specified manually in unscheduled and manual rotation jobs; 
and second, parameters that are always specified manually by the user. 

When a scheduled 
rotation job is run, the 
Backup mode, Write 

mode, New media 
location, New media 

name and Media 
parameters are 

updated automatically. 

 
Recall from the previous chapter that TapeWare jobs can be scheduled in four distinct 
ways, either as Not Scheduled, Manual Rotation, Automatic Rotation with Built-in 
Schedule or Automatic Rotation with Custom Schedule. 

When an automatic rotation job is scheduled, the job appears on the Queue tab with an 
indication of the date and time the job is scheduled to run. When TapeWare runs these 
scheduled jobs on the Queue tab, it automatically updates five of the parameters on the 
Options tab: Backup mode, Write mode, New media location, New media name and 
Media. 

For more 
information, 
see Forcing 
Scheduled 
Jobs to Run in 
Chapter 8 — 
Running Jobs. 

For more 
information, 
see Backup 
Job Scheduling 
Concepts in 
Chapter 6 — 
Scheduling 
Jobs. 
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Note that TapeWare does NOT automatically update these five parameters when you 
manually “force” a scheduled job to run. For example, when TapeWare automatically 
runs a scheduled backup job on a Monday, it changes (updates) the Backup Mode from 
Full to Incremental, but does not automatically update these parameters. 

When you run an unscheduled or manual rotation job, TapeWare always uses the 
parameters selected by the user. 

Advanced Options 

The Advanced Options… button on the Options tab allows the user to specify certain 
parameters controlling how files are stored on media. In particular, these options specify 
whether the data on the media is stored in the same form as it was transmitted across the 
network. TapeWare can either store the data in a format specific to a particular network 
platform or in a generic format. Similarly, TapeWare can store all of the data it receives 
or filter out some of the data used by particular network platforms or operating systems. 

Stream Format 
Parent Security 
Child Security 

Extended Attributes 

Generic Stream 
Format 

Advanced 
Options... 

Advanced options control how data 
transmitted across a network is stored on 
media. It can be used to filter out certain 

data and to change the data stream format. 

 
In general, the default values should be used. These options are provided only for 
advanced users who need to customize their backup jobs for unique circumstances. These 
options might be used in one of two circumstances: when transferring data from one 
network platform or operating system to another; or when demands on network traffic 
require that a backup job be run as quickly as possible. Unless you have specific needs 
that require changes to the advanced options, leave the default values unchanged. 

For more 
information on 
the Queue tab, 
see Queue Tab 
in Chapter 8 — 
Running Jobs. 
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Advanced 
Options window 

 
These options are applicable to both backup and restore jobs. Note that both job types 
can filter out certain data, such as security information. However, restore jobs cannot add 
data that was not originally stored on the media. 

Native Data Streams Format  
Different network software transmits data across the network to TapeWare in different 
formats. In particular, Windows, NetWare, Linux and UNIX use different data stream 
formats. If you are going to share data from one network platform to another, the data 
should be stored on media in a common data format, not in the native data streams 
format. 

Check this option when you do not plan to share data between different network 
platforms. When this option is checked, TapeWare generally runs backup jobs more 
quickly. 

Clear this option when you plan to share data between different network platforms, such 
as from a Windows server to a NetWare server. 

Warning  Security is an issue to consider when checking this option. When this option is 
checked, TapeWare backs up all security information that network software includes in 
the data stream. If the option is unchecked, TapeWare uses a generic format that removes 
security information. 

Parent Security  
When checked, TapeWare includes Windows, NetWare, Linux and UNIX parent security 
information, that is, the access control list and trustee information that controls who can 
see and modify the directories. If this option is unchecked, TapeWare filters out the 
parent security information that it receives from the network during a backup job and that 
it would transmit across the network during a restore job. 
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Child Security  
When checked, TapeWare includes Windows, NetWare, Linux and UNIX child security 
information, that is, the access control list and trustee information that controls who can 
see and modify the files. If this option is unchecked, TapeWare filters out the child 
security information that it receives from the network during a backup job and that it 
would transmit across the network during a restore job. 

Volume Restrictions  
NetWare controls the maximum amount of space a user can use on a volume. When this 
option is checked, TapeWare includes this information about the volume in the backup 
media. If this option is unchecked, TapeWare filters out the volume restrictions that it 
receives from the network during a backup job and that it would transmit across the 
network during a restore job. 

Space Restrictions  
NetWare controls the maximum amount of space a directory can use on a volume. When 
this option is checked, TapeWare includes this information about the directories in the 
backup media. If this option is unchecked, TapeWare filters out the space restrictions that 
it receives from the network during a backup job and that it would transmit across the 
network during a restore job. 

Auto Eject  
When this option is checked, TapeWare automatically ejects the tape at the end of the 
backup job. This feature only works on devices that support software eject. 

Auto Retension 
When this option is checked, TapeWare automatically retensions the tape at the 
beginning of the backup job. This feature winds the tape cartridge end-to-end, applying 
equal tension to the entire tape for maximum tape life and data integrity. Your device 
must support auto retension to use this feature. 

Autoprint Log 
When this option is checked, TapeWare automatically prints the log as soon as the 
backup job is finished. This option is only available on Windows NT (or later) systems 
and Linux and UNIX systems running X Window. For information on configuring this 
feature, see Autoprint Log in Chapter 8 — Running Jobs. 
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Extended Attributes  
When this option is checked, TapeWare includes the extended attributes for objects on 
workstations or servers running operating systems that use extended attributes. Since 
many operating systems use extended attributes, this option can affect backups from 
servers and workstations running different operating systems. If this option is unchecked, 
TapeWare filters out the extended attributes during a backup job. As a result, these 
attributes will not be available during a restore job. 

Macintosh Finder  
When this option is checked, TapeWare includes the Finder information for files and 
directories on workstations or files servers that are using the Macintosh file system. If 
this option is unchecked, TapeWare filters out the Finder information that it receives 
from the network during a backup job and that it would transmit across the network 
during a restore job. 

NFS Information  
When this option is checked, TapeWare includes NFS information for files and 
directories on workstations or file servers running a UNIX version of NFS. If this option 
is unchecked, TapeWare filters out the NFS information that it receives from the network 
during a backup job and that it would transmit across the network during a restore job. 

Object Owner  
When this option is checked, TapeWare includes the object owner information for files 
and directories on workstations or file servers running NetWare. If this option is 
unchecked, TapeWare filters out the object owner information that it receives from the 
network during a backup job and that it would transmit across the network during a 
restore job. 

Hardware Compression 
When this option is checked, TapeWare enables hardware compression. This feature only 
works on devices that support software control of hardware compression. 

Note  We recommend that you select System for Compression type on the Options tab. 

Mount Points 
When checked, TapeWare includes the mount point information in the backup. If this 
option is not checked, TapeWare filters out the mount point information from the backup 
job. 
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Restore Job Options 

There are fewer and simpler options for restore jobs. In general, these options are similar 
to options for backup jobs. 

Restore job 
Options tab  

Number of Passes 
This parameter determines how many times TapeWare will try to open a file for restore 
before it skips it and continues with the next file. The default is 3. 

The Number of passes is the 
number of times an attempt will 

be made to access a file that 
may be in use by another user. 

The Delay between 
passes is the number of 
seconds between each 
of these attempts.  

Sometimes when TapeWare is trying to restore a file, the file may already be open, that 
is, in use by another user, a software program or the operating system. Because the file 
could change, TapeWare waits until the file is not in use. Each attempt to open a file is 
called a pass. When TapeWare cannot restore a file on the first pass, it tries to restore the 
file on subsequent passes, up to the Number of passes. When it cannot be opened on the 
last pass, the file fails the restore job. 

If your historical usage shows that many files are open during a restore job, set the value 
to a higher number. This will increase the number of times TapeWare attempts to open a 
file and may result in fewer files failing to be restored. 
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Delay Between Passes 
This determines how many seconds TapeWare waits before trying the next pass. If your 
historical usage suggests that many files are being opened on the last pass, consider 
increasing this parameter to a higher number. 

Restore Files in Use  
The Restore files which are in use option tells TapeWare what to do when files to be 
restored are in use. 

Select this option to restore the backup copy of the open file. (Under Windows, you can 
access the restored file after reboot.) If you select this option, the restored file will replace 
your open file. As a result, your current changes may be lost. 

Deselect this option to skip over all selected files that are in use. This is useful if the open 
files are more current than the backed up files. 

Log Options 
The Log options are either None, Log only failed, Log only completed or Log all. 

Log options 
list box 

 
TapeWare keeps a log of which files are restored while running a restore job. After a job 
is run, you can view or print the log to see if the job was completed successfully. The 
default value is Log only failed, which writes in the log any files which were not 
successfully restored. This information can be vital for checking to see if your job ran 
successfully. 

None  This parameter instructs TapeWare to not keep a log of the job as it runs. 

Log only failed  This parameter instructs TapeWare to log the name of any selected file 
that was not restored. Use this option to check if a job is running correctly. 

Log only completed  This parameter instructs TapeWare to log the name of any file 
selected that was successfully restored. 

Log all  This parameter instructs TapeWare to log the name of every file selected and 
whether or not that file was successfully restored. You can use this option to be certain 
that a job is running correctly as you planned. 
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Device 
The Device option specifies which tape drive or other removable media device TapeWare 
will use to run the job. 

 By default, the Device 
option is set to the 

Network container and 
will use any devices 

available on the network. 

You can specify a particular device 
to use by adding it to the Device list.  

By default, TapeWare sets this parameter to the network container. When running the 
job, TapeWare will use whatever device it finds on the network. If there is only one 
device in your storage management zone or if you only have permissions to one device, 
there is no reason to change this parameter. 

However, if there are several devices on your network and you need to select a specific 
device, specify which device the job should use by selecting it from the Device list. (If a 
machine has only one device, you can just select the machine and not the device.) 

To use a device that is not shown in the Device list, click the Add… button and select the 
new device from the Browse window. Then select the undesired network container from 
the Device list, click Delete and confirm the deletion. 

Advanced Options 
For restore jobs, you may also specify advanced options. Generally, these options work 
just like they do for backup jobs, that is, as filters that exclude certain types of data. 

Advanced 
Options window  
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Note  The Native data streams format only appears on the Advanced Options window 
for backup jobs. The format that you selected for the backup job determines whether you 
can restore the data across platforms. TapeWare does not change the data stream format 
from its stored format. For more information, see Native Data Streams Format earlier in 
this chapter. 

Note  Data filters, such as security information and directory attributes, cannot restore 
data that was not originally backed up to the media. For example, if you did not select 
Volume restrictions for the backup job, TapeWare cannot restore this information 
because it was never stored on the media. 

Parent Security  
When checked, TapeWare restores Windows, NetWare, Linux and UNIX parent security 
information, that is, the access control list and trustee information that controls who can 
see and modify the directories. If this option is unchecked, TapeWare filters out the 
parent security information during the restore. 

Child Security  
When checked, TapeWare restores Windows, NetWare, Linux and UNIX child security 
information, that is, the access control list and trustee information that controls who can 
see and modify the files. If this option is unchecked, TapeWare filters out the child 
security information during the restore. 

Volume Restrictions  
NetWare controls the maximum amount of space a user can use on a volume. When this 
option is checked, TapeWare restores this information about the volume from the backup 
media. If this option is unchecked, TapeWare filters out the volume restrictions during 
the restore. 

Space Restrictions  
NetWare controls the maximum amount of space a directory can use on a volume. When 
this option is checked, TapeWare restores this information about the directories from the 
backup media. If this option is unchecked, TapeWare filters out the space restrictions 
during the restore. 
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Auto Retension 
When this option is checked, TapeWare automatically retensions the tape at the 
beginning of the restore job. This feature winds the tape cartridge end-to-end, applying 
equal tension to the entire tape for maximum tape life and data integrity. Your device 
must support auto retension to use this feature. 

Autoprint Log 
When this option is checked, TapeWare automatically prints the log as soon as the restore 
job is finished. This option is only available on Windows NT (or later) systems and 
Linux and UNIX systems running X Window. For information on configuring this 
feature, see Autoprint Log in Chapter 8 — Running Jobs. 

Extended Attributes  
When this option is checked, TapeWare restores the extended attributes for objects on 
workstations or servers running operating systems that use extended attributes. Since 
many operating systems use extended attributes, this option can affect backups from 
servers and workstations running different operating systems. If this option is unchecked, 
TapeWare filters out the extended attributes during a restore job. As a result, these 
attributes are not available with the restored objects. 

Macintosh Finder  
When this option is checked, TapeWare restores the Finder information for files and 
directories on workstations or files servers that are using the Macintosh file system. If 
this option is unchecked, TapeWare filters out the Finder information during the restore. 

NFS Information  
When this option is checked, TapeWare restores NFS information for files and directories 
on workstations or file servers running a UNIX version of NFS. If this option is 
unchecked, TapeWare filters out the NFS information during the restore. 

Object Owner  
When this option is checked, TapeWare restores the object owner information for files 
and directories on workstations or file servers running NetWare. If this option is 
unchecked, TapeWare filters out the object owner information during the restore. 

Mount Points 
When checked, TapeWare restores the mount point information from the backup. If this 
option is not checked, TapeWare filters out the mount point information. 
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Verify Job Options 

There are fewer and simpler options for verify jobs. In general, these options are similar 
to options for restore jobs. 
 

Verify job 
Options tab 

 

Number of Passes 
This parameter determines how many times TapeWare will try to open a file for verify 
before it skips it and continues with the next file. The default is 3. 

The Number of passes is the 
number of times an attempt will 

be made to access a file that 
may be in use by another user. 

The Delay between 
passes is the number of 
seconds between each 
of these attempts.  

Sometimes when TapeWare is trying to verify a file, the file may already be open, that is, 
in use by another user, a software program or the operating system. Because the file 
could change, TapeWare waits until the file is not in use. Each attempt to open a file is 
called a pass. When TapeWare cannot verify a file on the first pass, it tries to verify the 
file on subsequent passes, up to the Number of passes. When it cannot be opened on the 
last pass, the file fails the verify job. 
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If your historical usage shows that many files are open during a verify job, set the value 
to a higher number. This will increase the number of times TapeWare attempts to open a 
file and may result in fewer files failing to be verified. 

Delay Between Passes 
This determines how many seconds TapeWare waits before trying the next pass. If your 
historical usage suggests that many files are being opened on the last pass, consider 
increasing this parameter to a higher number. 

Log Options 
The Log options are either None, Log only failed, Log only completed or Log all. 

 

Log options 
list box  

TapeWare keeps a log of which files are verified while running a verify job. After a job is 
run, you can view or print the log to see if the job was completed successfully. The 
default value is Log only failed, which writes in the log any files which were not 
successfully verified. This information can be vital for checking to see if your job ran 
successfully. 

None  This parameter instructs TapeWare to not keep a log of the job as it runs. 

Log only failed  This parameter instructs TapeWare to log the name of any selected file 
that was not verified. Use this option to check if a job is running correctly. 

Log only completed  This parameter instructs TapeWare to log the name of any file 
selected that was successfully verified. 

Log all  This parameter instructs TapeWare to log the name of every file selected and 
whether or not that file was successfully verified. You can use this option to be certain 
that a job is running correctly as you planned. 

Verify Mode 
The Verify mode is either No verify, Full verify or Quick verify. 

When TapeWare runs a verify job, it checks to see if the data on the media is readable 
and whether or not it matches data from the original source (that is, from the workstation 
or file server). 

 
Verify mode 

list box 
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No verify  This parameter instructs TapeWare to skip the verification step. If you select 
this step, the verify job will not run. 

Full verify  This parameter instructs TapeWare to compare every selected file stored on 
the media with the original file from the workstation or file server. This default option is 
strongly recommended. 

Quick verify  This parameter instructs TapeWare to be certain that every file backed up 
onto the media is in readable condition. It does not verify that the data is correct, only 
that the data stored on the media (incorrect or not) can be read. While selecting this 
option can save time, it is nonetheless not recommended. 

Device 
The Device option specifies which tape drive or other removable media device TapeWare 
will use to run the job. 

 By default, the Device 
option is set to the 

Network container and 
will use any devices 

available on the network. 

You can specify a particular device 
to use by adding it to the Device list.  

By default, TapeWare sets this parameter to the network container. When running the 
job, TapeWare will use whatever device it finds on the network. If there is only one 
device in your storage management zone or if you only have permissions to one device, 
there is no reason to change this parameter. 

However, if there are several devices on your network and you need to select a specific 
device, specify which device the job should use by selecting it from the Device list. (If a 
machine has only one device, you can just select the machine and not the device.) 

To use a device that is not shown in the Device list, click the Add… button and select the 
new device from the Browse window. Then select the undesired network container from 
the Device list, click Delete and confirm the deletion. 
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Advanced Options 
For verify jobs, you may also specify advanced options. Generally, these options work 
just like they do for backup and restore jobs. 

Advanced 
Options window 

 

Auto Retension 
When this option is checked, TapeWare automatically retensions the tape at the 
beginning of the verify job. This feature winds the tape cartridge end-to-end, applying 
equal tension to the entire tape for maximum tape life and data integrity. Your device 
must support auto retension to use this feature. 

Autoprint Log 
When this option is checked, TapeWare automatically prints the log as soon as the verify 
job is finished. This option is only available on Windows NT (or later) systems and 
Linux and UNIX systems running X Window. For information on configuring this 
feature, see Autoprint Log in Chapter 8 — Running Jobs. 
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Chapter 8 — Running Jobs 

TapeWare will automatically run jobs that are scheduled. You can view jobs scheduled to 
be run on the Queue tab and you can track the progress of a job as it runs from the job’s 
Status window. 

In This Chapter 

• Overview 

• Queue Tab 

• Running Scheduled Jobs 

• Running Unscheduled Jobs 

• Job Status Window 

• Job Logs 

• Audit Logs 

Overview 

For jobs that are not scheduled, TapeWare will only run the job when you instruct it to do 
so. Scheduled jobs run automatically as scheduled. You can view what jobs are scheduled 
to run on the Queue tab, which indicates when a job is scheduled to run and provides a 
short summary of a job’s progress as it runs. When TapeWare automatically runs a 
scheduled job from the Queue tab, it updates the option parameters for that job before 
running it. 

You can also “force” scheduled jobs to run before they are scheduled. When a scheduled 
job is forced to run, TapeWare does not automatically update parameters on the job’s 
Option tab. Forcing a job to run can also affect the permissions TapeWare uses when it 
runs the job. Be certain to read Forcing Scheduled Jobs to Run later in this chapter for 
more information on how forcing a scheduled job to run affects the parameters TapeWare 
uses to run the job. 
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The Status window provides detailed information about the progress and status of jobs as 
they run. You can use this window to see that a job is running properly. After a job has 
completed running, you can view and print the Job Log to check what files were 
successfully or unsuccessfully backed up, verified or restored. 

Queue Tab 

After a job has been scheduled to run, TapeWare displays the job and information about 
it on the Queue tab. This tab shows all of the jobs that are scheduled to run. As new jobs 
are created and scheduled, they are listed on the Queue tab. Each scheduled job is listed 
only once using information for the next scheduled time that job is to run. 

Unscheduled jobs that TapeWare has been instructed to run also appear on the Queue 
tab, but only after you have manually instructed them to run. 

Details view 
of the Queue tab 

 

Queue Tab Details View 
The Details view on the Queue tab provides the most useful and important information 
about scheduled and currently running jobs. 

The Name and Type fields show the name of the job and whether it is a backup, restore 
or verify job. The Run Time field indicates the date and time the job is next scheduled to 
run. The Schedule Type field indicates what type of schedule that job has, such as GFS-
30 or Custom. 

The Status, Complete and Failed fields provide a short summary of a job’s current 
status. The Status field indicates if the job is currently running and if so, what procedure 
is currently being performed. The Complete and Failed fields indicate what percentages 
of the files selected have been successfully or unsuccessfully backed up, restored or 
verified. 

The Owner field indicates what user permissions information TapeWare will use to 
calculate the permissions for the job when it is run. 

 
Details button 
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Running Scheduled Jobs 

Scheduled jobs are normally run automatically by TapeWare, but you can also “force” a 
scheduled job to run. 

Automatically Running Scheduled Jobs 
When you close the property sheet of a job, TapeWare calculates the next time the job is 
scheduled to run and places the job on the Queue tab. The Run Time field in the Details 
view on the Queue tab shows the date and time the job is scheduled to run. This is true 
for jobs scheduled with automatic or manual rotation schedules. 

The Run Time of 
a job is shown on 
the Queue tab.  

These jobs will run automatically if TapeWare is open at the scheduled date and time. It 
is not necessary for a user to be logged on to TapeWare for the job to run. TapeWare will 
run scheduled jobs even if the user who created the job has logged out. 

For example, suppose you have scheduled a job to run at 11:00 p.m. tonight. When you 
leave your workstation, log out of TapeWare. Do not exit or close TapeWare. When the 
TapeWare Logon window appears, click the minimize button to close the window. 
Although no user will be logged on, TapeWare will still be open and will execute the job 
at the scheduled time. 

Tip  You can install TapeWare as a service on machines running Windows, Linux and 
UNIX. When installed as a service, TapeWare will start automatically whenever the 
system starts up and run in the background without any user interface. If you want to 
make sure that scheduled jobs always run, install TapeWare as a service. For more 
information, see Appendix E — TapeWare Service in the TapeWare Installation Guide. 
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 If you want scheduled jobs to 
run, don’t close TapeWare. 
Instead, select Log Out from 
the File menu… 

…then minimize the 
Logon window to 
ensure no 
unauthorized access 
to the network. 
Another alternative is 
to install TapeWare 
as a service. 

 

Note  If the storage management server is turned off when a job is scheduled, the job will 
run when that machine is started again. Jobs scheduled to run will begin running five 
minutes after you start TapeWare. (If TapeWare is run as a service, this will be five 
minutes after startup.) This five-minute lag allows you to modify, update or cancel any 
pending jobs before they run. 

Security and Scheduled Jobs 
Scheduled jobs will run whether you log out or not, as long as TapeWare is open or the 
TapeWare service is running. If you have not logged out, however, unauthorized users 
will be able work with your security clearance. For this reason, be certain to log out or 
exit TapeWare before leaving your workstation. This is the only way to ensure that no 
unauthorized users gain access to sensitive data. 

Warning  Do not leave the main TapeWare window open when you are not at your 
workstation. Doing so allows users without security clearance unauthorized access to the 
network. Be certain to log out of TapeWare before leaving your workstation. If you have 
jobs scheduled to run, either log out instead of exiting TapeWare or make sure the 
TapeWare service is running. 

Forcing Scheduled Jobs to Run 
You can “force” scheduled jobs to run prior to their scheduled time by selecting the job 
and clicking the Run button on the toolbar. Alternatively, you can select Run from the 
Job menu, the Queue menu or the shortcut (right-click) menu. TapeWare will execute 
the job immediately. 

 
Run button 
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Note that forcing a job that is scheduled for the same day marks the job as complete for 
that day. TapeWare resets the job on the next day so it will run as scheduled. As a result, 
if you force a job to run on the same day that it is scheduled to run, it only runs once on 
that day. 

You can force a 
scheduled job to run by 
selecting it and clicking 

the Run button… 

…or clicking the job with 
the right mouse button 

and selecting Run. 
 

How Forcing Jobs to Run Affects Job Parameters 
When you force a scheduled job to run before its scheduled time, TapeWare does not 
automatically update certain parameters on the Options tab of the job. Recall that when a 
scheduled job with an automatic rotation is run, TapeWare updates the Backup mode, 
Write mode, New media location, New media name and Media parameters on the 
Options tab of the job to reflect that job’s place in the rotation schedule. However, when 
a job is forced to run before its scheduled time, TapeWare does not update these option 
parameters. 

For example, suppose that a backup job is scheduled to run as an incremental job in the 
evening. If it is forced to run before its scheduled time, TapeWare will not update the 
Backup Mode parameter. In this case, if the last time the job was run, it was as a full 
backup job, the Backup Mode parameter on the job’s Option tab will still be set to Full. 
As a result, when you force the job to run, it will be run as a full backup job, even though 
it is next scheduled to run as an incremental job. 
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You must manually 
set the Backup 

mode and other 
options before 

forcing a scheduled 
job to run. 

When you force a 
scheduled job to run, 

the Backup mode, 
Write mode, New 

media location and 
New media name 

are not updated. 

 
Forcing a job to run can be useful when a job failed to run for some reason. For example, 
suppose a full backup job is scheduled for a Saturday, but a network equipment 
malfunction prevented the job from being run as scheduled. It is important that another 
full backup job be run before the next incremental job. This is the only way to ensure that 
the full data recovery period is not compromised. On Monday, you can force the failed 
backup job to run again after the network connections are restored. Before you run the 
job, open the job’s property sheet and make sure the proper job type and media are 
selected. 

Before forcing a scheduled job to run, you should always check the Options tab of the 
job to see that the option parameters are set correctly. If you are forcing the job to run 
because an earlier job failed to run properly, you can look at the log of the failed job to 
see what parameters the job would have used. 
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Logs tab 
 

How Forcing Jobs to Run Affects Permissions 
When a job is run, TapeWare will check for the appropriate permissions to the device, 
files, media and so forth. TapeWare calculates these permissions by using the 
permissions of the job’s Owner. The owner of a job is the user who either scheduled the 
job or forced the job to be run. After a job is run, the job owner is reset to the last user 
who changed the job properties; forcing a job to run does not permanently change the job 
owner. 

When a scheduled job is run, the job’s Owner is used to calculate 
what permissions are necessary for the job to run. If you force a job 

to run, the job’s Owner becomes whoever forced the job to run.  
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When the TapeWare administrator creates and schedules a job, the owner of the job is the 
administrator. TapeWare will use the TapeWare administrator’s permissions when 
running the job. Similarly, if another user creates and schedules a job, that user will be 
the job’s owner and TapeWare will calculate the job’s permissions using that user’s 
permissions. 

However, if a scheduled job is forced to run, the person who forces the job to run 
becomes the job’s new owner. So, for example, if the TapeWare administrator forces a 
job to run that another user has created, the TapeWare administrator becomes the job’s 
new temporary owner and TapeWare calculates the permissions using the TapeWare 
administrator’s permissions. 

Changing the job’s owner can be useful for managing security. A user can create and 
schedule a job, even though that user lacks the proper permissions to run that job. 
Another user, such as the TapeWare administrator, can then force that job to run with 
their own permissions. 

Viewing and Printing Scheduled Job Instructions 
Whenever a job is scheduled and placed on the Queue tab, TapeWare creates a set of 
instructions for that job. Included in a job’s instructions is information about which 
media set must be available to be used and which backup devices it may be inserted into. 
For example, when running an automatic rotation job, the instructions for that job include 
the name of the media TapeWare is expecting to use when that job runs next, such as 
“Daily Set 1” or “Yearly Set 2”. The instructions also include the name of the backup 
devices which TapeWare expects to be available when the job runs. 

Tip  You can use the instructions in order to ensure that all of your jobs run correctly by 
planning ahead to see that each job has the media it requires before it runs. For example, 
you can print the instructions and then assign a co-worker the task of inserting the proper 
media into various backup devices by the required time. 

You can view the Instructions for the jobs currently scheduled on the Queue tab by 
clicking the View Instructions button on the toolbar of the Queue tab or by selecting 
Instructions from the Tools menu. TapeWare will open the Instructions in a window of 
an external text editor, such as Windows Notepad. You can also print the Instructions by 
clicking on the Print Instructions button or from the Tools menu. (To change the 
external text editor with which you wish to view and print the Instructions, select 
Preferences from the File menu.) 

 
View 
Instructions 
button 
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You can print or view the 
instructions for all of the 

jobs scheduled on the 
Queue tab. Use the 

instructions to insure that 
the proper media and 

backup devices are 
available before a job is 

scheduled to run. 
 

Running Unscheduled Jobs 

If you did not schedule the job, then you must manually instruct TapeWare to run the job 
when you want it to run. To run the job, select the job and then click the Run button on 
the toolbar, select Run from the Job, Queue or shortcut (right-click) menu, or double-
click on the job. TapeWare asks you to confirm and then executes the job immediately. 

Unscheduled Job Parameters and Permissions 
When an unscheduled (or manual rotation) job is run, TapeWare uses the current 
parameters on the job’s Options tab. 

Similarly, the owner of the job is the person that instructed TapeWare to run the job. 
TapeWare calculates the permissions of the job using this user’s permissions, that is, the 
permissions of the job’s owner. Note that the creator of a job and its owner are not 
necessarily the same user. 
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Job Status Window 

Each time TapeWare runs a job, it goes through a predetermined series of steps. Many of 
these steps are indicated in the Status window of the job. If you have run the job 
manually, TapeWare will automatically show the Status window. If the Status window 
of a job that is running is not displayed, you can open it by selecting the job and clicking 
on the Status button or by selecting Status from the Job, Queue or shortcut (right-click) 
menu. 

Summary 
view of the job 

Status window 
 

You can change what information is displayed in the Status window by selecting an 
option from the Display list box. This allows the user to inspect how various components 
of the backup job are running and locate potential problems. Many of the fields in the 
display box are self-explanatory; if you require additional help, use the context-sensitive 
help. To see a short description of the different fields, right-click the field to view the 
What’s this? window. Or, alternatively, press F1 to display context-sensitive help for the 
targeted area. 

The Display list 
box shows the 

different Job 
Status window 

views available. 
 

 
Status button 
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Job Status Messages 
As jobs are run, TapeWare displays messages in the Status message box indicating the 
progress of the job. These messages are also displayed in the job’s Status field on the 
Queue tab. Which messages are displayed depends on the type of job being run. The 
following short descriptions indicate what procedures TapeWare is performing as each 
message is displayed. 

Building…Selection List  The first step is to create a list of files to be backed up, verified 
or restored. For backup jobs, TapeWare uses the selection criteria and the backup job 
type (whether full, incremental or differential) to create a list of files to be backed up. The 
number of files and the total size of the selected files are indicated in the Objects and 
Size fields under Selected. 

Objects and 
Size fields  

Mounting Media  TapeWare displays this message as it mounts the media. During this 
step, TapeWare reads identification information stored on the tape. TapeWare then 
checks to see if the media already exists in the storage management database and whether 
or not the current job can be run using this media. 

If TapeWare can use the mounted media with the current job, it proceeds to the next step. 

If the mounted media cannot be used for this current job, the next step is determined by 
the settings specified on the Options tab for the job. For example, TapeWare only 
formats a blank tape if that option is selected. 

Scanning for Device  This message is displayed when TapeWare is looking for a device to 
use with the current job. This message might be displayed when the current media cannot 
be used with this job or when TapeWare cannot find a device on the network. 

Note  Many times this message will be accompanied by an alert. You can view any 
current alerts by clicking the Alert button on the Status bar. 

Formatting Media  If the media is already formatted, TapeWare proceeds to the next step. 
Otherwise, TapeWare formats the media according to the Auto format mode setting on 
the Options tab for the job. 

Opening Device  Once the media is mounted and formatted, TapeWare readies the media 
and device for the job. 
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Running  After opening the device, TapeWare runs the job. As the job is run, the Status 
window automatically displays current information about the job, including which files 
are being backed up, restored or verified, which streams are active and the rate (or 
throughput) at which files are being written to media or volumes. You can use the 
Display list box to check the progress of individual streams or the throughput of a 
specific device. 

Waiting for Next Pass  If some files were not backed up, restored or verified during the 
first pass, such as when they are being used by other users, TapeWare attempts to access 
these files on subsequent passes. This message is displayed while TapeWare waits for the 
number of seconds specified in the Delay between passes field on the Options tab of the 
job. 

Closing Device  When TapeWare closes a device, it displays this message. 

Building Logs and Audit Trails  After closing the device, TapeWare updates the storage 
management database with new information from the job, such as which files were 
backed up, and creates a log of the job. The specific log contents depend on the Log 
options setting on the Options tab for the job. For more information, see Audit Logs later 
in this chapter. 

Merging Groups  After a backup job has run, TapeWare updates the storage management 
database to reflect any changes to media or files created by the current job. Prior to 
running a restore or verify job, TapeWare sorts all the selected files into the order in 
which they appear on the media and displays this message. 

Completed  This message is displayed after the job is finished. 

Terminated  When a job is forced to quit, TapeWare displays this message. 

Job Logs 

Each time a job is run, TapeWare creates a new log for that job. You can use this 
information to check if a job is running as you intended and to keep a permanent record 
of that job. After a job finishes, you can view or print the log, print the log automatically 
or have TapeWare email it to one or more addresses. 

You can specify what information TapeWare should write to the log on the Options tab 
of the job in the Log options field. The log always includes summary information about 
the job, which includes useful information about which option parameters the job used 
when it ran. Depending on what Log options parameter you selected, TapeWare will also 
include information about which files were successfully or unsuccessfully restored, 
verified or backed up. 
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Viewing Job Logs 
You can view the logs for a job on the job’s Logs tab. Note that there is a separate log for 
each time a job is run. 

The Logs tab 
shows a different 

log for each time a 
job is run. 

 

Note  You can also view all the available job logs from the Instructions and Logs option 
on the Wizards tab. 

To view the log of a particular job, open the Logs tab of the job. Select the appropriate 
log in the Log Date/Time box. When you click the View button, TapeWare opens the log 
in a text editor. Specify the text editor to use in the Preferences window (see Preferences 
Window in Chapter 12 — Objects and Properties Reference). 

To print a particular log, select it and then click the Print button. Note that some logs can 
be very long; check the length of the document before printing it. 

If you run a job repeatedly, you may want to delete old logs. Simply select the job log 
and then click Delete. You can also select multiple logs to delete. Use the CTRL and SHIFT 
keys or drag the mouse over the logs. 

Note  The maximum number of logs per job is 64. TapeWare will overwrite the oldest log 
when you reach this maximum. 

Autoprinting Job Logs 
TapeWare provides a convenient method for you to print the job log automatically. This 
way you don’t have to manually print a copy of each job log. 

For more 
information on 
selecting a text 
editor, see 
Preferences 
Window in 
Chapter 12 — 
Object and 
Property 
Reference. 
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Note  To print from a Windows NT (or later) system to a network printer, you must 
configure the TapeWare service to log on to the printer (see Appendix G — Configuring 
Autoprint for Windows in the TapeWare Installation Guide). 

The Autoprint tab appears on the property sheet of each user object. You can select a 
specific printer, font, print range and number of copies. TapeWare prints the job log 
automatically as soon as the job finishes, according to the autoprint settings of the job 
owner. 

Use the Autoprint 
tab to configure the 
settings to print the 

job log 
automatically. 

 
To configure this feature, access the group or user from the Security tab. Then click the 
Autoprint tab. Update your settings and click OK. 

Note  You must also select the Autoprint log option on the Advanced Options window 
to automatically print the job log. For more information, see Autoprint Log in Chapter 7 
— Job Options. 

Emailing Job Logs 
TapeWare can send you an email automatically when a job has completed. This way you 
can know for certain that a job has run successfully or the reason why a job has failed to 
run correctly. If you can retrieve your email remotely, you can monitor your jobs, even if 
you are away from the office. 

Note  If a job fail before it can generate a log, TapeWare cannot email you the job log. 

To use this feature, you must install and configure the email support option (see Appendix 
C — Configuring Email Options in the TapeWare Installation Guide). 
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When the email support option is installed, the Email tab appears on the property sheet 
of each user object. To use this option, access the group or user from the Security tab. 
Then click the Email tab. 

The job log is 
emailed to the 

addresses listed 
on the job owner’s 

Email tab. 
 

You must enter valid email addresses for each job log recipient. Then click OK. Upon 
job completion, TapeWare emails the job log to the addresses listed on the Email tab for 
the job owner. 

The job owner is generally the person who scheduled the job. If a different user forces a 
scheduled job to run, that user becomes the job’s temporary new owner. After the forced 
job has run, TapeWare resets the job owner to the last person who changed the job’s 
properties. You can confirm who owns a job by checking the Owner field on the Queue 
tab. 

The job log is sent to whatever addresses are listed on the Email tab. To specify multiple 
addresses on the Email tab, separate each address with a semicolon (no spaces). 
Additionally, you can enter the same address on each user’s Email tab, which would 
send a copy of every job log to the same user. For example, you might send the 
TapeWare administrator the log of every job that runs. Alternatively, consider setting up 
a separate email account for the sole purpose of receiving job logs. 

For more 
information on 
the job owner, 
see How 
Forcing Jobs to 
Run Affects 
Permissions 
earlier in this 
chapter. 
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Audit Logs 

Some files, such as databases, are mission critical and regular backups of these files are 
essential. It is also essential that system administrators be able to verify that these files 
have been regularly backed up. TapeWare’s audit trails allows you to collect, store and 
print such information about selected files and databases. 

You can use TapeWare’s auditing feature to track how often and when a file, folder, 
volume or database is backed up, verified and restored. TapeWare will create an audit 
trail for each object which is audit enabled. Each time an action is performed on this 
object, the audit trail or log is updated with data about when that object was backed up, 
restored and so forth. The audit log also includes information about the media on which 
instances of a file are stored. 

To create an audit log for an object, you must enable the audit storage property. To do 
this, open the property sheet for the object and the click on the Storage tab. Change the 
Audit object actions setting to Audit enable. (You can only create an audit trail for 
objects that have a Storage tab, including only files, directories and volumes.) 

To create an audit log 
for a file, directory, or 
volume, set the Audit 

object actions setting 
on the object’s Storage 

tab to Audit enable. 

 
When an object has been audit enabled, a new tab appears on its property sheet, the 
Audit tab. Click on this tab to view the audit trail of that object. You can also print the 
audit log or save it to a file. 
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When an object’s 
audit property has 
been enabled, the 
Audit tab appears 

on its property 
sheet. 

The audit log of an 
object tracks when 

that object has 
been backed up 

and the media on 
which instances of 

it are stored. 

 
Clear  Click to erase all audit log entries. 

Print  Click to print the audit log. Note that some logs can be quite long; check the length 
of the document before printing it. 

Save  Click to save the audit log as a text file. 
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Chapter 9 —Media, Device and Database Tabs 

Using the Media tab, you can create media folders and media in the TapeWare database 
and delete them from the storage management database as well. The Device tab allows 
you to perform physical operations with the backup device, such as erasing, formatting 
and ejecting media. The Database tab displays all of the objects in the TapeWare storage 
management database on a single tab. Many commands can also be executed from this 
tab. 

In This Chapter 

• Overview 

• Media Tab 

• Device Tab 

• Database Tab 

Overview 

The Media tab displays media folders and media objects. You can use this tab to work 
with these storage management database objects. For example, you can create and delete 
media folders, as well as create and delete media objects, such as tapes. The Device tab, 
on the other hand, is used to perform physical operations with the backup device. For 
example, media can be erased and formatted from the Device tab. 

The difference between the Media tab and the Device tab is significant: the Media tab is 
used to make changes to the storage management database while the Device tab is used 
to perform operations using the physical devices themselves (both media and drives). 
When you want to make changes to the storage management database, use the Media tab. 
When you want to work with the physical media or with the device itself, use the Device 
tab. For example, if you want to change the name of a tape, you make that change on the 
Media tab because you are making a change to the TapeWare database. However, if you 
want to identify a tape by reading its header, you must use the Device tab. 
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The Database tab displays all of the objects in the current storage management database. 
This may be useful, on the one hand, because you will be able to see and work with all 
the database objects at once. On the other hand, because all of the objects are displayed, it 
may be difficult to work with this tab efficiently. 

Media Tab 

The Media tab displays media folders and media objects in the TapeWare storage 
management database. You can use this tab to work with these database objects. For 
example, you can create new media folders and media objects on this tab, as well as 
delete media folders and media. 

 

The Media tab 
displays media 
folders and 
media objects.  

Although you can manipulate media and media folders on the Media tab, many of these 
operations are normally handled automatically by TapeWare. For example, when you run 
a scheduled (rotation) job, TapeWare will automatically create any new media and media 
folders needed for that job. As tapes and other media are overwritten and deleted from the 
storage management database, these changes are automatically reflected on the Media 
tab as well. 

Creating Media Folders 
You might wish to create a media folder in which to store media before you create and 
run a backup job. Note that TapeWare automatically creates new media folders when it 
runs either a built-in or custom scheduled job. TapeWare will create a media folder in the 
User/Group folder and give it the name of the scheduled backup job. However, if you run 
a manual job that is not scheduled, you may want to create a new media folder in which 
to store the new media for that job. 

 
Media and media folders are
automatically created when 
an automatic rotation job is 
run. 

 

For more 
information on 
automatically 
creating media 
folders, see 
Backup 
Options 
Automatically 
Updated in 
Chapter 7 — 
Job Options. 
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To Create a New Media Folder 
1. Select the existing folder in which you want to store the new Media folder. (It cannot 

be the Home folder.) 

2. Create the new media folder by either 

• Selecting New Object… from the File menu and then selecting Media Folder 
from the New Object window, or 

• Right-clicking in the TapeWare object detail area and selecting New Media 
Folder from the shortcut menu, or 

• Clicking the New Object button on the toolbar and then selecting Media Folder 
from the New Object window. 

3. Type in the name of the new folder in the tree view area. 

Tip  After creating a new folder, be certain to specify which users have permissions to it. 
This is the simplest and fastest way to assign permissions to multiple objects stored in the 
folder. 

Deleting Media Folders 
When you delete a media folder, you also delete all of the objects contained within it, 
including any media folders and media. You might want to delete media folders that were 
used by jobs you no longer plan to run and that contain media that are no longer in use. 

To delete media folders, select the folder and then select Delete from either the Edit 
menu or the shortcut (right-click) menu. Alternatively, you can click on the Delete button 
on the toolbar. 

Before deleting any media folders, you might want to move any media stored in those 
folders to another folder. For example, you might create a new folder named Old Media 
and move any currently unused media to this folder before deleting the media folders. 

Creating New Media 
TapeWare automatically creates new media when it runs backup jobs that use blank 
media or any overwrite setting. However, there may be occasions where you may want to 
manually create new media prior to running the job. For example, you might be recycling 
old tapes you no longer use. To be certain that the tapes are labeled correctly and that no 
tapes are inadvertently overwritten, you might want to manually create new media before 
running the job. 

 
Delete button 

 
New Object  
button 
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Note, however, that for built-in schedule jobs, TapeWare looks for media with specific 
names in specific folders. If it does not find the precise media it is looking for, TapeWare 
will display an alert. For this reason, it is best to let TapeWare automatically create its 
own media for automatic rotation jobs than to manually create the media in advance. 

When you create new media, TapeWare (1) creates a new database object and (2) 
physically formats the current media in the device. This will cause any current data on 
that media to be erased. When you create new media, be certain that the media TapeWare 
will format is no longer needed. 

When you format the new media, TapeWare opens the Format Media window. Use this 
window to name the media and select a media folder in which to store the media. You 
must also select a device. TapeWare will format the media currently loaded in the device 
you select. If you select an autoloader, select the storage slot that holds the media you 
want to use. 

When you format 
new media, type 
the name of the 

new media in the 
Media name field. 

Use the 
Browse button
to select the 
device you 
want to use to 
format the new
media. 

If you are using an 
autoloader, select 

the storage slot 
that stores the 

media to be 
formatted.  

When you format media, you can also assign the media password. See Media Passwords 
later in this chapter for more information. 

To Create a New Media 
1. Select the existing folder in which you want to store the new Media. 

2. Create the new media by either 

• Selecting New Object… from the File menu and then selecting Media from the 
New Object window, or 

• Right-clicking in the TapeWare object detail area and selecting New Media from 
the shortcut menu, or 
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• Clicking the New Object button on the toolbar and selecting Media from the 
New Object window. 

3. Type in the name of the new media in the Media name field of the Format Media 
window. 

4. If the device you want to use is not displayed in the Device field, click the Browse… 
button and select the proper device from the Browse window. 

5. If you are using an autoloader, select the loader and the storage slot that holds the 
media you want to use. 

6. If you want to assign a password to the media, click the Media Password button and 
then enter and confirm the password in the Media Password window. 

7. Click the Format button. TapeWare formats the specified media. 

Media Passwords 
Whenever you format media, you can assign that media a password. By default, there is 
no password. 

Media passwords are only required on one occasion: when media is imported from one 
storage management database to another database. For example, you might import media 
from an earlier version of TapeWare to the latest version of TapeWare. Or, alternatively, 
you might want to transfer data from one storage management zone to another storage 
management zone. To prevent unauthorized transferring of tapes between secure storage 
management zones, TapeWare lets you assign a password to any media you create. That 
password will be required before that media can be imported into a new storage 
management database. 

Note  Media passwords are the only security measure that prevents tapes from being 
imported into another storage management database. For sensitive data, be certain that 
every media is assigned a password. 

Whether or not you assign media a password depends on your particular security needs. 
Media that has no password can be easily imported into any storage management 
database. If you do not assign the media a password, mere possession of the tape or 
media is enough to compromise the security of your data. 

Note  Early versions of TapeWare automatically assigned PASSWORD as the default 
media password. If you are having trouble importing media created with an early version 
of TapeWare, try using PASSWORD when prompted for the media password. 

 
New Object 
button 
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Deleting Media 
When you delete media, TapeWare deletes information about that media from its storage 
management database. This includes any instances of files stored on that tape, which are 
also deleted from the storage management database. 

Note however that deleting media does not physically erase the media. The media 
remains unchanged; only the database is changed. This means that you can still import 
that tape to another storage management database or, if you wish, back into the original 
storage management database. 

To delete media, select the media you wish to delete and then select Delete… from the 
Edit menu or the shortcut (right-click) menu. Alternatively, you can click the Delete 
button on the toolbar. 

 

When you delete media, 
you only remove it from the 
database. Deleting media 
does not erase the media.  

Media Content 
At any time, you can display the contents of any media in the storage management 
database. Perform one of the following: 

• Double-click the media on the Media tab. The Wizard – Media Content screen 
appears. 

• Click Media Content on the Wizard tab and follow the on-screen directions. 

Device Tab 

You can use the Device tab to perform physical operations on any backup device in the 
current storage management zone. 

 
Delete button 
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Controllers are 
usually the adapters to 

which devices are 
attached. They act like 

containers in the 
storage management 

database. 
Devices are shown as objects 
contained inside Controllers.  

Any backup device in the current storage management zone can be displayed in the 
object detail area. Note that this tab displays two separate types of objects: Controllers 
and Devices. Controllers are usually the physical adapters in your machine that connect 
TapeWare to your physical devices; devices are the actual physical devices. In the 
TapeWare storage management database, controllers work like containers in which 
multiple devices are stored. 

When you work with devices on the Device tab, you can select the device in either the 
object detail area or the tree view area. 

Note that autoloaders have two or more drivers associated with them: the Loader driver 
and one or more Device drivers. In general, many commands on the Device tab can be 
performed with any one of the drivers selected. (Models and manufacturers vary.) 
However, if your autoloader supports multiple devices (for example, it has more than one 
tape read/write device) and you want to use a specific device, you must select that Device 
driver to use it. If you select the Loader driver, TapeWare will use the first available 
device in the autoloader it finds. 

Restarting Failed Devices 
Sometimes you will need to restart a device that has, for some reason, failed to initialize 
properly. A device may have stopped for any number of reasons, such as a power failure 
or a connecting cable malfunction. 

When a device is not initialized, it appears with a yellow warning icon. Some devices 
may take some time to initialize, during which the warning icon will continue to appear. 
If a device shows the warning icon after it is initialized, press F5 to refresh the device 
display. 

 
Devices show a yellow warning 
icon when they are not initialized. 

 
If there is some other problem with the device or the controller, the warning icon will not 
disappear. You must identify and correct the problem yourself. Then you must close both 
TapeWare and the TapeWare service. 
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When you restart TapeWare, it will initialize the device driver again. Check the Device 
tab to see that the devices are now properly working and that they no longer display the 
warning icon. 

Device Tab Commands 
After you have selected a device in the object detail area, you can perform physical 
operations with this device. Some of these operations affect the device itself, while others 
affect the current media in the device. 

The following commands can be found on the Device menu. Many of them also have 
buttons on the toolbar or are available from the shortcut (right-click) menu. 

Note  Check your hardware documentation to determine which of the following 
commands are supported by your device. If the command is not available, it will not 
appear on the shortcut (right-click) menu. 

Eject Media 
You can use this command to eject media from the selected device. If this command is 
missing, either your device does not support this command or no device is selected. 

Eject Magazine 
You can use this command to eject media magazines from the selected autoloader. If this 
command is missing, your device does not support this command. 

Rewind 
You can use this command to manually rewind tapes in the selected device. If this 
command is missing, your device does not support this command. 

Retension 
The Retension command winds the tape cartridge end-to-end, applying equal tension to 
the entire tape for maximum tape life and data integrity. When the tape is fast forwarded 
and rewound in short amounts, different tension develops and the drive may not report 
the correct location on the tape. 

TapeWare also lets you automatically retension a tape at the beginning of a backup, 
restore or verify job. If your tape drive supports this option, refer to Advanced Options in 
Chapter 7 — Job Options. 

Sometimes retensioning can make an otherwise unusable tape operational again. 

 
Retension 
button 

 
Rewind button 
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Note  If you need to retension tapes regularly to use them, you may need to service your 
tape drive or replace your tapes. 

Quick Erase and Secure Erase 
These commands erase the media currently loaded in the selected device. 

The Quick Erase command erases the first block and then writes an END OF DATA 
marker to that first block. The other blocks of the tape are not erased, but when that tape 
is read, TapeWare treats it as if it were blank because it encounters the END OF DATA 
marker in the first block. 

The Secure Erase command erases every block of the tape. This operation can be very 
time consuming, lasting several hours. However, it will physically erase every block of 
the tape. If you are attempting to destroy sensitive data, you may want to use the Secure 
Erase command. 

Not all devices support both commands. Some support only one of the two erase 
commands. If a command is missing, the selected device does not support that command. 

Format Media 
You can use this command to format media currently loaded in the selected device. 

When you format new media, TapeWare opens the Format Media window. Use this 
window to name the media and select a media folder in which to store the media. 
TapeWare will format the media currently loaded in the device you select. If you select 
an autoloader, select the storage slot that holds the media you want to use. 

When you format 
new media, type 
the name of the 

new media in the 
Media name field. 

Use the Browse 
button to select 
the device you 
want to use to 
format the new 
media. 

If you are using an 
autoloader, select 

the storage slot 
that stores the 

media to be 
formatted. 

 

 
Secure Erase 
button 

 
Quick Erase 
button 
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When you format media, you can also assign the media a password. See Media 
Passwords earlier in this chapter for more information. 

To Format Media 
1. Select the device with the media to format. 

2. Format the new media by either 

• Right-clicking the device and selecting Format from the shortcut menu, or 

• Selecting Format Media from the Device menu, or 

• Clicking the Format Media button on the toolbar. 

3. Type in the name of the new media in the Media name field. 

4. If the media folder in which you want to store the media is not displayed in the 
Media folder field, click the Browse… button and select the proper media folder 
from the Browse window. 

5. If the device you want to use is not displayed in the Device field, click the Browse… 
button and select the proper device from the Browse window. 

6. If you are using an autoloader, select the autoloader and the storage slot that holds the 
media you want to format. 

7. If you want to assign a password to the media, click the Media Password button and 
then enter and confirm the password in the Media Password window. 

8. Click the Format button. TapeWare formats the specified media. 

Import Media 
This command allows you to use data on media that was created in another storage 
management zone or by another software program. To use media that was not created in 
the current storage management database, you must import that media into the current 
database. 

You might import media in one of four situations: 

• When you want to use media created by an earlier version of TapeWare. 

• When you want to use media created in a different TapeWare storage management 
zone. 

• When you want to use media created by another backup program. 

• When you want to use media accidentally deleted from the storage management 
database. 

 
Format Media 
button 
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When you import media, you must supply the media password. No password is required 
if the media has no password. 

Note  Early versions of TapeWare automatically assigned PASSWORD as the default 
media password. If you are having trouble importing media created with an early version 
of TapeWare, try using PASSWORD when prompted for the media password. 

TapeWare will not perform any other operations while it is importing media. 
Additionally, the process may last several hours. Before you import media, be certain that 
there is sufficient time to complete this lengthy process. Additionally, you will want to be 
available to log out of TapeWare when the import is complete, in order that the security 
of the network is not compromised. 

When you import 
media, select the 

device you want to 
use to read the 

imported media. 

If you are using an 
autoloader, select 

the storage slot 
that holds the 

media you want to 
import. 

 
To Import Media 

1. Insert the media to import into your device. 

2. Select Import Media from the Device menu or the shortcut (right-click) menu. The 
Import Media window appears. 

3. The Media Folder field displays the folder in which TapeWare will store the 
imported media. If this is not the folder in which you want to store the media, click 
the Browse… button and select the proper media folder from the Browse window. 

4. The Device field displays the device from which TapeWare will import the media. If 
the device you want to use is not displayed, click the Browse… button and select the 
proper device from the Browse window. 
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5. If you are using an autoloader, select the storage slot that holds the media you want 
to import. 

6. Click the Import button. 

7. When the confirmation window appears, click Yes. 

8. In the Import Password window, enter the password for the media you are 
importing. If the media has no password, leave the field blank. 

9. Click OK. 

Restore Database 
The Restore Database… command provides a quick method of restoring your current 
storage management database, e.g., in case it has been lost or corrupted. Use this 
command only when your current set of media is intact. For example, you might use this 
command if the storage management server has crashed. 

The Restore Database… command differs significantly from the Import Media… 
command. The Restore Database… command replaces the current storage management 
database with the last known good database on that media. The Import Media… 
command, on the other hand, does not replace the current storage management database; 
it only adds additional data to it. 

The advantage of the Restore Database… command is that it provides a quick and easy 
way to replace a lost or corrupted TapeWare storage management database. (You could 
use the Import Media… command to restore a corrupted database, but this process is 
very time consuming and, if you have multiple tapes, might require many hours or even 
days.) 
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To restore a corrupted or 
lost database, select the 

device you wish to use 
on the Device tab and 

select Restore 
Database… from the 

Device menu. 

If you are using an 
autoloader, select the 

proper storage 
element… 

…and then click 
Restore. After the 

command completes, 
quit and restart.  

Note  All current information in the current TapeWare storage management database will 
be lost when you use the Restore Database… command. This command does not 
append data to the current storage management database; it replaces the current storage 
management database with the database on that media. 

To Restore a Storage Management Database 
1. Locate the media on which you have backed up the storage management database 

you wish to restore. Normally, this is the last backup job run. 

Note  If you printed the log from the last backup job, you can identify the media 
which contains the database. To make certain the database is regularly backed up, 
check the Selection tab of the backup job to verify that the database for your zone is 
checked. 

2. Insert the media into the appropriate backup device and then select it in the object 
detail area of the Device tab. 

3. Select Restore Database… from the Device menu or the shortcut (right-click) menu. 

4. The Device field displays the device from which TapeWare will restore the database. 
If the device you want to use is not displayed, click the Browse… button and select 
the proper device from the Browse window. 

5. If you are using an autoloader, select the correct storage slot from the 
Device/Storage field. 
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6. Click Restore. 

7. Exit TapeWare to finish the database restore process.  

8. If the TapeWare service is running, stop and restart the service (see Appendix E — 
TapeWare Service in the TapeWare Installation Guide. 

When you restart TapeWare, the database will be restored. 

Clean Device 
The Clean Device… command will run the backup device through a cleaning cycle. 

This command is supported only by autoloaders. If a device in an autoloader provides 
notification that it needs cleaning and the autoloader has a cleaning cartridge available, a 
cleaning cycle will be performed automatically at the start of a backup job. If you are 
using a device that is not an autoloader, you must manually clean the device at the 
manufacturer’s suggested intervals. 

To clean a device in an autoloader, highlight the device and select Clean Device… from 
the Device menu. TapeWare will check to see if one of the slots holds a cleaning 
cartridge. If it does, the cleaning cycle will be performed in the background; if not, an 
error message is shown. 

If the Clean Device… command is missing, it is not available for your backup device. In 
this case, a cleaning cycle can often be performed by manually inserting a cleaning 
cartridge into the backup device. 

Identify Media 
Use this command to get the name of the media currently loaded in the device. TapeWare 
tries to identify the tape or other media that is currently loaded in the device. If TapeWare 
cannot identify the media, it reads the media header, a process that may take up to several 
minutes. When TapeWare has learned the name of the media currently loaded, it displays 
that name in the Properties of… window. 

Database Tab 

All of the objects in the current TapeWare storage management zone are displayed on the 
Database tab. (Like other tabs, of course, you will only be able to see those objects to 
which you have permissions.) 

For more 
information on 
setting up a 
cleaning 
cartridge on an 
autoloader, see 
Status Tab in 
Chapter 12 — 
Object and 
Property 
Reference. 

 
Identify Media 
button 
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Many commands can be performed from the Database tab, including all of the 
commands on the Device tab and the Queue tab. These commands include running jobs, 
stopping jobs, formatting media and so forth. Note however that you cannot create new 
objects on the Database tab. 

The advantage of the Database tab is that it can display all of the objects in the storage 
management database at once. This is also its disadvantage, that so many objects are 
displayed that it may be cluttered and difficult to work with. 

You can use the Query window, however, to limit what files and objects are displayed on 
this tab. The Query window works similar to the Selection Filters window for jobs. It 
sorts through database objects and only displays those which meet the specified criteria. 

You can use the Query 
window to ‘sort’ through 

the objects in the 
database in order to 

only display those 
objects that match your 

specified criteria. 

 
For example, you might want to only display files that have not been backed up or only 
those files that have been deleted. By setting the appropriate filters, you can control 
which objects are displayed on the Database tab. For additional information on how each 
query filter works, see Query Window in Chapter 12 — Object and Property Reference. 

 

 
Query button 
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Chapter 10 — Tips, Techniques and Strategies 

This chapter contains information you can use to work more efficiently with TapeWare. 
The first sections explore managing the storage management database and running jobs 
faster. The last sections of the chapter cover practical techniques for working with jobs. 

In This Chapter 
• Managing the Storage Management Database 

• Strategies for Faster Jobs 

• Working with Permissions 

• Working with Scheduled Jobs 

• Selecting Files for Jobs 

• Restoring Tips 

• Other Tips 

Managing the Storage Management Database 

An important decision when planning a comprehensive backup strategy is where to locate 
the TapeWare storage management database. This section explores some considerations 
you should review before making this decision. 

Where to Locate the Storage Management Database 
Consider locating the database on a workstation or file server other than the main file 
server. 

Recall that TapeWare keeps track of objects and properties in a storage management 
database that it creates and manages. Where should you store this database? That is, on 
what volume and machine should be storage management server? 
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TapeWare lets you locate the storage management database on any machine (workstation 
or file server) or volume in the storage management zone. Note that the storage 
management database does not have to be on the same machine as the backup device. It 
could be placed on any volume of any machine that is a member of the storage 
management zone. 

 

NetWare File Server 
with Backup Device 

Win NT File Server 
with Backup Device 

LAN Workstation with 
Storage Management Database  

You can locate the storage 
management database on 

any machine in the 
TapeWare network, 

including, in this case, a 
workstation. Attach the 

backup devices to 
machines using local 

buses for greatest speed. 

 
For example, suppose you have a file server with a large RAID device attached. Backup 
jobs using this RAID device will run fastest when the backup device is placed on the 
same machine as the RAID device. On the other hand, the storage management database 
may be best located on another machine other than the file server. This is because if the 
file server were to become inoperable (for example, the drive were to crash), you would 
still be able to use the storage management database to restore the file server volumes. 
Had the storage management database been located on the file server, however, the 
database must first be restored before other files could be restored. This can be a lengthy, 
time-consuming process. 

A good strategy to consider is to place the backup device on the file server for maximum 
speed, but to locate the storage management database on a separate machine. Consider 
this example. Two file servers are connected on an Ethernet network. Each file server has 
its own backup device, which helps the jobs run faster and more efficiently. The storage 
management server for all three machines is located on a separate machine, which can be 
called a “storage management server.” Jobs can be run from this storage management 
server; additionally, they can also be run from any other machine on the network as well. 
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You can administer 

a job from a 
different storage 

management zone. 
NetWare File Server 
with Backup Device 

Win NT File Server 
with Backup Device 

LAN Workstation with 
Storage Management Database  

LAN Workstation from Different 
Storage Management Zone.  

Note  The backup device could have been placed just as easily on any other machine in 
the network. TapeWare does not require that the backup device be physically attached to 
a file server. Additionally, while the term “storage management server” is a convenient 
label, in fact, TapeWare does not require that this machine be a network server. It could 
just as well be a client machine or workstation. 

This arrangement offers several advantages: 

1. Jobs run quickly because most of the data is transferred over local buses, instead of 
over the network. In this arrangement, TapeWare will automatically route data from 
each of the file servers over local buses to its own backup device. Whenever there is 
a choice, TapeWare automatically routes data over local connections rather than 
network connections. 

2. Administering jobs is uncomplicated. Jobs can be created and run from any machine 
on the network. Note that jobs can also be administered from a machine that is a 
member of a different storage management zone. The TapeWare administrator or 
other user can log on to this storage management database from another database 
zone and then create and run jobs in that zone. 

3. Suppose a disaster occurs and the RAID device of one of the file servers needs to be 
replaced. Because the storage management database is located on another machine, 
recovery is quick and easy. The storage management database contains all of the 
information necessary to restore the lost data. Had the database been stored on the 
file server, recovery would have been much more difficult. Note that the backup 
device on the other file server can be used to help restore the file server that failed. 
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4. Suppose the storage management server fails and the TapeWare storage management 
database is lost. While the loss of the storage management server is significant, the 
file servers are not impacted and they can continue to perform their tasks. Backups 
can still be run from another machine on the network or, if need be, from the file 
servers themselves. Since the storage management database was lost, it will have to 
be imported from existing tapes. This step, however, is not crucial and can be run 
when convenient, as long as careful backup procedures are followed (that is, no 
important tapes are overwritten and a full backup job is run immediately). 

The advantages of this arrangement extend to any backup strategy or network 
arrangement. In general, consider placing the TapeWare storage management database on 
a machine separate from the most important data. At the very least, consider locating the 
database on a separate volume. 

Accounting for Storage Management Database Size 
Before deciding where to locate the database, consider how large the TapeWare database 
might eventually become. 

The size of the storage management database is primarily a function of the number of 
tapes in the backup set, the number of files backed up and the number of instances of 
each file on valid media. To a lesser extent, the number of objects in a storage 
management database and the properties of those objects affect the size of the database. 

In its storage management database, TapeWare assigns 

• 40 bytes for each instance of a file, 

• 128 bytes for each database object, and 

• 1024 bytes for the properties associated with objects. 

You can use these figures to estimate the size of the storage management database. Files 
are by far the most numerous of the objects in the database, so much so that the size of 
the other objects (such as users and jobs) is negligible. Each file that is backed up is 
assigned 128 bytes and is made part of the storage management database. While this 
figure can be significant, the number of instances for that file in the storage management 
database is more important when predicting the size of the database. This is because there 
might be as many as 20 or 30 instances of a particular file in the storage management 
database. (Files only have properties associated with them when they are assigned 
permissions or storage streams, but generally, since most files inherit their permissions 
from other objects, the 1024 bytes assigned for properties can be ignored.) 

For more 
information on 
restoring a 
corrupted 
storage 
management 
database, see 
Restore 
Database in 
Chapter 9 — 
Media, Device 
and Database 
Tabs. 
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Consider the following example. Suppose a file server which holds 100,000 files is 
regularly backed up using the GFS-25 automatic rotation schedule. Because there are 25 
tapes in this backup set, there are potentially 25 instances of each of these files (although 
in practice, there will be fewer instances since most of the jobs are incremental). You can 
predict the size of the storage management database as follows: 

[(# of files) * (128 bytes)] + [(# of instances) * (# of files) * (40 bytes)], or 

[(100,000) * (128 bytes)] + [(25) * (100,000) * (40 bytes)] = ~108 MB. 

Storage Management Server and Machine Platforms 
Finally, consider both the operating system and the hardware of the machine that will 
contain the storage management server. For multi-user network installations, we 
recommend placing the database on a high-speed, high-capacity server. For example, in a 
Windows environment, place the database on a Windows NT (or later) server that has a 
fairly current CPU and adequate RAM instead of an older machine running Windows 
98/Me. 

For single machine installations, TapeWare runs adequately under Windows, NetWare, 
Linux, UNIX and DOS. However, it runs less efficiently under DOS and Windows 
98/Me than under the other platforms. 

Strategies for Faster Jobs 

TapeWare is designed to run jobs quickly and efficiently on various network platforms 
and arrangements. This section will help you plan your backup strategy and network 
installation to maximize TapeWare’s speed and efficiency. 

What Slows Down Tape Drives? 
Tape drives work most efficiently when they are “streaming,” that is, when the tape itself 
is constantly moving forward and a steady flow of data is being written to the tape as it 
passes the write head. In general, tape drives will “stream” if there is a constant flow of 
data available to write to the tape. 

Whenever there is an interruption in the data and the drive must wait for the data, the 
“stream” breaks off and the tape stops. Additionally, after the tape stops, the drive must 
reposition the write head and regain the velocity of the tape. To do so, the drive will back 
up the tape prior to where it stopped writing and then restart the tape forward again. This 
can be a time-consuming process, especially if it occurs repeatedly. 
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For this reason, it is important to keep data constantly flowing to the tape drive. The 
performance of your job will be maximized when the tape drive constantly has data 
available to it. 

Maintaining the Flow of Data 
There are several steps you can take to make sure that data is constantly available to the 
backup device. 

Prefer Local Buses to Network Connections  In general, data is transmitted more 
efficiently over a local bus than over a network connection. Thus, for example, 
performance increases if the backup device is connected to the file server rather than to a 
different machine on the network, although either arrangement is possible. 

Note that the storage management database need not be placed on the same machine as 
the backup device. The location of the storage management database does not affect the 
rate of data transmission. (Other job tasks, such as building backup selection lists and 
opening and closing files, create network traffic and require CPU calculations. While the 
location of the storage management database will affect these parts of the job, the 
advantages of a remote location of the database often outweigh any speed loss.) 

Add a Second Device Controller  A backup device and volume may be on the same 
machine with a local connection between them. If the backup device and the volume 
share the same device controller, this limits the speed of data transmission and may cause 
a TapeWare error. Therefore, you should add a second device controller specifically for 
the backup device. This can effectively double the rate of data transmission and enhance 
TapeWare operation. At the least, you should connect the backup device to a different 
SCSI chain or IDE channel. 

Use a Wider Data Stream  For both network and local connections, the width of the data 
stream affects the rate at which data can be transferred. Many tape drives are capable of 
writing data much faster than can be transferred over older device controllers and 
network connections. By upgrading to more recent technology with wider data streams, 
there will be fewer interruptions in the stream of data to the backup device. For example, 
consider using a Wide or Ultra Wide SCSI controller for the backup device. Additionally, 
for network connections, consider upgrading from 10Base-T Ethernet to 100Base-TX. 

Consult your manufacturer’s documentation to see if your backup device would benefit 
from a wider data stream. 

Use the Proper Number of Data Streams  TapeWare is capable of controlling up to eight 
data streams per backup device simultaneously. This feature can greatly increase your job 
speed since multiple devices can simultaneously send data. For example, four backup 
devices can support up to 32 simultaneous data streams. 
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You control the data streams of a volume, directory or file from its Storage tab. 
Normally, the Backup stream field on the Storage tab of a volume is set to Create new 
stream, while the Backup stream of a directory or file is set to Use existing stream. By 
changing these options, you can change the number of backup streams, thereby affecting 
the speed at which the job runs. Assigning the proper number of data streams can help 
speed up the data transmission rate. 

In general, you should assign data streams according to the number of streams the 
physical device (e.g., the disk drive) is capable of handling. Usually this number is equal 
to the number of spindles the drive has. Under most circumstances, you should use this 
number to determine the number of data streams. 

One exception to this general rule is when you are working with very large files. You can 
increase performance by creating an additional stream for each of these very large files. 
For example, if you have a very large file with 1.0 GB or more, create a separate stream 
for this file. Then TapeWare will be able to send the file to the tape drive at a higher rate 
that allows for “streaming.” 

Consider these three examples: 

1. A RAID device is capable of sustaining multiple data streams at once. By assigning 
various directories on the RAID device to additional streams, you can increase the 
rate of data transmission. To do so, assign large directories to their own streams by 
changing the Backup stream field of each directory’s Storage tab to Create new 
stream. Don’t add any more streams than the RAID device can sustain. 

 Use the Storage tab to 
create new streams for 

large files and directories 
on RAID devices. 

 
2. On the other hand, a single physical device may have multiple logical volumes. If 

each volume is assigned a separate stream, this will not result in faster data 
transmission and may, in fact, result in slower data transmission if it creates 
additional seeks by the disk drive. To turn off one of the data streams, change the 
Backup stream field on the volume’s Storage tab to Use existing stream. 

3. Some file servers may have large database files on them, perhaps 1.0 GB or larger. 
These files should be assigned to their own streams. To do so, change the Backup 
stream field on the file’s Storage tab to Create new stream. 

In general, when creating or modifying data streams, first use the capacity of the physical 
device to determine the optimum number of data streams and then create separate streams 
for very large files. Too few or too many data streams will impede maximum 
performance. 
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You may experience problems with data streams if you have not dedicated any streams to 
specific volumes or files. Problems may also occur if you exceed your hardware or 
operating system capacity. 

Other Factors that Affect Job Speed 
Additional factors that affect job speed include: 

File Compression  Whether or not files are compressed by the backup unit affects how 
fast jobs run. When a backup device compresses files, e.g., at a ratio of 2:1, a 
proportionately greater amount of data needs to be sent to the backup device for it to 
stream. However, when files are sent across the network already compressed, as NetWare 
does, further compression by the backup device will be negligible. 

Note  Compression ratios vary among devices. 

Minimize Small File Size  Large files transfer and are written to the backup device more 
efficiently than are small files. If you can limit the number of small files you back up, 
especially those smaller than 64K, your job will run more quickly. 

CPU Speed  In general, a faster CPU results in faster backups. Take the speed of the CPU 
into account when deciding where to place the backup device and to locate the storage 
management database. 

RAM  In general, additional memory results in faster backups. By default, TapeWare 
allocates 25% of physical memory, up to 32MB per device, for buffering. If you have 
four devices on one machine, you should install 512MB of memory (32MB x 4 devices 
x 4) in that machine. If you have eight devices on one machine, install 1GB of memory 
(32MB x 8 devices x 4) in that machine. 

Note  Use this as a guideline when attaching devices to each machine. 

Enable Native data streams format  By default, TapeWare stores files in the format of the 
source platform or the network format. For example, it uses the Windows data format on 
Windows platforms and the NetWare data format on NetWare platforms. In general, jobs 
run faster when this default setting is selected. 

However, if you plan to share data from one network platform to another, you should 
clear this option. This option is in the Advanced Options window. 
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For faster jobs, 
keep the Native 

data streams 
format checked. 

 

Warning  Security is an issue to consider when checking this option. When this option is 
checked, TapeWare backs up all security information that network software includes in 
the data stream. If the option is unchecked, TapeWare uses a generic format that removes 
security information. 

Working with Permissions 

This section provides useful tips for assigning permissions. 

Checking the Effective Permissions of a User 
Log on as the user. 

On complex installations with multiple users and groups and varying levels of security, a 
particular user’s effective permissions can be difficult to identify. The easiest way to 
identify a user’s effective permissions is to log on as that user. 

If you have not yet assigned the user a password, simply log on as the user. Browse the 
various General tabs of the objects in the storage management database. Verify that the 
displayed effective permissions match your intended security measures. 

If the user has a password and you do not know it, create an “alias” user and make it 
equivalent to the user whose permissions you wish to check. Then log on as the alias 
user. Be certain to delete both the alias user and its folder after verifying the effective 
permissions. 
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Using Groups to Handle Complex Security Needs 
Set up groups and then make users members of them. 

Some security arrangements can be very complex, with multiple users possessing 
differing levels of effective permissions to different storage management database 
objects. Setting up each user’s permissions separately and individually can be a complex 
and time consuming process. 

You can use groups to speed up this process. Consider the following simplified example. 
Suppose you want some users to have full permissions to a tape drive (that is, the ability 
to create new tapes, to overwrite old tapes, to write backup tapes and read tapes for 
restore jobs), but want other users to have limited permissions to the tape drive, for 
example, only the ability to write to backup tapes, but not overwrite them. 

Begin by creating two new groups. Name one group Users with Full Permission to Tape 
and assign this group Create, Modify, Delete, Write and Read permissions to the tape 
drive. Name the other group Users with Write Permission to Tape and assign this group 
Write permission to the tape drive. Next, delete the corresponding User/Group folders 
that appear on the job tabs. 

Then when you create new users, rather than individually assigning each user 
permissions to the tape drive, make them members of the appropriate group. 

You create as many groups as necessary, with varying levels of access to storage 
management database objects such as media, machines, volumes and directories. For 
example, you might create a group named Backup Permission to Volume and another 
named Backup and Restore Permission to Volume, assigning to each the appropriate 
permissions. 

Working with Scheduled Jobs 

This section provides useful tips for running scheduled jobs. 

Running a Failed Rotation Job Again 
Manually set the correct options and “force” the job to run again. 

Suppose a scheduled job has failed to run correctly. In order to ensure the integrity of the 
data, the job must be run again. 
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Consider this example. Suppose it is discovered on Monday morning that a full backup 
job has failed to run as scheduled on Friday evening. If a full backup job is not run before 
the next incremental job, the ability to fully reconstruct data will be compromised. It is 
vital that the full backup job be run soon. 

However, you cannot merely “force” the job to run again. Recall that when TapeWare 
runs a scheduled job, it automatically updates four parameters on the Options tab of the 
job: Backup mode, Write mode, New media location, New media name and Media. 

Note that TapeWare does NOT automatically update these fields when you manually 
“force” a scheduled job to run. For example, when TapeWare automatically runs a 
scheduled backup job on a Monday, it changes (updates) the Backup Mode from Full to 
Incremental. But when this job is “forced” to run before its scheduled time, TapeWare 
does not automatically update these fields. 

You must manually 
set the Backup 

mode and other 
options before 

forcing a scheduled 
job to run. 

When you force a 
scheduled job to run, 

the Backup mode, 
Write mode, New 

media location, 
New media name 
and Media are not 

updated. 

 
Before forcing a failed job to run again, open the job log of the failed job, noting the 
appropriate options. If needed, print the job log. Next, open the Options tab of the failed 
job. Set the parameters on the options tab to match those of the failed job. In particular, 
check the Backup mode, Write mode, New media location, New media name and 
Media. 

You will also want to select the appropriate media in the Media field. Use the Browse 
button to select the same media as the failed job was to use. When the options of the job 
match the options the failed job would have used, run the job. 

If you have changed the Media field, be certain that this field is set back to its original 
specification so that scheduled jobs will automatically select the proper media. 
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An alternative method would be to copy the failed job, change the schedule type to Not 
Scheduled and then set the options parameters to match the failed job. Manually “force” 
the job to run and delete it after it has successfully completed. 

Scheduling a Job to Run Once Only 
Turn off all the dates on the Manual schedule except the desired date. 

When you want to run a job only once, you should set the Type field on the Schedule tab 
to Not scheduled. Then you can run the job from the Backup, Restore or Verify tabs at 
any time.  

But what if you only need to run a job once during off-peak hours? 

1. Create a new backup job. 

2. When the General tab appears, give it a name, such as One-Time Backup. 

3. Click the Selection tab and select the objects (directories, files, and so on) to back up. 
Many people select either the Network or computer name check boxes to back up all 
data on the computer. 

4. Select Manual in the Type field on the Schedule tab. 

5. Set the Start time for the job. 

6. De-select the day name tiles, located at the top of the calendar, to turn them all off. 
The dates in the calendar from today forward will turn white. (Past days turn gray.) 

7. Right-click the day of the week on which to run the job. 

8. When the popup menu appears, select Daily. The job will only run on that day. 

9. Click OK to close the backup job properties window. The job will run once on the 
selected day at the selected start time. 

Scheduling Simple Backup Jobs 
Many computer users do not need the power of one of TapeWare’s built-in schedules. 
They can manage their backups best with a simplified backup plan, such as the simple 
daily backup or the simple five-day rotation described below. 
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Simple Daily Backup 
Create a Manual schedule to run a full backup every day of the week at the same time. 

If an autoloader is not installed, you can create the following simple daily backup plan. It 
does not require different media for different days, though you can rotate your media if 
desired. It also does not require a lot of your attention. You can set it up quickly and let it 
run. 

1. Create a new backup job. 

2. When the General tab appears, give it a name such as Daily Backup. 

3. Click the Selection tab and select the objects (directories, files, and so on) to back up. 
Many people select either the Network or computer name check boxes to back up all 
data on the computer. 

4. Click the Options tab. The Backup mode should be set to Full by default. 

Note  Always select Full from the Backup mode list for this job. Otherwise, the backup 
job will not copy all of your data. 

5. Select Overwrite all tapes from the Write mode drop-down list. 

6. If your backup device does not support compression, select Standard from the 
Compression type drop-down list. 

7. If your backup device supports automatic eject, you can configure the job to eject the 
media after the job finishes. Click Advanced Options. When the Advanced Options 
window appears, select Auto eject and click OK. 

8. Click the Schedule tab. 

9. Select Manual from the Type field. 

10. Set the Start time for the job. 

11. Select the day name tiles, located at the top of the calendar, for the backup days. 
Selected dates turn red. De-select the tiles to not run the backup on those days. De-
selected dates turn white. (Past days turn gray.) 

12. Click OK to close the backup job properties window. The job will run at the selected 
time on each selected day. 
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Simple Five-Day Rotation  
Create separate media folders and backup jobs for each day of the week. 

If an autoloader with five or more slots is installed, you can create the following simple 
five-day rotation plan. It requires separate media for each day of the week, one in each 
autoloader slot. You can set it up quickly and let it run. You can also use different tape 
magazines to create separate sets of backups for different weeks. For example, set A for 
the first week of the month, set B for the second week and so on. 

1. Create separate media folders for each day of the week: 

a. Click the Media tab. 

b. Right-click the Admin Folder in the left window pane. 

c. Select New Media Folder from the popup menu. 

d. Enter Monday. 

e. Repeat steps b through d for Tuesday, Wednesday, Thursday and Friday. 

2. Create new backup jobs for each day of the week: 

a. Click the Backup tab. 

b. Right-click the Admin Folder in the left window pane. 

c. Select New Backup Job from the popup menu. 

d. When the General tab appears, enter Monday. 

e. Click the Selection tab and select the objects (directories, files, and so on) to 
back up. Many people select either the Network or computer name check 
boxes to back up all data on the computer. 

f. Click the Options tab. The Backup mode should be set to Full by default. 

Note  Always select Full from the Backup mode list for this job. Otherwise, the backup 
job will not copy all of your data. 

g. Select Overwrite all tapes from the Write mode drop-down list. 

h. If your backup device does not support compression, select Standard from 
the Compression type drop-down list. 

i. Select the existing Home\Admin Folder in the Media pane. 

j. Click the Delete button under the Media pane and click OK. 

k. Browse to Home\Admin Folder\Monday and click OK. 
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l. Click the Browse button next to New media location. 

m. Browse to Home\Admin Folder\Monday and click OK. 

n. Click the Schedule tab. 

o. Select Manual from the Type field. 

p. Set the Start time for the job. 

q. De-select the tiles for each day except Monday. De-selected dates turn white. 
(Past days turn gray.) 

r. Click OK to close the backup job properties window. The job will run at the 
selected time on the selected days. 

s. Repeat steps a through r for Tuesday, Wednesday, Thursday and Friday. 

Selecting Files for Jobs 

This section provides useful tips for selecting files. 

Selecting Files not Previously Backed Up 
Set the Instance Range filter to At most 0. 

Suppose you want to run a backup job that only selects files that have not been backed up 
previously. You can use the Instance Range filter to “filter out” any files that have been 
previously backed up. 

Each time TapeWare backs up a file, it creates a new instance of that file. If a file has not 
been backed up, TapeWare has no instances recorded in the database for that file. 

To select only files that have not been previously backed up, begin by clicking the 
Selection Filters button on the toolbar of the Selection tab. The Selection Filters 
window will appear. 

Click on the Filter Change button next to the Instance Range field. Set the Range Type 
to At most and then set the Maximum instances field to 0. TapeWare will only select 
those files with no instances. 

 
Filter Change 
button 

 
Selection 
Filters button 
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To select only files 
that have not been 
previously backed 

up, set the 
Instance Range 

filter to At most 0.  
Note that this method does not ensure that you have the latest instance of every file. 
Having an instance of a file does not ensure that the instance you have reflects the latest 
changes to the file. It may have been modified after the last time you backed it up and so 
your latest instance may not match the file’s current form. 

Selecting Deleted Files for Restoring 
Set the Delete range filter to On or before some random future date. 

When a file has been deleted from a file server or workstation and an instance of that file 
exists on valid media, TapeWare marks that file in its storage management database as 
having been deleted and assigns it a delete date. Additionally, these files appear with a 
special icon in the object detail area of the Selection tab. 

 Files that have been deleted, 
but for which there are valid 
instances in the database, 
are marked with a special 
yellow “x” icon. 

 
You can use the Delete range filter to select only those files for restoring that have been 
deleted. Begin by clicking the Selection Filters button on the toolbar of the restore job’s 
Selection tab. The Selection Filters window will appear. 

Click on the Filter Change button next to the Delete range field and then select On or 
before from the Range type list box. Next select a random future date, for example, Jan. 
1, 2020. TapeWare will exclude all of the files that have not been deleted from the set of 
files to be restored. When you return to the Selection tab, all and only those files that 
have been deleted will be checked. 

To select files that 
have been 

deleted, set the 
Delete range filter 

to On or before 
some future date. 

 

 
Filter Change 
button 

 
Selection 
Filters button 
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Selecting Instances from a Specific Job 
Select the appropriate instance date for a container object. 

When a file is backed up, TapeWare creates an instance. Each instance of a file has a 
unique instance date and every file backed up during the same job has the same instance 
date. (You can view this information for all of the available instances in the Instances… 
window.) 

Remember that when you specify the instance date for a container, such as a volume or 
folder, objects in that container are only selected when they have the same instance date. 

If you want to select only those files backed up during a particular job, begin by checking 
a container high in the tree hierarchy, such as the machine or network icon. This will 
cause all of the files below this object to be initially selected. Then open the Instances… 
window by clicking on the Select Instance button. Select the appropriate date and time 
instance for the job. Now only those files with a matching instance date will be selected. 

Selecting Instances from Specific Media  
Add the media to the Media filter. 

Suppose you want to restore only those files that appear on specific media or want only 
to verify files from specific media. You can use the Media filter on the Selection Filters 
window to only select files that have valid instances on the media you specify. 

To do so, open the Selection Filters window by clicking on the Selection Filters button 
on the toolbar of the Selection tab of the job. Then click the Add... button to open the 
Browse window. When you add media to the Media field, TapeWare checks to see if the 
file selected has a valid instance on that Media. If so, that file is included in the job. (If 
you add multiple media to the Media field, only files with instances on all the selected 
media will be included in the job.) 

 
Select Instance 
button 

 
Selection 
Filters button 
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Restoring Tips 

This section provides tips for restoring files and volumes. 

Restoring Volumes for the Latest Date 
If you have used a built-in schedule and have run backup jobs as scheduled, you can 
easily and simply restore files as they appeared the last time a backup job was run. 
Simply select the volumes or files you wish to restore on the Selection tab of a restore 
job. The <Latest> instance of each file will be automatically restored to the volume. 
TapeWare will prompt you for whatever tapes are needed to complete the restore job. 

Restoring Volumes for a Specific Date 
You can restore volumes and directories as they appeared on a particular date as long as 
that date is within the full data recovery period. Recall that the full data recovery period 
is the number of days prior to the data loss for which any and every file backed up can be 
recovered. (To restore volumes to the last backup date, refer to Restoring Volumes for the 
Latest Date above.) 

Different schedules provide full data recovery periods for varying numbers of days prior 
to the last backup. For example, a GFS 30-tape job can reconstruct the data for any day of 
the past three weeks, while a simple 4-tape backup only provides for reconstruction of the 
past two days. 

You can reconstruct the data for any particular day during the full data recovery period. 
Consider this example. Suppose you want to restore a particular volume as it appeared on 
Wednesday morning. Providing the date falls within the full data recovery period, there 
are three possible scenarios for restoring the volume as it appeared at the beginning of 
business on Wednesday: either (1) restore from a full backup tape; (2) restore from a full 
backup tape and the most recent differential tape; or (3) restore from a full backup tape 
and all of the incremental tapes from the previous full backup and the date in question. 
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Example 1 assumes a 
full backup job was run 

the Tuesday evening 
before the Wednesday 

for which you want to 
restore data. 

Example 3 assumes incremental 
jobs were run on the Monday 

and Tuesday before the 
Wednesday and a full backup 

job on the previous Friday. 

Example 2 assumes a 
differential job was run 
on the Tuesday before 
the Wednesday and a 
full backup job on the 
previous Friday. 

 
1. If you ran a full backup job the previous evening, you can run one restore job. Begin 

by creating a new restore job and selecting the appropriate volume on the selection 
tab of the restore job. Initially, the <Latest> instance of these files will be selected. 
You must select the instances according to the desired date, in this case the Tuesday 
before the Wednesday. To do so, set the Backup range filter to the desired date. 
Begin by clicking the Selection Filters button on the toolbar of the restore job’s 
Selection tab. The Selection Filters window will appear. Then click on the Filter 
Change button next to the Backup Range field. Specify Tuesday’s date in the Date 
Range window. 

2. If you ran a differential job the previous evening, you need only run two restore jobs. 
The first restore job must restore all of the files from the previous full backup job; the 
second restore job must restore files from the previous evening’s differential job. 

Suppose in this example that the last full backup was done on Friday evening and 
that a differential job was run on Tuesday evening. To restore files as they appeared 
on Wednesday morning, follow these steps. 

First, create a restore job, select the appropriate volume and then set the Backup 
range on the Selection Filters window to match Friday’s date. Name the job with an 
appropriately identifying name, such as Restore from Friday’s Full Backup. 

Second, copy the first restore job, rename it with an identifying name and change the 
Backup range date to match Tuesday’s date. 

Run the two jobs, being certain to run them in the proper order. 

3. If you ran an incremental job the previous evening, you will need to run two or more 
restore jobs. The first job must restore all of the files from the previous full backup 
job; the other jobs must restore all of the files from all of the previous incremental 
jobs between the full backup and the date in question. 

 
Filter Change 
button 
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Suppose in this example that the last full backup was done on Friday evening and 
that incremental jobs were run on Monday and Tuesday evenings. To restore the 
volume as it appeared on Wednesday morning, follow these steps. 

First, create a restore job, give it an identifying name, select the appropriate volume 
and then set the Backup range to Friday’s date. 

Second, copy the first restore job, rename it with an identifying name and change the 
Backup range date to match Monday’s date. Repeat this step, changing the Backup 
range date of this third job to Tuesday’s date. 

Run the three jobs, being certain to run them in the correct order. 

Copying a Directory Structure 
Clear the Children check box in the Selection Filters window. 

Suppose you have set up a complex directory that you want to replicate in a new location, 
for example, on a new workstation or file server. TapeWare provides you an easy way to 
do this. 

If you have not previously backed up the directory, create a backup job that does so. 
Select the appropriate volume. Then, open the Selection Filters window. Clear the 
Children check box, being certain that the Parents box is checked. (The job will run 
faster when the Children box is cleared, however it is not necessary to clear this option. 
You can restore the directory by itself, even when you have previously backed up both 
the directory and the files in it.) 

To copy the directory structure to a new location, create a restore job, selecting the 
appropriate directory and restore location. Then, open the Selection Filters window. 
Clear the Children check box, being certain that the Parents box is checked. The job 
will “copy” that directory to the new location. 

Restoring Files to a New or Different Folder 
On the Selection tab, drag the files to a different folder. 

Suppose you want to restore files or folders, but do not want to overwrite files and folders 
currently existing on the volume. To avoid overwriting (replacing) current files or folders 
with the instances you are restoring, restore the files or folders to a new or different 
location. 

When you instruct TapeWare to restore files and folders in new locations, TapeWare 
creates new files and folders in the specified location. 

 
Selection 
Filters button 
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To restore a file to a different folder, drag the file in the tree view area on the Selection 
tab of the restore job to the new folder. (If the target folder does not exist, you must 
create it first.) In the Confirm Move window, select a target location. TapeWare will 
move the file to the location you specify in the Target field. 

To restore a folder or 
file to a different folder, 

select it, drag it to the 
new folder… 

…and then confirm 
the move in the 
Confirm Move 

window. 

 
You can also restore folders and volumes in new locations. The contents of these 
containers move with them and are restored, along with the folder or volume, in the new 
location. 

Additionally, you can create a new folder and restore files to that new folder. When 
TapeWare restores the files, it creates the new folder and restores the files you specified 
to that new location. Similarly, you can restore folders and their contents in new folders 
you create. 

To create a new folder in which to restore the file or folder, first highlight the location 
where you want to create the new folder in the tree view area. Then click on the New 
Object button on the Selection tab’s toolbar. Or use the shortcut (right-click) menu and 
select New Directory. TapeWare will create the new folder in the location you specified. 
Give the folder a new name and then drag into that folder the files and folders you want 
restored in it. 

To restore a file or folder 
to a new folder, first 

highlight the container in 
which you want to create 
the new folder and then 

select New Directory 
from the shortcut menu. 

Next, drag the 
folder or file you 
want to restore to 
the new folder you 
created. 
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Note that when you move an instance on the Selection tab of a restore job, the changes 
you make are only reflected in the current restore job. Only the current restore job will 
assign the file or folder the new location. When you create a new restore job, you will see 
the files and folders in their original locations. Likewise, the Database tab will continue 
to display files in their original locations. 

Restoring Files with New Names 
Rename the file on the Selection tab of the restore job. 

Suppose you want to restore a file with a different name. To do so, you rename the file 
after you select it. When you rename the file, TapeWare restores the file with the new 
name. This can be useful for not overwriting versions of the file that currently exist on 
disk. 

To rename a file, right-click the file name and select Rename from the shortcut menu. 
You can also rename a file by selecting its name again after it has been highlighted. 

To restore a file 
with a new name, 

highlight it and 
then select it 

again. Then type 
the new name.  

Note that when you rename an instance, you are only renaming that file for the purposes 
of restoring it with this particular restore job. Only the current restore job will assign that 
file the new name. When you create a new restore job, you will see the file displayed 
with its original name. Similarly, the Database tab always displays files with the names 
they had when they were backed up. 
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Other Tips 

Here are two additional tips for transferring files between operating systems and for 
setting up an autoloader for cleaning. 

Moving Data Between Operating Systems 
Clear the Native data streams check box in the Advanced Options window. 

Suppose you want to transfer data (files and folders) from one operating system to 
another, such as from a NetWare platform to a Windows platform. To do so, you need to 
backup and restore the data in a generic format. 

Different networks transmit data to TapeWare in different formats. In particular, 
Windows, NetWare, Linux and UNIX all use different data stream formats. If you are 
going to share data from one network platform with another, the data should be stored on 
media in a common data format, not in the native data streams format. 

To back up data in a generic format, first create a new backup job and select the data you 
want to transfer between operating systems. Then open the Advanced Options window 
and clear the Native data streams format check box. When TapeWare backs up this 
data, it will convert it to a generic format before writing it to the media. 

To transfer files 
between operating 
systems, clear the 

Native data streams 
format option on the 

backup job. 

 

Warning  Security is an issue to consider when checking this option. When this option is 
checked, TapeWare backs up all security information that network software includes in 
the data stream. If the option is unchecked, TapeWare uses a generic format that removes 
security information. 

After the job has completed, create a restore job, selecting the same files to restore. Make 
certain you have selected the proper instances of these files by selecting the proper 
instance date in the Instances window. You can then restore the files to a different 
operating system. 

For more 
information on 
native data 
streams, see 
Native Data 
Streams 
Format in 
Chapter 7 — 
Job Options. 
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Setting Up an Autoloader for Automatic Cleaning 
Insert a cleaning cartridge into the autoloader and then change the status of the storage 
slot. 

Depending on the model and manufacturer, some autoloaders support automatic cleaning 
cycles. They will alert TapeWare when a cleaning cycle needs to be performed. If 
TapeWare knows that a particular storage slot on an autoloader magazine holds a 
cleaning cartridge, TapeWare will automatically run a cleaning cycle before running a 
backup job whenever a cleaning cycle is required. 

To set up an autoloader for automatic cleaning, insert the cleaning cartridge into the 
autoloader magazine. Then open the Status tab of the autoloader and change the status of 
the slot that holds the cleaning cartridge. Select the storage slot and then click the 
Change Status button. In the Change Status window, change the storage status to 
Clean. TapeWare will automatically use the cartridge in this slot when performing a 
cleaning cycle. 

To manually clean an autoloader, highlight the device and select Clean Device… from 
the Device menu. Alternatively, open the autoloader’s Status tab and select the device 
you want to clean. TapeWare will check to see if one of the slots holds a cleaning 
cartridge. If it does, the cleaning cycle will be performed in the background; if not, an 
error message is shown. 

If you are using a device that is not an autoloader, you must manually clean the device at 
the manufacturer’s suggested intervals. 

 

For more 
information on 
setting up a 
cleaning 
cartridge on an 
autoloader, see 
Status Tab in 
Chapter 12 — 
Object and 
Property 
Reference. 
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Chapter 11 — Advanced Permissions and 
Security 

This chapter provides a detailed summary of TapeWare’s extensive security system. If it 
is your responsibility to manage the security of your TapeWare storage management 
database and you are working with sensitive data, this chapter can help you set up a 
complex security system that meets your particular security needs. 

In This Chapter 

• Overview 

• Adding New Users and Groups 

• Effective Permissions 

• Permissions Reference 

Overview 

Permissions control what actions a user is allowed to perform within a given storage 
management zone. Users can be given extensive or limited permissions, allowing the 
TapeWare administrator to distribute backup duties to various users and workgroups. 
This allows for a flexible, non-centralized backup system while providing the highest 
degree of security for the network. 

How your security is arranged depends on your unique security needs. Before setting up 
your security system, consider the following questions: 

• Is more than one storage management zone required? 

Setting up separate storage management zones can provide a high level of security. If 
your security needs require that access to some data be strictly limited, setting up a 
separate storage management database is often the simplest way to achieve this. 
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Data cannot be shared between zones without using advanced procedures. Media 
from one storage management database must be imported into a new database before 
the data on it can be read or used. When it is imported, TapeWare requires the media 
password, if set. If you assigned the media a password when it was created, the media 
cannot be imported without that password. 

If you do not assign the media a password, the media can be easily imported into any 
storage management database. As a result, the data is actually less secure when there 
are two or more databases than it would be with just one database. If you are relying 
on multiple storage management databases for security purposes, make sure that each 
created media is assigned a password. 

There may be, however, some limitations on the number of storage management 
databases you can set up. In particular, machines (workstations and file servers) can 
only be an object in one storage management database. Similarly, volumes can only 
belong to one storage management zone. Files in one storage management zone 
cannot, without importing the media, be shared with database objects in other storage 
management zones. 

Thus your ability to set up separate storage management zones is limited by the 
number of backup devices you have and their respective locations on separate 
machines. For example, to set up two storage management databases, you would 
require at least two separate workstations or file servers, each with at least one 
backup device. 

• Within a single storage management zone, must some users be prevented access to 
some data? 

Multiple workgroups may share a single tape drive or backup device and thus are 
members of the same storage management zone. However, there may be reasons to 
allow these groups to work with only their own data. For example, an accounting 
workgroup may share a common tape drive with a personnel workgroup, although 
neither can be allowed access to the files and directories of the other group. 

The security needs of these situations can be addressed by carefully assigning 
permissions, particularly to the machines, backup devices, media, volumes and 
directories. 

• Should access to certain functions be limited? 

You may wish to distribute certain backup tasks to various users or workgroups. For 
example, each workgroup might be responsible for their own daily backup jobs and 
archive jobs. On the other hand, access to certain TapeWare features may need to be 
limited. Users might be able to create tapes, for example, but not restore files to disk 
or delete files on disk. Alternatively, you may want users to run jobs you create, but 
not create their own jobs. 
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The security needs of these situations can be addressed by carefully assigning users 
select permissions to various objects in the database. For example, you might assign 
permission to write files to tapes, but not to volumes, thus preventing restore jobs 
from running. 

Before Proceeding Further 
The most powerful user in any storage management database is the TapeWare 
administrator. Because TapeWare administrators are granted supervisor rights to the 
System Container, they have unlimited access to all of the objects in the storage 
management database. Any user who logs on as the TapeWare administrator will have 
complete access to all of the files and machines on the storage management database. 

Warning  TapeWare administrators have unlimited access to all of the objects in the 
database. Any user who logs on as the TapeWare administrator will have complete access 
to all of the files and machines on the database. 

Your first security step should be to change the TapeWare administrator’s password. 
Click on the Security tab. Select the Admin user object. Select Change Password… 
from the Security menu. Type in the new administrator’s password, enter it again to 
confirm and click OK. Do not continue until you have changed this password. 

The only difference between the TapeWare administrator (Admin) and other users is that 
the TapeWare administrator has Supervisor rights to the root object in the TapeWare 
hierarchy, that is, the System Container. You may also create additional TapeWare 
administrators as well as rename the Admin user. 

Warning  Do NOT delete Admin unless you assign Supervisor or Access permission to 
the System Container to another user. 

Adding New Users and Groups 

Generally, the first step to arranging the security system is to set up users and groups. 
You create new users and groups on the Security tab of the main TapeWare window. Use 
the New Object… option from the File menu, the New Object button or the shortcut 
(right-click) menu to create new users and groups. 
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New User/Group Folders 
Each time you add a new user or group object to the Security tab, TapeWare 
automatically creates a new User/Group folder in the Home folder with the same name as 
the new user or group. For example, if you create a new user named Galen Clark, 
TapeWare creates a new User/Group folder named Galen Clark Folder. 

The user or group is automatically assigned six permissions to their User/Group folder: 
Access, Create, Modify, Delete, Write and Read. You can modify these permissions at 
any time using the Permissions tab of the new user or group property sheet. 

Setting Up Users 
As you create new users, TapeWare automatically opens the property sheet of the new 
user. Use the tabs on the property sheet to control the user’s password, account activity, 
group membership, equivalencies and permissions. 

To Create a New User 
1. Click the Security tab. 

2. Create the new user by either 

• Selecting New Object… from the File menu and then selecting User Object 
from the New Object window, or 

• Right-clicking in the TapeWare object detail area and selecting New User 
Object from the shortcut menu, or 

• Clicking the New Object button on the toolbar and then selecting User Object 
from the New Object window. 

3. Type in the new user’s name in the Name field on the General tab. 

Logon Control Tab, User Object 
The Logon Control tab controls whether passwords are required, whether and when the 
password must be changed, whether an account has expired and the number of 
connections a user can have to the network. 

 
New Object  
button 
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Logon 
Control tab 

 
Expiration  A user account can expire on a given date. When the account expires, 
TapeWare disables the account and checks the Account is disabled box. This user will 
be unable to log on until the Account is disabled box is cleared. 

You can manually disable an account by checking the Account is disabled box. 

To make a disabled account active again, clear the Account is disabled box and change 
the Date account expires. 

Connection  These parameters control the allowable machines and simultaneous logons 
for a user. 

The Number of concurrent connections parameter controls how many different logons 
a user may have simultaneously from different machines. For example, if the Number of 
concurrent connections is set to 5, this user can log on to TapeWare from up to five 
separate machines at the same time. 

The user can only log on to TapeWare on the machines listed in the User can log on 
from these machines field. To add a machine, click Add… and select the machine from 
the Browse window. To remove a machine, select it and click Delete. 

Note  If no machine is listed, a user can log on from any machine. 
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Grace Logons  When Grace Logons is checked, a user can log on to TapeWare a set 
number of times after their old password has expired. For example, if the Grace logons 
allowed box is checked and Remaining grace logons is set to 2, the user will be allowed 
to log on two times after their old password has expired. On the third logon attempt, the 
user must change their password. 

Note  Grace logons do not function when passwords are not required, that is, when the 
Require password check box is cleared. 

Password  When Require password is checked, TapeWare requires the user to have a 
password. 

The minimum length of the password is determined by the Minimum password length 
parameter. 

Note  If you clear the Require password box and the user has a password, TapeWare will 
continue to require that user to input their password. 

If you check the Require unique passwords box, TapeWare only accepts the new 
password if you have never used it. 

If you check the Force periodic password changes box, either the user or the TapeWare 
administrator must change the password per the Days between forced changes and Date 
password expires settings. 

If you check the Allow user to change password box, the user can change their 
password on their own. 

Tip  The TapeWare administrator can change a user’s password without knowing the 
user’s current password. TapeWare does not even ask you to enter the old password. This 
is useful when the user has forgotten his or her password. 

Groups Tab, User Object 
Use this tab to add or remove a user from a group. To add a user to a new group, select 
the group in the right window pane and click the Add button; the group is moved to the 
left window pane. Similarly, to remove a user from a group, select the group in the left 
window pane and then click the Remove button. 
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The left side of the 
Groups tab lists the 
groups of which this 

user is a member. 

The right side of the 
Groups tab lists the 
groups of which this 

user is not a member. 

To add or remove the 
user from a group, 

select the group and 
then click the 

appropriate button.  
Everyone group  When a new user is created, they are automatically added to the 
Everyone group. Members of this group have Modify, Delete, Create, Write and Read 
permissions to the Everyone Folder. You can modify these permissions at any time, 
including from the Permissions tab of the new user’s property sheet. 

Equivalencies 
One quick way to assign user permissions is to make the current user equivalent to 
another user. This can be very useful for managing complex TapeWare installations with 
multiple users and varying security or for making temporary changes to a user’s 
permissions. 

Use this tab to make the current user equivalent to another user. To make the current user 
equivalent to another user, select the other user in the right window pane and click the 
Add button; the user is moved to the left window pane. Similarly, to end an equivalency, 
select the other user in the right window pane and then click the Remove button. 
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The left side of the 
Equivalencies tab 
shows other users 

who are equivalent to 
the current user. 

The right side of the 
Equivalencies tab 

shows users who are 
not equivalent to the 

current user. 

To create new 
equivalencies or end 

old equivalencies, 
select the user and 

click the appropriate 
button.  

Note that equivalencies only work in one direction; they are not reciprocal. The current 
effective permissions of the user whose property sheet is open will be calculated using 
the direct and inherited permissions of the user they are made equivalent to. For example, 
if a user named Galen Clark is made equivalent to a user named Stephen Mather, Clark’s 
effective permissions are calculated using both Mather’s and Clark’s direct permissions. 
However, Mather’s effective permissions remain unchanged. 

Permissions Tab, User Object 
Use this tab to grant users permissions to objects in the storage management database. 
The Permissions check boxes show the permissions of whatever object is selected in the 
Objects to which this user or group has permissions list. Select another object to see 
the user’s permissions to that object. 
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You can see the 
permissions of the 

user to an object by 
selecting and 

highlighting that 
object. To change the 
permissions, clear or 

check the appropriate 
boxes. 

To grant the user 
permissions to a new 

object, click the Add… 
button… 

… select the object in 
the Browse window 

and then set the 
appropriate 

permissions. 
 

Note that permissions can be granted from either the property sheet of the database object 
or the property sheet of the user. Either way, the permissions appear on the appropriate 
corresponding object’s Permissions tab. For example, if Galen Clark is granted 
permissions to the C: volume from the Permissions tab on his property sheet, the 
Permissions tab on the property sheet of the C: volume will list Clark as a user who has 
permissions. Alternatively, if Clark is granted permissions from the property sheet of the 
C: volume, the appropriate permissions will appear on Clark’s Permissions tab. 

When you grant a 
user permissions 

to an object… 

…that object will then 
show that user on its 

Permissions tab. 
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Note additionally that a user has direct permissions only to those objects listed on that 
user’s Permissions tab. Any and all other effective permissions to other objects are 
calculated through inherited permissions, through equivalencies or through groups. 

Setting Up Groups 
As you create new groups, TapeWare automatically opens the property sheet of the new 
group. Use the tabs on the property sheet to assign members to the group and assign 
permissions to the group. 

To Create a New Group 
1. Click the Security tab. 

2. Create the new group by either 

• Selecting New Object… from the File menu and then selecting Group Object 
from the New Object window, or 

• Right-clicking in the TapeWare object detail area and selecting New Group 
Object from the shortcut menu, or 

• Clicking the New Object button on the toolbar and then selecting Group Object 
from the New Object window. 

3. Type in the new group’s name in the Name field on the General tab. 

Members Tab 
Use the Members tab of the group’s property sheet to add and remove users from the 
group. To add a user to the group, select the user in the right window pane and click the 
Add button; the user is moved to the left window pane, under Members who belong to 
this group. To remove a user from a group, select the user in the left window pane and 
click the Remove button; the user is moved to the right window pane, under Members 
who do not belong to this group. 

 
New Object  
button 
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The left side of the 
Members tab shows 

users who are members 
of this group. 

The right side of the 
Members tab shows 

users who are not 
members of this group. 

To add or remove users 
from the group, select 
and highlight the user 

and then click the 
appropriate button. 

 

Permissions Tab, Group Object 
If a user is a member of a group, that user’s effective permissions are determined using 
the direct permissions that group has to objects in the storage management database. Use 
this tab to assign the group permissions to objects. The Permissions check boxes show 
the permissions of whatever object is selected in the Objects to which this user or 
group has permissions list. Select another object to see the group’s permissions to that 
object. 

Note that the permissions granted from this tab, like all permissions, are reciprocal. 
Changes made on this tab appear on the tabs of the corresponding object. For example, if 
you grant permission to a folder to a group, the Permissions tab of that folder will list the 
group, along with the appropriate corresponding permissions. 

Effective Permissions 

TapeWare ensures the security of the storage management database and network by 
calculating the effective permissions a user has to an object and using these permissions 
to determine what actions that user can perform. 

The current user’s effective permissions to an object are displayed on the General tab of 
the object’s property sheet. The Effective permissions box shows the current user’s 
effective permissions to the object. 
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The current user’s 
effective permissions 

to an object are shown 
on the General tab of 

that object. 

 

Calculating Effective Permissions 
A user is assigned effective permissions to an object in one of two ways, either through 
direct permissions or through inherited permissions. 

A user has direct permissions to an object if they are listed on the Permissions tab of the 
object, if they are equivalent to a user who has direct permissions to the object; or if they 
are a member of a group that is listed on the Permissions tab of that object. Note that a 
user can gain permissions from any combination of these. 

A user has inherited permissions to an object if (1) they do not have direct permission 
and (2) they have effective permissions to the container that contains the object. This 
means that, if you do not have direct permissions to an object, you must have effective 
permissions to the container in which the object is stored. 

Note  Your effective permissions to the container object can be either direct or inherited 
permissions. All that matters is that you have effective permissions to the container. 

When TapeWare determines the effective permissions a user has to an object, it first 
looks to see if the user has direct permission; if not, TapeWare then checks to see if the 
user has inherited permission. 

Effective Permissions Algorithm 
TapeWare uses the following algorithm to determine effective permissions: 

• Does the user have direct permissions to the object? If yes, these are used to calculate 
the effective permissions. TapeWare does not check to see if the user has inherited 
permissions. 
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• Does the user have effective permissions to the container that contains the current 
object (inherited permissions)? If yes, these permissions are used to calculate the 
effective permissions. If not, then the user does not have effective permissions to the 
object. 

Permissions from Multiple Sources 
Users can gain direct permissions to objects either as users, as a result of equivalencies or 
as members of a group. When the direct permissions result from multiple sources, 
TapeWare uses all of the sources to determine the permissions. 

Consider the following example: Galen Clark has direct permissions to Read and Write 
to a folder called Conservationist Archive Jobs; Clark is also a member of a group that 
has direct permissions to Modify to the folder. As a result, Clark’s effective permissions 
are Read, Write and Modify. 
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Examples of Effective Permissions 
The following six examples illustrate how effective permissions are calculated. The 
diagram below illustrates these six examples. 
 

System Container 
ADMIN [SACMDRW] 

Home 
(No Direct Permissions) 

Admin Folder 
(No Direct Permissions) 

Clark’s Folder 
Clark [-ACMDRW] 

Mather’s Folder 
Mather [-ACMDRW] 

Conservationist Folder 
Conservationist Group [--CMDRW]

Conservationist Media Folder 
Mather [------W] 

Network 
(No Direct Permissions) 

Machine 
Clark [-----RW] 

Backup Device 
(No Direct Permissions) 

Volume 
Clark [-----R-] 
Mather [--C--RW] 
Conservationist Group [--CMDRW]  

1. The TapeWare administrator has direct permissions to the System Container, the 
object at the very top of the storage management database hierarchy. These determine 
his or her effective permissions to this object. Because it is a container, the objects 
below it in the storage management database all have inherited permissions because 
the object directly above them has effective permissions. So, for example, the 
TapeWare administrator has effective permissions to the Home Folder because it 
inherits its permissions from the object that contains it, the System Container. Thus, 
the TapeWare administrator has effective permissions to all of the objects in the 
storage management database. 
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2. A user named Stephen Mather has direct permissions to his User/Group folder, 
named Mather’s Folder. As a result, by inherited permission, Mather has effective 
permissions to the objects stored in this folder, including any jobs, media or job 
folders stored in this folder. Mather does not, however, have effective permissions to 
the Home Folder or to the System Container—these objects are above his 
User/Group folder and thus do not inherit permissions. 

3. A user named Galen Clark has direct permissions to a Machine, in this case a file 
server with an attached tape drive and several associated disk drives. The direct 
permissions to the file server mean that Clark also has effective permissions (by 
inheritance) to the tape drive. So, for example, Clark might be given read and write 
permissions to the file server and thus to the tape drive. 

However, Clark is prevented from having permissions to the volumes on the file 
server. He is listed on the Permissions tab of the volume and these direct permissions 
are used to deny him access to the volume. In this example, he is granted Read 
permission by checking that box, but denied Write permissions by clearing the 
appropriate box. 

Thus even though Clark has effective permissions to the container that contains the 
volume, Clark’s effective permissions to the volume are determined only by his direct 
permissions to the volume. Because Clark has direct permissions, TapeWare does not 
check to see if Clark has inherited permissions. 

4. The following example is more complex, but illustrates an important concept: that 
TapeWare does not check for inherited permissions when there are direct 
permissions. 

A user named Stephen Mather is a member of the Conservationist group, which has 
five direct permissions to the Conservationist Folder: Create, Modify, Delete, Write 
and Read permissions. Mather also has direct permissions to the Conservationist 
Media Folder, but only Write permission. 

Mather has five effective permissions to objects contained in the Conservationist 
Folder, but not to the Conservationist Media Folder, where he has only one (Write 
permission). TapeWare does not look to see if Mather has effective permissions to 
the container that contains the Conservationist Media Folder because Mather has 
direct permissions to that object. Thus even though other members of the 
Conservationist group have effective permissions to the Conservationist Media 
Folder through inherited permissions, Mather will not. Mather will have only Write 
permissions to this folder. 

5. The following example shows how equivalencies and group membership work 
together to determine effective permissions. 
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Suppose that Mather is a member of the Conservationist group and that he is made 
equivalent to Clark. What permissions will Mather have? 

Mather has permissions to all of the User/Group folders, except the Admin Folder. 
For example, he has permissions to Clark’s Folder because he is equivalent to Clark. 
(Note that this equivalency does not give Clark permission to Mather’s Folder.) 
Mather also has the same permissions to the Machine and Tape Drive that Clark 
does. 

However, Mather’s permissions to the Volume are different from Clark’s. Mather 
has direct permission to the Volume in three ways: as a user, as a member of the 
Conservationist group and as a result of his equivalency to Clark. When TapeWare 
calculates his effective permissions, it uses these direct permissions from all three 
sources. In this case, Mather will have five permissions (Create, Modify, Delete, 
Write and Read). 

Note that it does not matter that Mather’s own direct permissions as a user do not 
include Create and Modify permissions. TapeWare uses all three sources to 
determine Mather’s effective permissions to the volume. In this case, Mather’s 
membership in the Conservationist group grants him Create and Modify 
permissions. 

6. Given the above example, suppose we wanted to deny Mather all permissions to the 
Volume. How could this be accomplished? 

To deny Mather all permissions to the Volume, three things must happen: Mather’s 
equivalency to Clark must end; Mather’s membership in the Conservationist group 
must end; and Mather’s direct permissions must be changed so that Mather is listed 
on the Permissions tab of the Volume but no permission boxes are checked. 

Note that listing Mather on the Permissions tab and clearing the permissions check 
boxes is not enough to deny Mather permissions to the tab. Mather must no longer be 
equivalent to Clark and Mather must no longer be a member of the Conservationist 
group. 

Checking Effective Permissions 
On complex installations with multiple users and groups and varying levels of security, a 
particular user’s effective permissions can be difficult to identify. The easiest way to 
identify a user’s effective permissions is to log on as that user. 

If you have not yet assigned the user a password, simply log on as the user. Browse the 
various General tabs of the objects in the storage management database. Verify that the 
displayed effective permissions match your intended security measures. 
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If the user has a password and you do not know it, create an “alias” user and make it 
equivalent to the user whose permissions you wish to check. Then log on as the alias 
user. Be certain to delete both the alias user and its folder after verifying the effective 
permissions. 

Permissions Reference 

There are seven permissions: Read, Write, Delete, Modify, Create, Access and 
Supervisor. These permissions affect different objects in the TapeWare storage 
management database differently. Even though a particular permission may not apply 
directly to that object, objects below it in the storage management database hierarchy can 
still inherit permissions from that object. 
 System Container 
 Home Folder 
  User Group Folder 
   Backup Job 
   Restore Job 
   Verify Job 
   Media  
   Job Folder 
    Job Folder 
    Backup Job 
    Restore Job 
    Verify Job 
   Media Folder 
    Media Folder 
    Media 
 Network Container 
  Machine 
   [Drivers] 
   Controller 
    Device 
    Autoloader 
   Volume 
    File 
    Directory 
     Directory 
     File 
 Security Container 
  User Object 
  Group Object 

Bold = Container 
Italic = Container 

stored in 
container of 
same type 
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Read Permission 
Affected Objects  Media, controller, device, autoloader, volume, directory, file, storage 
management database. 

Description  Controls whether a user can read from a given storage management database 
object. 

In the case of physical peripherals that perform read functions, such as controllers, 
devices, autoloaders and volumes, Read permission to the peripheral is required in order 
for TapeWare to instruct the peripheral to read files or directories. 

In case of storage management database objects that hold data, such as media, volumes, 
directories and files, Read permission is required to read the data these objects contain. 

Affected Commands  Copy, Run (job type), Rewind, Start, Eject Media, Eject Magazine, 
Retension, Restore Database, Clean Device, Identify Media, Import Media, Restore 
Database. 

This permission enables Copy (but not Paste), allowing the user to copy objects in the 
storage management database. 

Read permission is also required to run jobs. Backup jobs require Read permission to the 
appropriate volumes, directories and files. Restore jobs require Read permission to the 
appropriate devices, autoloaders and media. Verify jobs require Read permission to all of 
these objects. 

Many commands that perform utility functions, such as Clean Device or Eject Media on 
a device, require Read permission. Device commands that also read media in backup 
devices require this permission. 

Write Permission 
Affected Objects  Media, device, autoloader, volume, directory, file, storage management 
database. 

Description  Controls whether a user can write to a given storage management database 
object. 

In the case of physical peripherals that perform write functions, such as controllers, 
devices, autoloaders and volumes, Write permission to the peripheral is required in order 
for TapeWare to instruct the peripheral to write files or directories. 

In the case of storage management database objects that hold data, such as media, 
volumes, directories and files, Write permission is required to write data to these objects. 

Affected Commands  Run (job type). 
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Write permission is also required to run jobs. Backup jobs require Write permission to 
the appropriate devices, autoloaders and media. Restore jobs require Write permission to 
the appropriate volumes, directories and files. 

Delete Permission 
Affected Objects  Media, device, autoloader, volume, directory, file, storage management 
database. 

Description  Controls whether a user can delete storage management database objects or 
perform delete functions. 

In the case of physical peripherals that perform delete functions including overwrite 
functions, such as controllers, devices, autoloaders and volumes, Delete permission to the 
peripheral is required in order for TapeWare to instruct the peripheral to delete or 
overwrite files or directories. 

In case of database objects that hold data, such as media, volumes, directories and files, 
Delete permission is required to delete or overwrite the data contained in these objects. 

Affected Commands  Delete, Run (job type). 

This permission enables Delete, allowing the user to delete objects in the storage 
management database. 

Delete permission is also required for some types of jobs. Backup jobs require Delete 
permission to the appropriate devices, autoloaders and media whenever files are 
overwritten or media are formatted. Restore jobs require Delete permission to the 
appropriate volumes, directories and files whenever the files are overwritten. 

Modify Permission 
Affected Objects All storage management database objects. 

Affected Property Sheet Tabs  General, Selection, Options, Schedule, Logs, Storage, 
machine diagnostic tabs. 

Description  Controls whether a user can change the name of an object, modify the 
specified tabs on an object’s property sheet or move an object to a new location in the 
storage management database. 

For any object, Modify permission allows the user to change the object’s General tab. 
(This affects only the name of the object.) 

For backup, restore and verify jobs, Modify permission to the job allows the user to 
change the job’s Selection, Options, Schedule and Logs tabs. Note that Read 
permission to the volume is required in order to select the volume’s files and directories 
on the Selection tab. 
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For machines, controllers and volumes, Modify permission allows the user to modify the 
diagnostic tabs, such as Communication Test and Ping Test. 

Affected Commands  Move…, Rename. 

This permission enables Move… and Rename, allowing users to move objects in the 
storage management database and rename them. 

Create Permission 
Affected Objects  Home folder, user/group folder, job folder, media folder, restore job. 

Description  Controls whether a user can create new objects within a container object. 

For the Home folder, Create permission is required in order to create new User/Group 
folders. 

For User/Group folders, Create permission is required in order to create new job folders, 
backup jobs, restore jobs, verify jobs, media folders and media. 

For Job folders, Create permission is required in order to create new job folders, backup 
jobs, restore jobs and verify jobs. 

For Media folders, Create permission is required in order to create new Media folders 
and media. 

For Restore Jobs, jobs that restore files in new locations or with new names require 
Create permission to the appropriate machines, volumes and directories. 

Affected Commands  New…Job, New…Folder, New Object…, Paste. 

This permission enables the New…Job and New…Folder commands, for each type of 
job and folder. This permission also enables the New Object… command on the File 
menu. 

This permission enables Paste, allowing the user to paste objects in the storage 
management database. 

Access Permission 
Affected Objects  All storage management database objects, except Security Container, 
User Object and Group Object. 

Affected Property Sheet Tabs  Permissions. 

Description  Controls whether a user can see and modify the Permissions tab of an object. 
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For any object, Access permission allows the user to change the permissions to the 
object. To add a new user to the Permissions tab, Modify permission is also required. A 
user listed on the Permissions tab can be deleted with Access permission alone. 

Note that Access permission does not allow the user to change the Permissions tab on 
the Security Container, a User Object or a Group Object. 

Supervisor Permission 
Affected Objects  All storage management database objects. 

Affected Property Sheet Tabs  Logon Control, Equivalencies, Groups, Members, 
Permissions. 

Description  This permission gives the user unlimited permissions to the object and all 
objects below it in the storage management database. Additionally, only a user with 
Supervisor permission to the Security Container can create new users and groups. 

When a user has Supervisor permission to an object, the user is automatically granted all 
seven permissions to the object. Furthermore, the user cannot be denied any permission 
to any object below it in the hierarchy, even by assigning that user direct permission. As 
a result, a user with Supervisor permission to an object will have all permissions to the 
object and every object below it in the storage management database tree. 

Supervisor permission to the Security Container is required to create new users and 
groups. Additionally, the Logon Control, Groups, Equivalencies, Email, Autoprint 
and Members tabs are only available to users with Supervisor permission to the Security 
Container. 

Normally, only the TapeWare administrator has Supervisor permission to the System 
Container. 

Affected Commands  New User, New Group 

This permission enables the New User and New Group commands, allowing the user to 
create new users and groups. 
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Chapter 12 — Objects and Properties Reference 

This chapter provides reference details for every object and property in the TapeWare 
database. It is organized alphabetically according to the name of each property sheet tab. 
The property sheet tab name appears at the beginning of each entry and in the page 
header. The applicable objects for each property tab are listed under the Applicable 
Objects heading. Various fields and parameters on each property sheet tab are indicated 
by bold headings, followed by a short description. List box choices and field parameters 
are indicated by bold in-line headings. 

In addition to the property sheet tabs, this chapter provides reference information for the 
Instances, Preferences, Query and Selection Filters windows. 
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Address Tab 

Applicable Objects  Machine 

The Address tab shows the machine object’s network address. 

Address 
tab  

Protocol  This field shows either Ipx or UDP, depending on your network operating 
system. If this is a standalone machine, it shows Local. 

Net Address  This field shows the machine address used by the network operating system. 
If this is a standalone machine, it shows Local. 
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Audit Tab 

Applicable Objects  File, Directory, Volume 

The Audit tab shows the audit log for the object. It appears on the property sheet of an 
object that has been audit enabled. 

Audit tab  
To enable an object’s audit log, open the Storage tab of the object and change the Audit 
object actions setting to Audit enable. 

When audit is enabled, TapeWare enters into that object’s log a record every action 
performed on that object. For example, there will be an entry each time the object is 
backed up or restored. Additionally, the audit log will show the media on which instances 
of the object are stored. 

Clear  Click to erase all audit log entries. 

Print  Click to print the audit log. Note that some logs can be quite long; check the length 
of the document before printing it. 

Save  Click to save the audit log as a text file. 

For more information on… See… 

Using audit logs Audit Logs, Chapter 8 — Running Jobs 
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Autoprint Tab 

Applicable Objects  User Object, Group Object 

The Autoprint tab shows the print settings to use when automatically printing a job log. 

Autoprint tab  
The Autoprint tab appears on the property sheet of a user or group object. When the 
Autoprint log option is selected on the Advanced Options window for a job, the job log 
prints automatically as soon as the job is complete. It prints to the printer specified on the 
Autoprint tab for the job owner. 

For more information on… See… 

Job logs Job Logs, Chapter 8 — Running Jobs 

Autoprinting logs Autoprinting Job Logs, Chapter 8 — 
Running Jobs 

The Advanced Options window Advanced Options, Chapter 7 — Job 
Options 

Configuring autoprint for Windows NT (or 
later) 

Appendix G — Configuring Autoprint for 
Windows, TapeWare Installation Guide 
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Command Tab 

Applicable Objects  Volume, Directory, File 

Use the Command tab to execute operating system commands before and after backup 
jobs. These commands can execute programs, batch files or scripts.  

The default path for these programs, batch files or scripts is the same as the path of the 
current object (e.g., the volume, directory or file whose property sheet is open). You can 
specify another path if necessary. 

Be sure that you enter commands appropriate to the operating system. On Windows 
systems, you can specify .exe and .bat files, such as c:\mybatch.bat. On NetWare 
systems, you can specify .ncf files, such as mybatch.ncf. On Linux and UNIX systems, 
you can specify shell scripts, such as myscript.sh. You can also specify any parameters 
with these commands, according to the operating system. 

Command 
tab  

For example, you may want to temporarily close certain files before backing up. You 
could prepare one batch file to close these files and one to open these files after a 
successful backup. You could also prepare a batch file to execute if the backup job fails. 
Then you would enter these commands in the appropriate fields. 
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Note  If a command takes more than 15 seconds to execute, TapeWare continues the job. 
This is a precaution in case the command fails in some way, which would prevent 
TapeWare from continuing. If the command must be run, we recommend that you assign 
it to the next object up in the tree view. 

Command to execute before backup  TapeWare executes this command before it opens the 
current object for backup. Enter the command with its path (if necessary) and any 
parameters. 

Command to execute after successful backup  TapeWare executes this command after it 
has successfully backed up and closed the current object. Enter the command with its 
path (if necessary) and any parameters. 

Note  If the backup job includes a verify step, TapeWare executes this command if the 
current object was backed up successfully. TapeWare closes the object and executes this 
command. Then it performs the verify step. 

Command to execute after failed backup  TapeWare executes this command after it closes 
the current object if the backup fails. Enter the command with its path (if necessary) and 
any parameters. 

Note  If the backup job includes a verify step, TapeWare executes this command if the 
backup of the current object fails. TapeWare closes the object and executes this 
command. Then it performs the verify step. 
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Communication Test Tab 

Applicable Objects  Machine 

Use the Communication Test tab to test the communication performance of the network. 
It can also be used to evaluate the ability to transfer data under optimum circumstances. 

Communication 
Test tab  

Running the Test 

Note  To accurately test network performance, stop the TapeWare service on the machine 
to be tested (see Appendix E — TapeWare Service in the TapeWare Installation Guide). 
Then start the TapeWare administrator and access the Communication Test tab. 

1. Configure the Transfer type parameter: 

Backup  Simulates data transfer during a backup job. The local machine sends a large 
packet; the remote machine sends small replies acknowledging receipt of the data. 

Restore  Simulates data transfer during a restore job. The remote machine sends a 
large packet; the local machine sends small replies acknowledging receipt of data. 

Large packet  Send a large-sized packet of data between remote and local machine. 

Medium packet  Send a medium-sized packet of data between remote and local 
machine. 
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Small packet  Send a small-sized packet of data between remote and local machine. 

2. Select With data checking to send a known byte pattern between machines. The 
receiving machine will verify the pattern. 

3. Click Start to begin the test. As the test runs, the Communication status fields 
reflect the results of the test. 

4. Click Stop to end the test. The final results appear in the Communication status 
fields. 

Test Results 
The Communication status fields display the test results: 

Packet No.  This is the number of data packets sent from one machine to another up to this 
point in the test. 

Transfer rate (KBytes/sec)  The rate at which the test data packets are being transferred in 
kilobytes per second. 

Transfer rate (MBytes/min)  The rate at which the test data packets are being transferred in 
megabytes per minute. 

No. of ACKs sent  The number of network ACKs (acknowledgments) sent between 
machines. 

No. of NACKs sent  The number of network ACKs (negative acknowledgments) sent 
between machines. 

No. of timeouts  The number of communication errors encountered. This only occurs if a 
machine on the network fails to respond in timely fashion. 

Note  Use this information to identify current transfer rates between machines. If the rates 
are less than expected, try one or more TapeWare optimization strategies. 

For more information on… See… 

Optimizing backup jobs by increasing data 
transfer rate 

Strategies for Faster Jobs, Chapter 10 — 
Tips, Techniques and Strategies 
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Connections Tab 

Applicable Objects  Machine 

The Connections tab shows the active connections for this machine. It is for information 
purposes only. 

Connections are established for varying purposes and are automatically opened and 
closed as necessary. 

Connections 
tab  

Active connections  Lists the currently active connections for this machine. 

Details  Shows detailed information about the selected active connection. 
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Diagnostics Tab 

Applicable Objects  Machine, Drivers 

The Diagnostics tab provides detailed information about the current machine or driver 
object. It is available for all active machines and drivers, including controllers, logical 
tape formats and services. It is for information purposes only. 

Diagnostics 
tab  
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Drivers Tab 

Applicable Objects  Machine 

The Drivers tab shows the available drivers for this machine. It provides users with a 
single view of all drivers associated with this machine. (The Drivers tab also appears on 
the Database tab in various locations.) It is for information purposes only. 

Drivers are used by TapeWare for differing purposes. The name of each folder on this tab 
indicates the purpose of the drivers in that folder. 

Drivers that are marked with a yellow exclamation point are currently unavailable for 
some reason. The device could be initializing or there may be an actual failure. For 
example, a controller driver may be marked with this icon during device initialization. 
Once initialized, the exclamation disappears when you press F5. When there is an actual 
failure, you must correct the problem and restart the driver. You must exit and restart 
TapeWare and the TapeWare service. When TapeWare restarts, it will reinitialize these 
devices. 

Drivers 
tab  
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Email Tab 

Applicable Objects  User Object 

The Email tab shows the email address to which logs of jobs will be emailed when that 
user is the owner of a job that runs. This tab only appears when the optional email 
package has been installed and configured. 

Email 
tab  

When email has been installed and configured, TapeWare will attempt to email the log of 
every job after it has run. The log is sent to the address listed on the Email tab for the job 
owner. 

You can enter multiple email addresses by separating each address with a semicolon (no 
additional spaces). 

The address entered here need not be the address of the user. For example, you can enter 
the TapeWare administrator’s address in this field for any or all users. 

For more information on… See… 

The owner of a job How Forcing Jobs to Run Affects 
Permissions, Chapter 8 — Running Jobs 

Installing and configuring email Appendix C — Configuring Email Options, 
TapeWare Installation Guide 

Using email to send job logs Emailing Job Logs, Chapter 8 — Running 
Jobs 
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Equivalencies Tab 

Applicable Objects  User Object 

The Equivalencies tab is used to assign an individual user effective permissions 
equivalent to the effective permissions of another user. 

Note that equivalencies only work in one direction; they are not reciprocal. The current 
user’s effective permissions (the effective permissions of the user whose property sheet is 
open) will be calculated using the direct and inherited permissions of the user they are 
made equivalent to. For example, if a user named Galen Clark is made equivalent to a 
user named Stephen Mather, Clark’s effective permissions are calculated using both 
Mather’s and Clark’s direct permissions. However, Mather’s effective permissions 
remained unchanged. 

Additionally, note that users can gain direct permissions to objects either as users, as a 
result of equivalencies or as members of a group. When the direct permissions result from 
multiple sources, TapeWare uses all of the sources to determine the permissions. 

Equivalencies 
tab 

 
Users to which this user is equivalent  Lists those users to whom the current user (whose 
property sheet is open) is equivalent. 

Users to which this user is not equivalent  Lists those users to whom the current user 
(whose property sheet is open) is not equivalent. 

Remove  To remove a user from the equivalent list, select the user from the left window 
pane and click Remove. The user is moved to the right window pane. 
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Add  To add a user to the equivalent list, select the user from the right window pane and 
click Add. The user is moved to the left window pane. 

For more information on… See… 

Calculating effective permissions Effective Permissions, Chapter 11 — 
Advanced Permissions and Security 

Examples of equivalencies Examples of Effective Permissions, Chapter 
11 — Advanced Permissions and Security 
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General Tab 

Applicable Objects  All objects 

The General tab shows information and object attributes stored in the TapeWare 
database for the current object. 

The data on this tab is taken from the TapeWare database. For files, directories and 
volumes, this data is regularly updated. Each time TapeWare opens a directory or 
volume, it updates it database with any new information about these files and directories. 

General 
tab  

Name  Shows the name of the current object. To change the name, select it and type in a 
new name. An object name can be up to 256 characters long. 

Type  Shows the type or category of object. There are 21 object types in the TapeWare 
database, plus drivers. The object names and their possible relationships to each other are 
illustrated below. 
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 System Container 
 Home Folder 
  User Group Folder 
   Backup Job 
   Restore Job 
   Verify Job 
   Media  
   Job Folder 
    Job Folder 
    Backup Job 
    Restore Job 
    Verify Job 
   Media Folder 
    Media Folder 
    Media 
 Network Container 
  Machine 
   [Drivers] 
   Controller 
    Device 
    Autoloader 
   Volume 
    File 
    Directory 
     Directory 
     File 
 Security Container 
  User Object 
  Group Object 

Bold = Container 
Italic = Container 

stored in 
container of 
same type 

 
Effective Permissions  Shows the effective permissions the current user has to this object. 
Note that these are the effective permissions, not the direct permissions. There are seven 
possible permissions, abbreviated as follows: 

Sup Supervisor 
Acc Access 
Cre Create 
Mod Modify 
Del Delete 
Rd Read 
Wt Write 

Attributes  Shows operating system attribute information about file or directory. The 
attribute information is taken from the operating system and is updated each time the 
directory that contains the file is opened. You can use this information to sort files with 
filters. 
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The attribute abbreviations are grouped as follows: 

Ro Read only 
Rw Read and write 
H Hidden 
Sy System 
X Execute only 
D Directory 
A Archive 
I Incremental 
D Differential 
E Encrypted 

Sh Share 
Tm Temporary 
T Transaction 
Ra Read audit 
Wa Write audit 
P Immediate purge 
Ri Rename inhibit 
Di Delete inhibit 
Ci Copy inhibit 
Dm Migrate inhibit 
Ds Sub-allocation inhibit 

Ic Immediate compression 
Dc Don’t compress 
Co Compressed 
Cc Can’t compress 
Mg Migrated 

Size  Shows operating system information about file or directory size. Information about 
the size of the file or directory is taken from the operating system and is updated each 
time the directory that contains the file is opened. You can use this information to sort 
files with filters. 

Last backup  Shows the date and time when this object was last backed up. You can use 
this information to sort files with filters. 

Created  Shows operating system information about date file or directory created. The 
create date is taken from the operating system and is updated each time the directory that 
contains the file is opened. You can use this information to sort files with filters. 
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Deleted  When a file that was previously backed up is deleted, TapeWare assigns it a 
delete date. When TapeWare opens a directory, it compares the files it finds with 
information about instances of files in its database. When an instance of the file is found 
in the database, but not in the directory, TapeWare assigns that instance a delete date. 

Modified  Shows operating system information about date file or directory last modified. 
The modify date is taken from the operating system and is updated each time the 
directory that contains the file is opened. You can use this information to sort files with 
filters. 

Accessed  Shows operating system information about the date the file or directory last 
accessed. The access date is taken from the operating system and is updated each time the 
directory that contains the file is opened. You can use this information to sort files with 
filters. 

For more information on… See… 

Calculating effective permissions Effective Permissions, Chapter 11 — 
Advanced Permissions and Security 

Sorting selected files according to object 
attributes 

Filter Selection Criteria, Chapter 5 — 
Selecting Files and Instances 
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Groups Tab 

Applicable Objects  User Object 

The Groups tab shows the groups to which the current user belongs. Use this tab to add 
or remove a user from a group. 

Groups 
tab  

Groups to which this user belongs  Shows the groups to which the current user belongs. 
To add the user to a new group, select the group in the right window pane and click the 
Add button; the group is moved to the left window pane. Similarly, to remove a user 
from a group, select the group from the left window pane and then click the Remove 
button. 

Everyone group  Normally, this group will be listed in this field. When created, new users 
are automatically added to the Everyone group. Members of this group have Modify, 
Delete, Create, Write and Read permissions to the Everyone Folder. You can remove a 
user from this group by selecting the Everyone group and then clicking remove. 

Groups to which this user does not belong  Shows the groups to which this user does not 
belong. 
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For more information on… See… 

Calculating effective permissions Effective Permissions, Chapter 11 — 
Advanced Permissions and Security 

Assigning members to groups Setting Up Users, Chapter 11 — Advanced 
Permissions and Security 
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Instances Window 

Open the Instances of… window by clicking the Check button on the toolbar of the 
Selection tab of either a restore or verify job. This window is used to select an instance of 
the object targeted on the Selection tab. 

Each time an object is backed up, an instance of that object is created. There may be 
multiple instances of objects stored on different media created by different backup jobs. 
TapeWare keeps track of all the instances of each object in its database and the media on 
which each instance is stored. When media is overwritten or deleted, TapeWare deletes 
those instances from its database as well. 

When you select an object for restoring, TapeWare initially selects the <Latest> 
instance. To select a different instance, use the Instances of… window. 

The <Latest> instance is a wildcard and automatically selects the most recent instance. 
Which instance is selected is updated as the restore or verify job is run. 

Instances 
window  

Available Instances 
Shows a list of the instances of the object and the media on which those instances are 
stored. 
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Backed up  Shows the date and time the job was run. All objects backed up during a 
single job will be listed with the same date and time. 

Status  Shows whether or not the object was verified when the job was run. It is either 
Verify complete, Verify failed or Not verified. 

Media  Shows the media on which the instance is stored. 

Select the instance to restore and click OK. 

Details 
Shows more information about whatever instance of an object is highlighted. When you 
click Details, TapeWare displays the following information about the object. Click No 
Details to close the Details window. 

Data size  Shows the size of the data fork for the selected object: 0 bytes for folders and 
directories; the size of each file. 

Backup date  The date and time this instance was created. 

Modify date  The last time the object was modified. This information is recorded from the 
operating system when the object is backed up. 

Physical stream id  Shows internal data used by TapeWare to manage the instance. 

Instance flags  Shows internal data used by TapeWare to manage the instance. 

Stream format  Shows what format the instance is recorded in. The stream format is 
controlled by the Advanced Options window. You can use this information to see if you 
can transfer the object from one operating system to another. Stream format can only be 
set when creating instances, not when restoring them. 

Compression type  Shows the compression setting on the Options tab for the backup job. 

Encryption type  (Reserved for future use.) 

Start position  Shows internal data used by TapeWare to manage the instance. 

Instance id  Shows internal data used by TapeWare to manage the instance. 

Object id  Shows internal data used by TapeWare to manage the instance. 
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For more information on… See… 

Selecting instances Selecting Instances of Files for Restore 
Jobs, Chapter 5 — Selecting Files and 
Instances 

Using filters to select instances Backup Range, Chapter 5 — Selecting Files 
and Instances 
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Loader Test Tab 

Applicable Objects  Autoloader 

The Loader Test tab lets you test the ability of the autoloader to load and unload media 
to the associated device. 

Click Start to begin the test. Click Stop to end the test. 

Loader 
Test tab  

Status  Shows an informational message about the current autoloader activity. 

Total Moves  Shows the total number of media loads and unloads performed during the 
current test. 
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Logon Control Tab 

Applicable Objects  User Object 

The Logon Control tab controls the ability of a user to log on to the current TapeWare 
database zone. Controls whether passwords are required, whether and when the password 
must be changed, whether an account has expired and the number of connections a user 
can have to the network. 

Logon 
Control tab  

Expiration 
Controls when the current account will expire. A user account can expire on a given date 
or can be disabled manually. 

Account is disabled  Checked when the account has expired. 

Date account expires  Specifies a date when the account will no longer be active. When 
the account expires, TapeWare disables the account and checks the Account is disabled 
box. This user will be unable to log on until the Account is disabled box is cleared. 

To make a disabled account active again, clear the Account is disabled box and change 
the Date account expires. 
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Connection 
Controls the allowable machines and simultaneous logons for a user. 

Number of concurrent connections  Controls how many different logons a user may have 
simultaneously from different machines. For example, if the Number of concurrent 
connections is set to 5, this user can log on to TapeWare from up to five separate 
machines at the same time. 

User can log on from these machines  Lists the machines from which a user can log on to 
TapeWare. The user cannot log on to TapeWare from any machine unless it is listed. To 
add machines, click Add… and select the appropriate machine from the Browse window. 
To remove machines, select the machine and click Delete. 

Note  If no machine is listed, a user can log on from any machine. 

Grace Logons 
Controls how many times a user can log on to TapeWare after their password has 
expired. For example, if the Allow grace logons box is checked and the Remaining 
grace logons is set to 2, the user will be allowed to log on two times after their old 
password has expired. On the third logon attempt, the user must change their password. 

Note  Grace logons do not function when passwords are not required, that is, when the 
Require password check box is cleared. 

Grace logons allowed  If checked, a user can log on after their old password has expired. 

Limit grace logons  Shows the maximum number of grace logons allowed. For example, if 
it is set to 2, the user can log on with an expired password two times. 

Remaining grace logons  Shows the number of remaining grace logons. TapeWare 
automatically adjusts this number each time the user logs on with expired password. You 
can also set this manually. 
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Password 
Controls whether a user must have a password to log on. 

Require password  When checked, TapeWare requires the user to have a password. 

Note  If you clear the Require password box and the user has a password, TapeWare will 
continue to require that user to input their password. 

Minimum password length  Specifies the minimum length of the password. 

Require unique passwords  If checked, TapeWare only accepts the new password if the 
user has not used it before. 

Force periodic password changes  If checked, either the user or the TapeWare 
administrator must change the password per the Days between forced changes and Date 
password expires settings. 

Days between forced changes  Specifies the interval between forced password changes. 

Date password expires  Calculated date of next password expiration, based on Days 
between forced changes parameter. 

Allow user to change password  If checked, the user can change their password on their 
own. 

Tip  The TapeWare administrator can change a user’s password without knowing the 
user’s current password. TapeWare does not even ask you to enter the old password. This 
is useful when the user has forgotten his or her password. 

For more information on… See… 

Setting up new users Setting Up Users, Chapter 11 — Advanced 
Permissions and Security 
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Logs Tab 

Applicable Objects  Backup Job, Restore Job, Verify Job 

The Logs tab shows the available logs for the current job. 

TapeWare creates a log for each job, according the Log option on the job’s Options tab 
After the job runs, you can view or print this log to see the files that were successfully or 
unsuccessfully backed up, restored or verified. 

Logs 
tab  

Logs for this object  Lists the available logs for this job. 

View  Select a log and click to open the file in the specified text editor. (Specify the text 
editor to use in the Preferences window.) You can print the log from the text editor. Note 
that some logs can be quite long; check the length of the document before printing it. 

Print  Select a log and click to print the log. Note that some logs can be quite long; check 
the length of the document before printing it. 

Delete  Select one or more logs and click to delete them. 

Note  The maximum number of logs per job is 64. TapeWare will overwrite the oldest log 
when you reach this maximum. 
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For more information on… See… 

Creating logs Log Option, Chapter 7 — Job Options 

Accessing and printing job log Job Logs, Chapter 8 — Running Jobs 

Specifying a text editor Preference Window, Chapter 12 — Object 
and Property Reference 
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Media Control Tab 

Applicable Objects  Media 

The Media Control tab shows information about the current media that TapeWare stores 
in its database. 

Media 
Control tab  

First format  Shows the date and time the current media was first formatted. 

Last format  Shows the date and time the current media was last formatted. 

Last read  Shows the date and time the current media was last read. Matches the last time 
files were read for either a restore or verify job or the verify pass of a backup job. 

MBytes read  Shows the total number of megabytes read during the last verify or restore 
job. 

Count read  Shows the total number of times this media has been read. This number is not 
reset when the media is overwritten. 

Last write  Shows the date and time the current media was last written to. Matches the last 
time files were written to the media during a backup job. 

MBytes written  Shows the total amount of data written in megabytes to this media over 
the life of the media. 

Count written  Shows the total number of times this media has been written to. This 
number is not reset when the media is overwritten. 
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Number of sessions  Shows the number of jobs this media has been used with. This 
number is reset each time the media is overwritten. In general, this number is the number 
of backup jobs currently stored on the media, including the first overwrite job and 
subsequent append jobs. 

Current KBytes  Shows the amount of data written to this media during the last backup 
job in Kbytes. This number is reset when the tape is overwritten. 

Media identifier  Shows the unique number used internally by TapeWare to track the 
media in the database. 

Media volume tag  Shows the volume tag for the physical media. In general, this number 
equals the bar code number on the media. Used by devices with optical readers to identify 
media. This is only available for media used with devices that support volume tags. 

For more information on… See… 

Formatting media Creating New Media, Chapter 9 — Media, 
Device and Database Tabs 
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Members Tab 

Applicable Objects  Group Object 

The Members tab shows the users that are members of the group. Use it to add and 
remove members from a group. A user’s group membership is used to calculate their 
effective permissions. For more information about effective permissions, see Effective 
Permissions in Chapter 11 — Advanced Permissions and Security. 

Members 
tab  

Members who belong to this group  This window shows the users that are members of the 
group. 

Members who do not belong to this group  This window shows the users that are not 
members of the group. 

Add  To add a user to the group, select the user in the right window and click Add. The 
user is moved to the left window. 

Remove  To remove a user from the group, select the user in the left window and click 
Remove. The user is moved to the right window. 

For more information on… See… 

Adding users to groups Groups Tab, User Object, Chapter 11 — 
Advanced Permissions and Security 

Calculating effective permissions Effective Permissions, Chapter 11 — 
Advanced Permissions and Security 
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Options Tab 

Applicable Objects  Backup Job, Restore Job, Verify Job 

The Options tab on the property sheet of a job controls various parameters important to 
how TapeWare runs backup, restore and verify jobs. 

Options 
tab  

Number of Passes 
Determines how many times TapeWare will attempt to access a file. The default is 3. 

If TapeWare needs to use a file that is currently being used, TapeWare waits until that 
user is done with the file. Each attempt to open a file is called a pass. 

For backup jobs, when TapeWare is unable to back up a file on the first pass, it attempts 
to back up that file on subsequent passes. On the last pass, TapeWare opens the file in 
shared mode. 

Delay Between Passes 
Determines how many seconds TapeWare waits before attempting the next pass. If your 
historical usage suggests that many files are being opened on the last pass, consider 
increasing this parameter to a higher number. 
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Log Options 
Determines the kind of log that TapeWare keeps of the current job. The Log options is 
either None, Log only failed, Log only completed or Log all. 

After a job is run, you can view or print the log to see which files were successfully or 
unsuccessfully backed up, restored or verified. The default value is Log only failed, 
which writes to the log any files that were not successfully backed up, restored or 
verified. 

None  Instructs TapeWare to not keep a log of the backup job as it runs. 

Log only failed  Instructs TapeWare to log the name of any selected file that was not 
successfully backed up, restored or verified. 

Log only completed  Instructs TapeWare to log the name of any file selected for and 
successfully backed up, restored or verified. 

Log all  Instructs TapeWare to log the name of every file selected and whether or not that 
file was successfully backed up, restored or verified. 

Backup Mode 
(Backup jobs only) 

Determines whether all files or only changed files are backed up. For scheduled 
automatic rotation jobs, TapeWare uses the backup mode for each backup set as indicated 
on the Schedule tab; for unscheduled or manual jobs, TapeWare uses the parameters set 
by the user. 

The Backup mode is either Full, Incremental, Differential or Snapshot. 

Full  Instructs TapeWare to back up all selected files. For each file, TapeWare resets the 
incremental bit in the storage management database and the archive bit on disk.  

Differential  Instructs TapeWare to back up all selected files that have changed since the 
last full backup. When a file changes, its differential bit has been set. TapeWare does not 
reset any bits. 

Incremental  Instructs TapeWare to back up all selected files that have changed since the 
last backup. For each file, TapeWare resets the incremental bit in the storage 
management and the archive bit on disk. 

Snapshot  Instructs TapeWare to back up all selected files. It has no effect on any future 
scheduled job. After backing up each file, the archive bit is left unchanged. 



Chapter 12 — Object and Property Reference: Options Tab 249 

 

Change Mode 
(Backup jobs only) 

Determines what action TapeWare will perform when it fails to find the media it was 
expecting to use for a job. When TapeWare runs a job, if the job uses specific media, 
TapeWare scans the network for devices with that media. If it does not find the media it 
expects, its response is determined by the Change mode parameter. 

The Change mode is either Skip device, Force to append or Prompt. 

Skip device  Instructs TapeWare to skip the designated device and look for other devices 
on the network with the proper media. TapeWare continues to scan for the correct media 
until it is found. As a result, the job may never run if the correct media is not found. 

Force to append  Instructs TapeWare to append data to whatever media it finds in the 
designated backup device. If it cannot find the correct media, TapeWare appends data to 
whatever media is available. This option will ensure that the job runs, if the media 
contains enough room to complete the job. 

Prompt  Instructs TapeWare to continue to scan for the expected media and to send an 
alert warning that the proper media has not been found. This option will not allow a job 
to run with any other media except with the expected media. Additionally, this option 
will not search for another device that might contain the proper media. 

Write Mode 
(Backup jobs only) 

Determines whether the old data on the media is overwritten with new data or whether 
the new data is appended to the end of the old data. When media is overwritten, all of the 
data previously stored on it is lost. Appending data will preserve the old data. 

For scheduled automatic rotation jobs, TapeWare defaults to Overwrite all tapes; for 
unscheduled and manual jobs, TapeWare uses the parameters set by the user. 

The Write mode is either Append to all tapes, Append to 1st tape, overwrite others or 
Overwrite all tapes. 

Append to all tapes  Instructs TapeWare to append all data to the end of the media. No 
data is overwritten. Select this parameter for permanent storage. 

Append to 1st tape, overwrite others  Instructs TapeWare to append data to the end of the 
first media, but to overwrite all media that follows. For example, TapeWare will not 
overwrite the first tape inserted, but will overwrite the second, third and later tapes. This 
parameter is useful if you have a set of media with old data you no longer need. By 
selecting this option, TapeWare preserves your most recent data on the first media, but 
overwrites older, unneeded media. 
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Overwrite all tapes  Instructs TapeWare to overwrite all media. All data on media that is 
overwritten is lost. Use this option for tapes that are going to be recycled. 

Auto Verify Mode 
(Backup and verify jobs) 

Verifies that a file was backed up correctly. TapeWare compares the file to the original 
file. 

The Auto verify mode is either No verify, Full verify or Quick verify. 

No verify  Instructs TapeWare to skip the verification step. It is not recommended. 

Full verify  Instructs TapeWare to compare every selected file stored on media with the 
original file from the workstation or file server. This default option is strongly 
recommended. 

Quick verify  Instructs TapeWare to be certain that every file backed up onto the tape is in 
readable condition. It does not verify that the data is correct, only that the data stored on 
the tape (incorrect or not) can be read. While selecting this option can save time, it is 
nonetheless not recommended. 

Compression Type 
(Backup jobs only) 

Controls how TapeWare compresses or maintains the compression of files and 
directories. 

The Compression type is either None, Standard, System or Both. 

None  Instructs TapeWare to write all data to the tape in a decompressed format. If the 
file is stored on disk in a compressed format, the file will be decompressed before 
writing. This option is useful if the device supports hardware data compression and the 
files are to be restored to a different operating system. 

Standard  Instructs TapeWare to write all data to tape in the TapeWare compression 
format. If the file is stored on disk in a compressed format, the file will be decompressed 
before being re-compressed by TapeWare. This option is useful if the tape device does 
not support hardware data compression and the files are to be restored to a different 
operating system. 
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System  Instructs TapeWare to write all data to tape in the same mode it is stored on disk. 
If the file is stored on disk in compressed format, TapeWare will write the data in the 
host’s compressed format. If the file is not compressed on disk, TapeWare will store the 
file on tape in a non-compressed format. This option is useful if the hardware supports 
data compression and the files are to be restored to the same operating system. This 
option also gives better performance. 

Note  If the backup device supports hardware compression, be sure to select the System 
option. Then enable Hardware compression on the Advanced Options window. 

Both  Instructs TapeWare to write all compressed data in its compressed format. Any 
uncompressed files will be stored in the TapeWare compression format. This option is 
useful if the hardware does not support data compression and the files are to be restored 
to the same operating system. 

Auto Format Mode 
(Backup jobs only) 

Determines whether or not TapeWare will format media automatically. 

Before data can be written to media, the media must be formatted. When media is 
formatted, any data on it is lost. Tapes and other media are formatted when TapeWare 
does not recognize the media, that is, when it has no information in its storage 
management database about that particular media. This will occur when the media is 
blank, it has been erased, it is first used or it has been deleted from the database. 

The Auto format mode is either No auto format, Auto format blank media or Auto 
format all. 

No auto format  Instructs TapeWare to send an alert to the alert window if it encounters 
media that needs to be formatted (either blank or unrecognized media). While waiting for 
a user reply, TapeWare scans the network for devices with the media it was expecting. 
When selected, TapeWare waits for a reply to the alert before formatting unrecognized 
media. 

Auto format blank media  Instructs TapeWare to automatically format all new or blank 
media. However, if TapeWare encounters unrecognized media, it sends an alert to the 
alert window and then scans the network for the media it was expecting. This parameter 
can help prevent data from being accidentally destroyed by formatting, while not 
needlessly querying the user before formatting a blank media. 

Auto format all  Instructs TapeWare to automatically format all of the media inserted into 
the tape drive which require formatting. With this parameter selected, TapeWare will 
automatically format all new (or blank) media and all unrecognized media. 
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New Media Location 
(Backup jobs only) 

Specifies the folder in which TapeWare will store any new media created while the job is 
run. By default, TapeWare stores media in the current User/Group folder; the media will 
appear there on the Media and Database tabs. You can also store the media in a separate 
media folder inside the User/Group folder. 

Select the folder in which to store any new media by clicking the Browse… button. Then 
select the folder from the Browse window. If the folder does not exist, use the Media tab 
to create it first. Then you can select the New media locations. 

When TapeWare runs any scheduled automatic rotation job, it automatically creates new 
media folders for the job. The folders are organized by the name of the job and the 
various rotation sets in that job. There is no reason to create these folders manually. 
TapeWare will automatically create these folders for you. 

Note  TapeWare does not automatically create new media folders for manual jobs. 

New Media Name 
(Backup jobs only) 

Specifies the name TapeWare gives to any new media it creates while running the job. 
For scheduled automatic rotation jobs, TapeWare automatically updates this parameter to 
match the media’s place in the rotation schedule. For example, if the media is the first 
media in the yearly rotation set, TapeWare names it “Year Set 1:1”. (This means the 
media was used with a yearly backup job and that it was the first tape in the first set.) 

For manual rotation and unscheduled jobs, TapeWare assigns any new media it creates 
the name listed in this field. This is also true for automatic rotation jobs that are “forced” 
to run. 

Device 
Specifies which tape drive or other removable media device TapeWare will use to run the 
backup, restore or verify job. 

By default, TapeWare sets this parameter to the network container. When running the 
job, TapeWare will use whatever device it finds on the network. If there is only one 
device in your storage management zone or if you only have permissions to one device, 
there is no reason to change this parameter. 
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However, if there are several devices on your network and you need to select a specific 
device, specify which device the job should use by selecting it from the Device list. (If a 
machine has only one device, you can just select the machine and not the device.) 

To use a device that is not shown in the Device list, click the Add… button and select the 
new device from the Browse window. Then select the undesired network container from 
the Device list, click Delete and confirm the deletion. 

Media 
(Backup jobs only) 

Specifies the media folder in which the tape or other removable media are stored. 
TapeWare will look here for media to use with this job. 

The default folder is the current User/Group folder. If you wish to use media from 
another folder, specify which folder by selecting it from the Media list. 

If you wish to use a folder that is not shown in the Media list, click the Add… button 
and select the new folder from the Browse window. 

Media Password… 
(Backup jobs only) 

When a job creates new media, you can assign that media a password. A password 
prevents the media from being imported into another TapeWare storage management 
database and can be an important part of your overall security plan. 

To have the job assign a password to the new media, click the Media Password… button 
and type and confirm your password. 

Note that passwords can only be assigned when media is formatted. Additionally, media 
passwords are only required when importing media. 
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For more information on… See… 

Setting job options Job Options, Chapter 7 — Job Options 

Backup mode Backup Mode, Chapter 6 — Scheduling Jobs 

Formatting media Creating New Media, Chapter 9 — Media, 
Device and Database Tabs 
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Permissions Tab 

Applicable Objects  All database objects 

For user objects and group objects, the Permissions tab lists the objects to which the 
current user or group has permissions. For all other objects, it shows the users or groups 
that have permissions to the current object. 

Use this tab to grant users or groups permissions to objects. Note that permissions can be 
granted from either the property sheet of the database object or the property sheet of the 
user or group. Either way, the permissions appear on the appropriate corresponding 
object’s Permissions tab. For example, if Galen Clark is granted permissions to the C: 
volume from the Permissions tab on his property sheet, the Permissions tab on the 
property sheet of the C: volume will list Clark as a user who has permissions. 
Alternatively, if Clark is granted permissions from the property sheet of the C: volume, 
the appropriate permissions will appear on Clark’s Permissions tab. 

Note additionally that a user has direct permissions only to those objects listed on that 
user’s Permissions tab. Any and all other effective permissions to other objects are 
calculated through inherited permissions, through equivalencies or through groups. 

Permissions 
tab  

Users or groups which have permissions to this object  Lists the users or groups which 
have permissions to the current object (does not apply to either group or user objects). 

To display the permissions for a user or group, select the user or group; the permissions 
appear in the Permissions fields. 
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To add a user or group, click Add. To remove a user or group, select the group or user 
and click Remove. 

Objects to which this user or group has permissions  Lists the objects to which the current 
user or group has permissions (only applies to group and user objects). 

To see the permissions each user or group has to a particular object, select the object; the 
permissions to that object appear in the Permissions fields. 

To grant a user or group permissions to a new object, click Add and select the 
appropriate permissions. To end permissions to an object, select the object and click 
Remove. 

Permissions  Shows the permissions granted to the currently highlighted object, user or 
group. Check or uncheck the appropriate boxes to grant or restrict permissions. 

For more information on… See… 

Calculating effective permissions Effective Permissions, Chapter 11 — 
Advanced Permissions and Security 

Assigning user permissions Permission’s Tab, User Object, Chapter 11 
— Advanced Permissions and Security 

Assigning group permissions Permission’s Tab, Group Object, Chapter 
11 — Advanced Permissions and Security 

Differing types of permissions Permissions Reference, Chapter 11 — 
Advanced Permissions and Security 
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Ping Test Tab 

Applicable Objects  Machine 

Use the Ping Test tab for a machine to measure how long it takes an echo packet to travel 
back and forth on the network. The packet is sent from the machine on which TapeWare 
is currently running to the machine whose property sheet is open. 

Click Start to begin the test. Click Stop to end the test. 

Ping Test 
tab  

The Ping status fields display the test results: 

Packet No.  Shows the number of data packets sent from one machine to another up to this 
point in the test. 

Round trip time (ms)  Shows the average time for the echo packet to travel between the 
two machines. 
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Preferences Window 

Use the Preferences window to set certain options that control the user interface. 

Preferences 
window  

Confirmation 
Allows user to determine if TapeWare will prompt before completing certain commands. 

Confirm when deleting objects  When checked, TapeWare opens the Confirm Delete 
window before deleting an object. It requires user confirmation before deleting a database 
object. 

Confirm when moving objects  When checked, TapeWare opens the Confirm Move 
window before moving an object. It requires user confirmation before moving a database 
object. 

Confirm when copying objects  When checked, TapeWare opens the Confirm Copy 
window before pasting a copied object. It requires user confirmation before pasting a 
database object. 

Tree View 
Determines whether TapeWare calculates if containers in hierarchical, tree views have 
containers within them. Determines whether or not TapeWare displays expand tree icons 
next to containers that cannot be expanded, i.e., that do not contain additional containers. 

Smart expandable indicators  When checked, TapeWare looks in every container in the 
hierarchical, tree view. If it does not have any additional containers, the expand tree icon 
is not displayed. 

 
Expand tree 
icon 
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When unchecked, TapeWare displays an expand tree icon for every container. TapeWare 
only checks if a container holds other containers when you click the expand tree icon. In 
this case, the expand tree icon does not necessarily indicate additional containers in the 
container. Leave this option unchecked to display the hierarchical tree faster. 

Text Editor 
Identifies the text editor (word processor) that TapeWare will use when displaying logs. 
When you select a job log on the Logs tab and click View, TapeWare opens the log using 
the specified text editor. You can change the text editor by either entering the run 
command for the text editor or by clicking Browse and selecting another text editor. Note 
that the default Windows text editor is Notepad.exe. 
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Query Window 

Applicable Objects  All storage management database objects 

Use the Query window to sort files for displaying on Database tab. Use it to exclude or 
“filter out” files that do not meet the specified selection criteria. 

Selection filters are applied to all of the volumes, folders and files ordinarily displayed on 
the Database tab. You cannot apply different filters to different machines or volumes. 
TapeWare uses the selection filters to sort the files and only displays the files that meet 
the selection criteria. 

Query 
window  

Backup range  Displays files according to their backup date. The backup date is assigned 
to a file each time it is backed up. The backup date for a file is the same as the last time it 
was backed up. 

Modify range  Displays files according to their modify date. Each time a file is modified, 
its modified date is updated. You can use this filter to display files whose modified date 
matches your criteria. TapeWare checks the directory information on the volume to see if 
the file should be included in the job. 
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Create range  Displays files according to their create date. When a file is first created, it is 
assigned a create date. You can use this filter to displays only those files which match 
your criteria. TapeWare checks the created date for each file stored in the directory of the 
volume and uses this to sort files. 

Delete range  Displays files according to their delete date. 

When files have been backed up and are later deleted, TapeWare marks the file as having 
been deleted and assigns it a delete date. This filter instructs TapeWare to display only 
files which have a delete date that matches the selection criteria. If a file has not been 
deleted, it will not have a delete date and will not be displayed. 

Access range  Displays files according to their access date. Each time a file is read, 
whether or not it is modified, its access date is updated by the operating system. You can 
use this information to select and filter files. 

Size range  Displays files according to their size. 

Instance range  Displays files according to their instance date. Each time TapeWare backs 
up a file, it creates a new instance of that file and assigns it an instance date. 

Wildcard type  Displays the wildcard format used by the Must match and Cannot match 
filters. Select one of three types of wildcard formats: DOS, Long or UNIX. 

Must match  Displays files that match specified wildcards. Only files that match the 
wildcard indicated in this field are selected. 

Specify multiple wildcards by separating each with a semicolon (no spaces). TapeWare 
displays any file that matches any one of the wildcards. For example, if you enter 
*.exe;*.doc in the Must match field, TapeWare displays all files that have either the .exe 
extension or the .doc extension. 

Cannot match  Files that match the specified wildcard are not displayed; they are 
excluded. You can specify multiple wildcards by separating them with a semicolon (no 
spaces); if you specify multiple wildcards, TapeWare excludes any file that matches any 
one of the wildcards you specify. 

Required attributes  Displays files according to attributes controlled by the operation 
system. 

Operating systems track certain features of files called attributes that they use to manage 
these files. In this field, if an attribute is checked, TapeWare only displays those files 
which have these attributes. 

You can select multiple attributes. In this case, TapeWare only displays those files that 
meet all of the required attributes. 
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Note that some of these attributes are only supported by certain operating systems. If you 
specify an attribute that is specific to a particular operating system, then only files created 
under that operating system will be displayed. 

Exclude attributes  Files with specified operating system attributes are not displayed. 

This field works like the Required attributes field except that TapeWare excludes files 
that match these attributes. 

You can select multiple attributes. TapeWare excludes any file that has any one of the 
attributes. For example, if you the Hidden and System attributes, a file will be excluded 
if it has either the Hidden attribute or the System attribute. 

Parents  Determines whether or not the directories are displayed. 

When this option is checked, TapeWare displays the directories for any object that meets 
the other display criteria. 

Children  When this option is checked, TapeWare backs up and restores the selected files. 
If you want only to back up or restored the marked directories, uncheck this option. 
When the Children box is unchecked and the Parents box is checked, TapeWare backs 
up the directory structure, but not the files stored in the directories (that is, in the folders). 

Media  Displays files which have a valid instance on the media listed in this field. 

TapeWare tracks instances of files and the media on which those instances are stored. 
You can use this information to sort files according to the media on which they appear. 
Only files with instances on the media in the Media field will be displayed. If there are 
multiple media shown in the Media filter field, only files which have a valid instance on 
all the media listed will be displayed. 
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Schedule Tab 

Applicable Objects  Backup Job, Verify Job, Restore Job 

The Schedule tab controls when and how often a job is run. 

Schedule 
tab  

Type 
Sets the type of schedule. 

For restore and verify jobs, the type is either Not Scheduled or Manual. In addition, for 
backup jobs, there are eight automatic rotation schedules plus the custom schedule. 

Not Scheduled  The job will run only when instructed to do so. Uses parameters set on 
job’s Options tab. 

Manual  Turns on scheduling calendar, allowing job to be scheduled to run repeatedly. 
Job will run every day indicated on calendar. Uses parameters set on job’s Options tab. 
User manually controls set count, media rotation, media name and backup mode. 
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Custom  Turns on automatic rotation schedule. Applies to backup jobs only. Job will run 
every day as scheduled in the calendar. TapeWare will automatically update the Backup 
mode, Write mode, New media location and New media name parameters on the 
Options tab of the job when it runs the job as scheduled. (These parameters are not 
updated if the job is manually “forced” to run by a user.) Allows the user to determine the 
set count for each set type; however, TapeWare will automatically control the 
implementation of these features. When first selected, initially defaults to GFS–25 
schedule. 

Automatic Rotation Schedules  There are eight automatic rotation schedules: GFS 30-tape, 
GFS 25-tape, GFS 20-tape, Simple 12-tape, Simple 11-tape, Simple 10-tape, Simple 5-
tape, Simple 4-tape. Applies only to backup jobs. Job will run every day scheduled in 
calendar. TapeWare will automatically update the Backup mode, Write mode, New 
media location and New media name parameters on the Options tab of the job when it 
runs the job as scheduled. (These parameters are not updated if the job is manually 
“forced” to run by a user.) Set count for each set type is predetermined; TapeWare 
automatically controls media rotation. 

Start Time 
Specifies the time of day the job will run. Note that jobs can run concurrently. 

Daily, Weekly, Monthly, Yearly 
Indicates the backup mode and set count for the Daily, Weekly, Monthly and Yearly 
media sets respectively. Backup mode and set Count can be set by the user when the 
Custom schedule is selected. 

End of Week 
Indicates the day of the week that TapeWare will use to schedule Weekly backup jobs. 
Change the list box to match whatever day of the week TapeWare should run weekly 
jobs. 
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For more information on… See… 

Differences between schedule types Which Built-in Schedule to Select, Chapter 6
— Scheduling Jobs 

Manually forcing scheduled jobs to run Forcing Scheduled Jobs to Run, Chapter 8 
— Running Jobs 

Scheduling jobs to run once only Scheduling a Job to Run Once Only, 
Chapter 10 — Tips, Techniques and 
Strategies 

Working with the calendar Modifying Built-in Schedules, Chapter 6 — 
Scheduling Jobs 



266 TapeWare® User’s Guide and Technical Reference 

 

Selection Tab 

Applicable Objects  Backup Job, Restore Job, Verify Job 

Use the Selection tab to select the files and instances for use by the current job. 

Selection 
tab 

 
TapeWare uses the following to identify selected objects for all job types: 

• The box is checked for each selected object. 

• The box is grayed for each container (folder, volume, machine and network) that has 
one or more selected objects. 

If you select a container, all objects within that container are selected. If you add new 
objects to a marked container, those objects will also be selected when the job is run. 

If a container is both unmarked and not gray, it contains no selected objects and it is not 
itself selected. 

For more information on… See… 

Filtering and selecting files for jobs Chapter 5 — Selecting Files and Instances 
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Selection Filters Window 

Applicable Objects  Backup Job, Restore Job, Verify Job 

Use the Selection Filters window to specify the selection criteria for a job. It excludes or 
“filters out” files that do not match the selection criteria. 

The selection filters are applied to all of the volumes, folders and files that have been 
marked for backup. You cannot apply different filters to different folders or volumes. If a 
folder or other container has been marked for backup, TapeWare uses the selection filters 
to sort through the files and unmark any files that do not meet the selection criteria. 
TapeWare does not use the selection filters to add files to the backup set. 

The filter criteria are applied to all marked files, regardless if they were marked before or 
after the filter criteria were specified. After specifying the selection filter criteria, you can 
then mark or unmark files, folders and volumes for backup. Additionally, you can change 
the filter criteria at any time; TapeWare will automatically reapply the new selection filter 
criteria to the marked folders and files. 

Selection 
Filters window 

 
Backup range  Selects files according to their backup date. The backup date is assigned to 
a file each time it is backed up. The backup date for a file is the same as the last time it 
was backed up. 
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Modify range  Selects files according to their modify date. Each time a file is modified, its 
modified date is updated. You can use this filter to select files whose modified date 
matches your criteria. TapeWare checks the directory information on the volume to see if 
the file should be included in the job. 

Create range  Selects files according to their create date. When a file is first created, it is 
assigned a create date. You can use this filter to select only those files which match your 
criteria. TapeWare checks the created date for each file stored in the directory of the 
volume and uses this to sort files for the job. 

Delete range  Applies only to restore jobs. Selects files according to their delete date. 

When files have been backed up and are later deleted, TapeWare marks the file as having 
been deleted and assigns it a delete date. This filter instructs TapeWare to only restore 
files which have a delete date that matches the selection criteria. If a file has not been 
deleted, it will not have a delete date and will not be selected. 

Access range  Selects files according to their access date. Each time a file is read, 
whether or not it is modified, its access date is updated by the operating system. You can 
use this information to select and filter files. 

Size range  Selects files according to their size. 

Instance range  Selects files according to their instance date. Each time TapeWare backs 
up a file, it creates a new instance of that file and assigns it an instance date. For restore 
and verify jobs, this is the only filter that selects instances of files, rather than files 
themselves. 

Wildcard type  Specifies the wildcard format used by the Must match and Cannot match 
filters. Select one of three types of wildcard formats: DOS, Long or UNIX. 

Must match  Selects files that match specified wildcards. Only files that match the 
wildcard indicated in this field are selected. 

Specify multiple wildcards by separating each with a semicolon (no spaces). TapeWare 
selects any file that matches any one of the wildcards. For example, if you enter 
*.exe;*.doc in the Must match field, TapeWare selects all files that have either the .exe 
extension or the .doc extension. 

Cannot match  Files that match the specified wildcard are not selected; they are excluded. 
You can specify multiple wildcards by separating them with a semicolon (no spaces); if 
you specify multiple wildcards, TapeWare excludes any file that matches any one of the 
wildcards you specify. 

Required attributes  Selects files according to attributes controlled by the operation 
system. 
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Operating systems track certain features of files called attributes that they use to manage 
these files. In this field, if an attribute is checked, TapeWare only selects those files 
which have these attributes. 

You can select multiple attributes. In this case, TapeWare only selects those files that 
meet all of the required attributes. 

Note that some of these attributes are only supported by certain operating systems. If you 
specify an attribute that is specific to a particular operating system, then only files created 
under that operating system will be selected for backup. 

Exclude attributes  Unselects files according to attributes controlled by the operating 
system. 

This field works like the Required attributes field except that TapeWare excludes files 
that match these attributes. 

You can select multiple attributes. TapeWare excludes any file that has any one of the 
attributes. For example, if you select the Hidden and System attributes, a file will be 
excluded if it has either the Hidden attribute or the System attribute. 

Parents  Determines whether or not the directory information is selected. 

When this option is checked, when TapeWare backs up or restores a file, it also backs up 
or restores the directory information relevant to that file. This option must be checked in 
order for folders and other directory data to be backed up or restored. When this option is 
not checked, TapeWare will not back up or restore any parent information for any file 
backed up. If unchecked, directory information about folders and volumes is not backed 
up. 

Children  Determines whether or not the files are selected. 

When this option is checked, TapeWare backs up and restores the selected files. If you 
want only to back up or restored the marked directories, uncheck this option. When the 
Children box is unchecked and the Parents box is checked, TapeWare backs up the 
directory structure, but not the files stored in the directories (that is, in the folders). 

Media  Selects files which have a valid instance on the media listed in this field. 

TapeWare tracks instances of files and the media on which those instances are stored. 
You can use this information to sort files according to the media on which they appear. 
Only files with instances on the media in the Media field will be selected for a job. If 
there are multiple media shown in the Media filter field, only files which have a valid 
instance on all the media listed will be selected. 
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For more information on… See… 

Using file selection filters File Selection Criteria, Chapter 5 — 
Selecting Files and Instances 

Selecting deleted files only Selecting Deleted Files for Restoring, 
Chapter 10 — Tips, Techniques and 
Strategies 

Using filters to select instances Backup Range, Chapter 5 — Selecting Files 
and Instances 

Using filters to copy directories Copying a Directory Structure, Chapter 10 
— Tips, Techniques and Strategies 
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Status Tab 

Applicable Objects  Autoloader 

The Status tab shows the device and storage status that is associated with each slot in an 
autoloader. Use it to select storage slots and media or to perform various functions on the 
media in the autoloader. 

Status 
tab  

Loader Statistics 
Shows information about the current magazine in the autoloader. 

Device/Storage  Specifies the device or the storage slot. 

Status  Shows the current or likely status of the device or storage slot. 

• Valid  The slot is known to hold media that is in the current database. 

• Probably Valid  The slot held valid media previously. TapeWare verifies that the 
media is valid before using it. When you exit and restart TapeWare, media marked 
Valid is reset to Probably Valid. 

• Invalid  The slot holds media that is definitely not in the current database. 

• Probably Invalid  The slot holds media that may not be in the current database. 
When you exit and restart TapeWare, media marked Invalid is reset to Probably 
Invalid. 
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• Empty  The slot is either known to be empty or a user changed its status to Empty. 

• Probably Empty  The slot was empty previously. When you exit and restart 
TapeWare, slots marked Empty are reset to Probably Empty. 

• Unknown  The status of the slot is not known, usually because it has not been used 
yet. 

• Cleaning Tape  A user marked the slot as holding a cleaning cartridge. The number 
of remaining cleaning cycles also appears. TapeWare does not verify that a cleaning 
cartridge was, in fact, inserted into this slot. 

• Reserved  The slot was disabled by a user. TapeWare will ignore it during any job. 
You can only change the status of a reserved slot. 

Message  Displays the name of a Valid or Probably Valid media. Also displays the 
status to the slot. 

Import… 
Opens the Import Media window for the selected storage slots. 

Format… 
Opens the Format Media window for the selected storage slots. 

Identify 
Identifies the selected media. Reads the media header information and checks to see if 
media is in current database. 

Rebuild 
Identifies the selected media. If the autoloader supports optical scanning of media bar 
codes, TapeWare uses bar codes to identify the media, comparing it to the current 
database. If the autoloader does not support optical scanning of media, TapeWare reads 
the media header information and checks to see if the media is in current database. 

Clean 
Performs a cleaning cycle on the selected device. Select the device and click Clean. Once 
complete, TapeWare decreases the Number of remaining cleaning cycles by one. This 
option requires a cleaning cartridge in a storage slot whose status is Clean. 
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Change Status… 
Opens the Change Status window. Lets the user assign one of the following to the media 
or slot: 

• Unknown  TapeWare will identify the media in the slot before using it. 

• Empty  TapeWare marks the slot as empty. 

• Clean  TapeWare will use the media in this slot to perform a cleaning cycle. 

• Reserved  TapeWare ignores the storage slot until a user changes its status again. 
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Storage Tab 

Applicable Objects  File, Directory, Volume 

Use the Storage tab to configure the Backup stream and Audit object actions for this 
object. 

TapeWare is capable of controlling up to 16 data streams simultaneously (up to eight 
streams per device). Data streams are automatically created for each machine object; this 
parameter cannot be changed. 

By default, new data streams are created for each volume, while files and directories use 
the data stream of their parent volume by default. For files, directories and volumes, these 
parameters can be modified. 

Storage 
tab  

Backup Stream 
Determines whether or not a new data stream is created for the current object. 

Use existing stream  TapeWare does not create a new stream for this object. This is the 
default value for directories and files. 

Select this parameter for a volume when you do not want to create a new stream for that 
volume. For example, you may wish to not create an additional stream when the volume 
is only a logical partition—not a physically separate device. 

Create new stream  TapeWare will create a new stream for this object when running a 
backup job. This is the default value for volumes. 



Chapter 12 — Object and Property Reference: Storage Tab 275 

 

Select this parameter for directories and files when you want to create a new stream for 
these objects. For example, to speed up a backup job, you may wish to create an 
additional stream for a very large file or for a RAID device. 

Audit Object Actions 
Enables or disables the audit log for this object. 

For more information on… See… 

Optimizing backup streams Strategies for Faster Jobs, Chapter 10 — 
Tips, Techniques and Strategies 

Audit logs Audit Logs, Chapter 8 — Running Jobs 
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Appendix A — Disaster Recovery 

The TapeWare disaster recovery system is designed to operate as automatically as 
possible during initial preparation and recovery. Once installed, disaster recovery will 
perform its tasks without any intervention by you. 

In This Appendix 

• Create the disaster recovery backup 

• Testing disaster recovery media 

• Recovering from a disaster 

• Using disaster recovery with autoloaders 

• Using disaster recovery with Windows active directory 

Overview 

TapeWare’s Disaster Recovery can be prepared using diskettes, CD-R/CD-RW or tape, 
depending on computer configuration and tape drive. You create bootable media 
(diskettes, CD, tape), which you use to recover your system configuration, software and 
data following a system or disk failure. You can use this media to boot your system and 
initiate the recovery process. 

To make your disaster recovery process as easy as possible, please note the following: 

• TapeWare rewrites most system configuration information to the media each time it 
overwrites the media. Therefore, when making a full backup to be used for disaster 
recovery, you should select Overwrite all tapes on the backup job’s Options tab. 

• Disaster Recovery works best with full backups, where all disks on your system fit 
on a single media. If the total amount of data on your system requires more than one 
media, TapeWare still functions correctly. However, you will have to change media 
during recovery. You can also use incremental and differential jobs for recovery 
purposes, but you must insert the recovery media in the correct chronological order. 
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• If you have an autoloader, make sure the most recent backup media is loaded in slot 
1. For more information, see Using Autoloaders with Disaster Recover later in this 
appendix. 

• When recovering your system, TapeWare gives you the option to recover your whole 
system or just the hard disk that your system boots from. If the volumes on your boot 
hard disk are split among multiple physical hard disks, you should recover the entire 
system and not just the boot disk. Otherwise, some system data may not be restored. 

• You must install the disaster recovery option and prepare bootable media on each 
system that will use this feature. TapeWare does not support remote disaster 
recovery. It only saves recovery information for the local system. 

For example, if the tape device is connected to Machine1 and you make a remote 
backup of Machine2, the media will contain system configuration information for 
Machine1, not Machine2. You can use the media to boot Machine1, but TapeWare 
only restores system information to Machine1 during recovery. All other files on the 
media were backed up from Machine2. To perform disaster recovery on Machine2, 
you must connect a tape device to Machine2. 

When performing disaster recovery, TapeWare assumes that major changes to your 
hardware have not occurred. The hardware on the target system must be nearly identical 
to the source system with the following exceptions: 

• You may change your video adapter as long as the new video adapter is VGA 
compatible. 

• You may increase the size of your hard disk, but the geometry of the hard disk should 
remain the same. For example, if your original system had a hard disk with 63 sectors 
per track and 255 heads, then the new hard disk should be the same. The actual 
number of cylinders can be larger. If the geometry has changed, TapeWare will still 
use it, but the recovered operating system may not function correctly. 

• Your SCSI, ATAPI, Fibre Channel or USB tape drive and adapter must be the same 
or use the same driver as it did when the disaster recovery media was created. 

• You may change network cards, USB ports and USB peripherals, except tape drives, 
without restriction. 

• You may not perform disaster recovery to a USB hard drive. 

Note  Ideally, you should perform the disaster recovery operation on the same computer 
after replacing the faulty hardware that caused the system failure. 
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Create the Disaster Recovery Backup 

Preparing for disaster recovery is a three-step process: 

1. Install TapeWare and the Disaster Recovery option on each computer that will use 
disaster recovery (see Chapter 2 — Windows Operating Systems and Chapter 3 — 
Non-Windows Operating Systems in the TapeWare Installation Guide). 

2. Create a full backup of your system, according to the instructions in Create Full 
Backup below. 

3. Create the bootable media (see Create Bootable Media later in this appendix). If you 
have a bootable tape device, you already created bootable media when you ran the 
full backup. 

4. Test the bootable media to make sure you have created it properly (see Testing 
Disaster Recovery later in this appendix). 

Note  We recommend that you create at least one extra set of bootable media in case the 
first set fails during disaster recovery. 

Create Full Backup 
TapeWare automatically creates disaster recovery media whenever you run a full backup 
with the Overwrite all tapes job option. To create your disaster recovery media: 

1. Log in to TapeWare. 

2. Insert the first disaster recovery media. 

3. Create a backup job in the Admin Folder. 

4. Enter a name for the job, such as Disaster Recovery Backup. 

5. Click the Selection tab and select the check box for the local computer. 

Note  When creating the disaster recovery media, back up the local machine only. 
Otherwise, disaster recovery may not restore properly. 

6. Click the Options tab. The Backup mode should be set to Full by default.  

7. Select Overwrite all tapes from the Write mode drop-down list. 

8. Select Full verify from the Auto verify mode drop-down list. 
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9. If your backup device does not support compression, select Standard from the 
Compression type drop-down list. 

10. If your backup device supports automatic eject, you can configure the job to eject the 
media after the job finishes. Click Advanced Options. When the Advanced Options 
window appears, select Auto eject and click OK. 

11. Click OK. The job appears in the Admin Folder on the Backup tab. 

12. Run the job, inserting additional media as required. 

Note  If you have a bootable tape device, TapeWare makes each media bootable. For 
example, if the full backup uses three media, all three media are bootable. 

13. Once the backup job is complete, we recommend that you test the disaster recovery 
media on a test computer (see Testing Disaster Recovery later in this appendix). 

14. After the test is successful, store the disaster recovery media. 

Create Bootable Media 
After you make a full backup of your system, you must create bootable disaster recovery 
media. Depending on your platform (Windows, NetWare, Linux), TapeWare lets you 
create bootable diskettes or a bootable CD (CD-R/CD-RW). 

Note  If you have a bootable tape device, TapeWare already made bootable media when 
you created the disaster recovery backup (see Create Full Backup earlier in this 
appendix). However, you should still create bootable diskettes or a bootable CD 
(CD-R/CD-RW) as a precaution. 

Windows 
Under Windows, you can create either bootable diskettes or a bootable CD. To create the 
bootable media: 

1. Log in to TapeWare. 
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2. Select Disaster Recovery from the TapeWare Wizards tab. The Disaster Recovery 
window appears. 

 
3. Select one of the following options: 

• Create Diskettes  Create a set of bootable floppy diskettes (see Windows Diskettes 
below). 

• Create CD Image  Create a bootable CD-R/CD-RW (see Windows CD below). 

4. When the Disaster Recovery window appears again, click Close. 

Windows Diskettes 
This procedure creates a set of bootable floppy diskettes that will be used to initiate a 
system recovery. Windows 98/Me/NT typically requires three blank, formatted diskettes. 
Windows 2000/XP typically requires four blank, formatted diskettes. Windows Server 
2003 typically requires six blank, formatted diskettes. However, you may need more, 
depending on your system configuration. 

After you select Create Diskettes, TapeWare prepares the system information to be 
copied to diskette. Each time you are prompted, label the blank diskette as directed, insert 
the diskette and click OK. After all the diskettes have been created, TapeWare returns to 
the Disaster Recovery window. 

As soon as you create the diskettes, we recommend that you test the disaster recovery 
media on a test computer (see Testing Disaster Recovery later in this appendix). After the 
test is successful, store the diskettes. 

Windows CD 
This procedure creates a CD image file in your TapeWare main directory, 
BOOTCD.ISO by default. Use this image to create a bootable CD. The image file 
created contains the entire ISO-9660 bootable image required to boot your system and 
initiate the recovery process. 
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Note  TapeWare creates the CD image file; it does not create the CD itself. Use your CD 
writer software and drive to create the actual bootable CD-R/CD-RW. When creating the 
CD, make sure you use the write image option instead of the normal file write option. 

After you select Create CD Image, the Create Boot CD Image window appears. Enter 
the name of the CD image file and click OK. The default is BOOTCD.ISO. 

TapeWare prepares the system information and copies it to the CD image file. After the 
image file has been created, TapeWare returns to the Disaster Recovery window. Start 
your CD writer software and burn the CD image file directly to the CD-R/CD-RW. 

As soon as you create the CD, we recommend that you test the disaster recovery media 
on a test computer (see Testing Disaster Recovery later in this appendix). After the test is 
successful, store the CD. 

NetWare 
Under NetWare, you can create either bootable diskettes or a bootable CD. To create the 
bootable media: 

1. Log in to TapeWare. 

2. Select Other from the Available Options menu. 

3. Select Disaster Recovery from the Other Options menu. 

4. Select one of the following from the Available Options menu: 

• Create Boot Diskettes  Create a set of bootable floppy diskettes (see NetWare 
Diskettes below). 

• Create CD Image  Create a bootable CD-R/CD-RW (see NetWare CD below). 

5. When the Available Options menu appears again, press Esc twice to return to the 
main Available Options menu. 

NetWare Diskettes 
This procedure creates a set of bootable floppy diskettes that will be used to initiate a 
system recovery. NetWare 4.x typically requires three blank, formatted diskettes. 
NetWare 5.x typically requires five diskettes. NetWare 6.x typically requires seven 
diskettes. However, you may need more, depending on your system configuration. 

After you select Create Boot Diskettes, TapeWare prepares the system information to be 
copied to diskette. Each time you are prompted, label the blank diskette as directed, insert 
the diskette and click OK. After all the diskettes have been created, TapeWare returns to 
the Available Options menu. 
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As soon as you create the diskettes, we recommend that you test the disaster recovery 
media on a test computer (see Testing Disaster Recovery later in this appendix). After the 
test is successful, store the diskettes. 

NetWare CD 
This procedure creates a CD image file in your TapeWare main directory called 
BOOTCD.ISO. Use this image to create a bootable CD. The image file created contains 
the entire ISO-9660 bootable image required to boot your system and initiate the 
recovery process. 

Note  TapeWare creates the CD image file; it does not create the CD itself. Use your CD 
writer software and drive to create the actual bootable CD-R/CD-RW. When creating the 
CD, make sure you use the write image option instead of the normal file write option. 

After you select Create CD Image, TapeWare prepares the system information and 
copies it to the CD image file. After the image file has been created, TapeWare returns to 
the Available Options menu. Start your CD writer software and burn the CD image file 
BOOTCD.ISO directly to the CD-R/CD-RW. 

As soon as you create the CD, we recommend that you test the disaster recovery media 
on a test computer (see Testing Disaster Recovery later in this appendix). After the test is 
successful, store the CD. 

Linux 
Under Linux, you can only create a bootable CD. 

This procedure creates a CD image file in your TapeWare main directory, 
BOOTCD.ISO by default. Use this image to create a bootable CD. The image file 
created contains the entire ISO-9660 bootable image required to boot your system and 
initiate the recovery process. 

Note  TapeWare creates the CD image file; it does not create the CD itself. Use your CD 
writer software and drive to create the actual bootable CD-R/CD-RW. When creating the 
CD, make sure you use the write image option instead of the normal file write option. 

Console Interface 
To create a bootable CD from the console version of TapeWare: 

1. Log in to TapeWare. 

2. Select Other from the Available Options menu. 
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3. Select Disaster Recovery from the Other Options menu. 

4. Select Create CD Image. TapeWare prepares the system information and copies it to 
the CD image file. 

5. When the Available Options menu appears again, press Esc twice to return to the 
main Available Options menu. 

6. Start your CD writer software and burn the CD image file BOOTCD.ISO directly to 
the CD-R/CD-RW. 

7. As soon as you create the CD, we recommend that you test the disaster recovery 
media on a test computer (see Testing Disaster Recovery later in this appendix). After 
the test is successful, store the CD. 

X Window Interface 
To create a bootable CD from the X Window version of TapeWare: 

1. Log in to TapeWare. 

2. Select Disaster Recovery from the TapeWare Wizards tab. The Disaster Recovery 
window appears. 

 
3. Select Create CD Image. The Create Boot CD Image window appears. 

4. Enter the name of the CD image file and click Save. The default is BOOTCD.ISO. 
TapeWare prepares the system information and copies it to the CD image file. After 
the image file has been created, TapeWare returns to the Disaster Recovery window.  

5. Click Close to return to the Wizard tab. 

6. Start your CD writer software and burn the CD image file directly to the 
CD-R/CD-RW. 
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7. As soon as you create the CD, we recommend that you test the disaster recovery 
media on a test computer (see Testing Disaster Recovery later in this appendix). After 
the test is successful, store the CD. 

Troubleshooting Disaster Recovery Backup 
When creating disaster recovery backups, any of the following problems may occur: 

• Error Number 11 - File Not Found 

Examine the twtrace.txt file located in your TapeWare installation directory. This 
will list the file that was not found. All files must reside in “standard” directory 
locations provided by the operating system, e.g., \WINNT\SYSTEM32\DRIVERS 
subdirectory under Windows NT and SYS:SYSTEM or C:\NWSERVER under 
NetWare. If the file is not a driver file for your hardware, please contact technical 
support for assistance. 

• Error Number 1062 - Unable to open registry 

TapeWare requires full access to the registry to create disaster recovery information. 
Make sure you are starting TapeWare from an account with full administration 
privileges. 

• Error Number 1523 - Get/Set Server Info Failure 

An error has occurred while retrieving your disk configuration information. Consult 
the twtrace.txt file for additional details on this error. It usually occurs if a hard drive 
is not powered on or if a user does not have adequate system security rights. 

• Error Number 5 - Error opening file 
Error Number 7 - File read error 
Error Number 8 - File write error 

An error has occurred while accessing one of the floppy diskettes. The floppy may be 
defective. Reformat or replace it. Then try again. 

When to Create New Bootable Media 
Your bootable media may become obsolete whenever any of the following occurs: 

• You update your operating system by installing a service pack or other software. 

• You add or remove hardware from your computer. 

• You change the configuration of your disk drives, e.g., adding or removing volumes 
or partitions. 

• You change your TapeWare environment information, including changes to the 
TapeWare.ini file. 
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Therefore, we recommend that you create new bootable media anytime you change the 
environment. 

Testing Disaster Recovery Media 

We recommend that you test your disaster recovery media before you have to rely on it 
following a disaster. We also recommend that you create additional bootable media in 
case your new hardware configuration does not support your original bootable media. For 
example, if you create a bootable CD, but your new hardware does not support booting 
from CD, you should also create a set of bootable diskettes or a bootable tape. 

Warning  Before relying on any disaster recovery media, you should verify that your 
system can boot from the bootable device as described below. 

To test your disaster recovery media, perform the following steps. You will not lose any 
data on your system. This procedure is completely safe. 

1. Make a full backup of your system and create bootable media as directed in Create 
the Disaster Recovery Backup earlier in this appendix. 

2. Shut down your system as normal. 

3. If you are using a bootable CD: 

a. Insert the disaster recovery CD into your computer. 

b. Power on your computer. 

c. Perform any special steps for booting your computer from CD (refer to your 
system documentation). 

d. The system boots from the CD. 

4. If you are using a set of bootable diskettes: 

a. Insert the first diskette into your computer. 

b. Power on your computer. 

c. The system boots from the diskette. 

d. TapeWare prompts you to insert the rest of the diskettes. 

5. If you are using a bootable tape: 

a. Remove all media from all tape drives and/or autoloader magazine slots. 

b. Insert the first bootable media: 
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• If you are using a single tape drive, insert the first bootable media into 
the drive. 

• If you are using an autoloader, insert the first (or only) bootable media 
into slot 1 of the magazine. If the full backup used two or more media, 
insert the rest of the full backup media into the autoloader magazine in 
their proper order. 

Note  Slot 1 must contain the first (or only) bootable media from the most recent full 
backup. 

c. Perform any special steps for booting your computer from the tape drive 
(refer to your system documentation). Most bootable drives use a 
combination of power cycling and pressing the Eject button on the front 
panel. Many also require that you update the computer BIOS. 

d. The system boots from the tape. 

6. If your system boots and displays the Disaster Recovery (Phase 2) screen, your 
bootable media should function correctly during disaster recovery. 

 
7. If you are using a bootable tape, the Disaster Recovery (Phase 2) screen may not 

appear. Your system may hang during startup or your operating system may not boot 
from the tape. If either case, you must use bootable diskettes or a bootable CD to 
perform disaster recovery. Your tape device is not compatible with bootable tape. 

8. Select Exit from Disaster Recovery and press Enter. 

9. Remove the bootable media and restart your computer. This ends the disaster 
recovery test. 
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Recovering from a Disaster 

If disaster strikes and you are unable to boot your system using your normal boot 
procedure, use one of the following procedures to recover your system. You will need 
your bootable media (diskettes, CD, tape), your most recent full backup and any 
incremental or differential backups. 

Note  Data that has changed since the last full backup will not be restored. You must 
restore the rest of your data from incremental or differential backups. Any data that has 
not been backed up must be recreated. Therefore, you should only use Disaster Recovery 
as a last resort. 

Disaster Recovery from Diskette/CD 

Note  Do not restore incremental or differential backup media until after you complete 
disaster recovery. 

1. If you are using a bootable CD: 

a. Insert the disaster recovery CD into your computer. 

b. Power on your computer. 

c. Perform any special steps for booting your computer from CD (refer to your 
system documentation). 

d. The system boots from the CD. 

2. If you are using a set of bootable diskettes: 

a. Insert the first diskette into your computer. 

b. Power on your computer. 

c. The system boots from the diskette. 

d. TapeWare prompts you to insert the rest of the diskettes. 

3. Insert the first disaster recovery media. 
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Note  For disaster recovery, use only full backup media that were created with the 
Overwrite all tapes option. After disaster recovery is complete and your system has 
restarted, use the standard TapeWare options to restore any incremental or differential 
media to your system. The standard TapeWare restore procedure optimizes restoration 
and restores incremental and differential media faster than the disaster recovery process. 

 
4. When the Disaster Recovery (Phase 2) screen appears, select one of the following 

options: 

• Recover Boot Disk  Select this option to only recover the boot disk. Use it if your 
boot disk is corrupt or if you replaced the boot disk. This option does not usually 
affect the data on other hard disks. 

• Recover Entire System  Select this option to recover data to multiple hard disks, 
including the boot disk. Use this option if you replaced one or more hard disks. 

5. Press Enter. 

6. If a warning screen appears, read it and then press F10. 

7. Read through each information screen. Press F10 to advance to the next screen. 

8. When the first confirmation message appears (Are you sure?), select the appropriate 
Yes option and press Enter. 

9. When the second confirmation message appears, select Yes, Perform the Recovery 
and press Enter. 

The system does not require any input from you until it finishes restoring the first 
media to your system. Restoring the first media can take from 15 minutes to two or 
three hours, depending on the amount of data on the media, the speed and capabilities 
of the tape drive and whether you are recovering the entire system or just the boot 
disk. 
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10. After the system has restored the media, it asks for the next media to restore. Select 
Yes or press F10 to restore another media. 

11. After restoring the last media, remove the disaster recovery CD or diskette. 

12. Press Esc. A message screen appears. 

13. Press F10. TapeWare restarts your computer. 

14. You can now use TapeWare to restore the data from your incremental and differential 
backup media, if needed. 

Disaster Recovery from Bootable Tape 

Note  Do not restore incremental or differential backup media until after you complete 
disaster recovery. 

1. Remove all media from all tape drives and/or autoloader magazine slots. 

2. Insert the first bootable media: 

• If you are using a single tape drive, insert the first bootable media into the drive. 

• If you are using an autoloader, insert the first (or only) bootable media into slot 1 
of the magazine. If the full backup used two or more media, insert the rest of the 
full backup media into the autoloader magazine in their proper order. 

Note  Slot 1 must contain the first (or only) bootable media from the most recent full 
backup. When you use the Overwrite all tapes option, TapeWare makes each media 
bootable (see Create the Disaster Recovery Backup earlier in this appendix). For 
example, if the full backup uses three media, all three media are bootable. 

3. Perform any special steps for booting your computer from the tape drive (refer to 
your system documentation). Most bootable drives use a combination of power 
cycling and pressing the Eject button on the front panel. Many also require that you 
update the computer BIOS. 

Note  For disaster recovery, use only full backup media that were created with the 
Overwrite all tapes option. After disaster recovery is complete and your system has 
restarted, use the standard TapeWare options to restore any incremental or differential 
media to your system. The standard TapeWare restore procedure optimizes restoration 
and restores incremental and differential media faster than the disaster recovery process. 
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4. When the Disaster Recovery (Phase 2) screen appears, select one of the following 

options: 

• Recover Boot Disk  Select this option to only recover the boot disk. Use it if your 
boot disk is corrupt or if you replaced the boot disk. This option does not usually 
affect the data on other hard disks. 

• Recover Entire System  Select this option to recover data to multiple hard disks, 
including the boot disk. Use this option if you replaced one or more hard disks. 

5. Press Enter.  

6. If a warning screen appears, read it and then press F10. 

7. Read through each information screen. Press F10 to advance to the next screen. 

8. When the first confirmation message appears (Are you sure?), select the appropriate 
Yes option and press Enter. 

9. When the second confirmation message appears, select Yes, Perform the Recovery 
and press Enter. 

The system does not require any input from you until it finishes restoring the first 
tape to your system. Restoring the first tape can take from 15 minutes to two or three 
hours, depending on the amount of data on the tape, the speed and capabilities of the 
tape drive and whether you are recovering the entire system or just the boot disk. 

10. After the system has restored the tape, it asks you to insert the next tape to restore. 
Select Yes or press F10 to restore another tape.  

11. After restoring the last tape, remove the tape.  

12. Press Esc. A message screen appears. Then TapeWare restarts your computer.  
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13. You can now use TapeWare to restore the data from your incremental and differential 
backup media, if needed. 

Troubleshooting Recovering from a Disaster 
When attempting to recover your system, the following are common errors that occur: 

• Error Number 1523 - Get/Set Server Info Failure 

This message appears when TapeWare cannot reconfigure the disk drives and 
volumes on the target system. Make sure that all disks are powered on and ready and 
that any new disks are the same size or larger than the old disks. Make sure that the 
geometries of any new disks are also the same size or larger. Make sure you have 
enabled logical block addressing in your BIOS configuration and that any SCSI 
controllers are configured the same as when you created the recovery tape. If you 
changed SCSI adapters, TapeWare may not be able to access any peripherals from 
the new adapter unless it uses the same driver as the old adapter. 

• Unable to boot from tape 

This message appears if the tape does not contain a valid disaster recovery boot track. 
Try another tape or tape drive, if available. 

• Dynamic disk failure 

In some dynamic disk configurations under Windows 2000/XP/Server 2003, 
including RAIDs and mirrors, you may receive a dynamic disk failure message. The 
layout is usually recovered successfully. You simply have to re-activate the mirror 
set. 

Using Disaster Recovery with Autoloaders 

When using Disaster Recovery with an autoloader, remember the following: 

• Make sure the most recent full backup media is loaded into slot 1 of the autoloader. 
TapeWare will only boot from the tape in slot 1. Make sure the media was created 
using the Overwrite all tapes option. 
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• TapeWare will restore all media that are contained in the autoloader during the final 
recovery process. Therefore, make sure that you only load media in the autoloader 
that you will need to restore during recovery. For example, if you are using the 
Simple 10-tape schedule, TapeWare will have four daily differential backups, two 
weekly full backups and two monthly full backups. You should only perform disaster 
recovery with the latest full backup. After your system has been recovered, use the 
standard TapeWare restore procedures to recover any other changes from the 
differential backups. 

• Remove all media not associated with the recovery from the autoloader. If the full 
backup spans more than one media, put the additional full backup media into 
additional slots. TapeWare will then restore these media along with the slot 1 media. 

Note  Slot 1 must contain the first (or only) bootable media from the most recent full 
backup. When you use the Overwrite all tapes option, TapeWare makes each media 
bootable (see Create the Disaster Recovery Backup earlier in this appendix). For 
example, if the full backup uses three media, all three media are bootable. 

Using Disaster Recovery with Windows Active Directory 

When performing disaster recovery on a system with Windows Active Directory, use the 
following general steps: 

1. Perform the general system-level disaster recovery to restore the basic system data. 

2. When the Starting Windows screen appears during system startup, press F8. 

3. Select Directory Services Restore Mode and press Enter. 

4. Log in to the system. 

5. Log in to TapeWare. 

6. Create a restore job. 

7. Select Windows Active Directory for the restore job from the Selection tab. 

8. Run the restore job. 

9. Exit TapeWare. 

10. Restart the computer, letting Windows load normally. 

11. Verify that Windows active directory is running properly. 
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Appendix B — Troubleshooting Guide 

This appendix contains useful information about commonly encountered problems and 
frequently asked questions when using TapeWare. 

In This Appendix 

• Troubleshooting Backup Jobs 

• Troubleshooting Restore Jobs 

• Troubleshooting Verify Jobs 

• Troubleshooting Backup Devices 

• Troubleshooting the Storage Management Database 

• Troubleshooting Error Messages 

Note  Please refer to the TapeWare Installation Guide for useful information about 
installing TapeWare. 

Troubleshooting Backup Jobs 

When I run a backup job, it uses the backup device on my local machine 
instead of the one on the server. 

On the Options tab of the job, you have probably accepted the default Network device 
selection. When this is enabled, TapeWare will use any device on the network, in this 
case, your local backup device. 

To send the job to a specific device: 

1. Access the Options tab for the backup job. 
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2. Delete the current network device: 

a. Select the path to the device in the Device field. 

b. Click Delete. The path disappears from the Device field. 

3. Add the local device: 

a. Click Add. The Browse screen appears. 

b. Select the local device. 

c. Click OK. The path to the local device appears in the Device field. 

My scheduled job is not running. 
First, make sure the job is scheduled. Check the Schedule tab for the job’s properties. 
After reviewing the schedule, close the properties sheet or the job will not run. Then 
check the Queue tab to verify that the job is scheduled. 

Second, if you have not installed TapeWare as a service, make sure TapeWare is open 
and running. If you exit TapeWare, the job cannot execute. We recommend that you log 
out of TapeWare to prevent unauthorized access to TapeWare. 

Third, if you have installed TapeWare as a service, make sure the service has been 
started. 

To start the service on a Windows computer, access TapeWare Service Control from 
the Start menu. 

On a Linux or UNIX computer, open a terminal window (if necessary). Then access the 
directory where you installed TapeWare, e.g., usr/local/tapeware. Type ./twunxsvc. 

For additional information, see Automatically Running Scheduled Jobs in Chapter 8 — 
Running Jobs and Logging Out and Running Scheduled Jobs in Chapter 2 — TapeWare 
Workplace. 

I have two tape drives, but it is only using one to run a job. 
TapeWare uses “streams” to divide a job up and to assign the job to devices for backup. 
By default, it creates a new stream for each disk volume to be backed up, e.g., one each 
for C: and D: drives. If you only have a single volume, TapeWare only creates one 
stream by default. 

To use multiple devices, you must first add each device to the device list. Access the 
Options tab for the backup job. Then click Add to display the Browse screen. Select the 
local device and click OK. The path to the local device appears in the Device field. 
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To create additional streams for different objects, change the Backup stream parameter 
to Create new stream on the Storage tab for each object. Then the streams will be 
distributed evenly across all available backup devices. For further information, see 
Storage Tab in Chapter 12 — Object and Property Reference and Strategies for Faster 
Jobs in Chapter 10 — Tips, Techniques and Strategies. 

Note  Since multiple streams run concurrently, creating multiple streams on the same 
physical disk drive does not necessarily result in faster backup jobs. The drive tries to 
stream to multiple devices at once, which requires numerous seek and read commands 
from various sectors at the same time. 

How do I replace media in a rotation group? 
TapeWare automatically creates a series of folders and media for use with rotation jobs. 
These folders control the daily, weekly, monthly and yearly media. 

To remove a media that is lost or damaged physically, select the media on the Media tab 
and delete it. When you use replacement media, TapeWare will automatically format it if 
necessary. 

To move media to an offsite location, create a new media folder called Offsite Media (or 
similar) in your User/Group folder. Then drag the media to this folder. If the media is 
required by TapeWare during the rotation schedule, it will automatically create a new 
media to replace the media that you moved offsite. 

How can I tell when the next job will run and which media is required? 
Click on the Wizards tab and select Instructions and Logs. 

How can I easily view the logs for each job? 
Click on the Wizards tab and select Instructions and Logs. Tab to the Logs screen and 
view any available log. 

How can I determine which files were not backed up? 
Check the Details section of the job log for any failed objects. Access the Logs tab for 
the backup job and select the date of the backup you want to check. TapeWare uses the 
text editor specified on the Preferences screen to display the job log. Then you can save 
the log to a file after editing. TapeWare can also print the log directly to the printer. 

Note  You are only working with a copy of the log. The original log is still available. 
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Troubleshooting Restore Jobs 

I can’t restore a backup to a different operating system. 
Windows, NetWare, DOS, Linux and UNIX systems store information in different 
formats. For example, if you backed up NetWare information in a compressed format, 
Windows cannot read the NetWare compressed data. 

To restore to a different operating system, even to a different version of the same 
operating system, you must create the backup in a generic format. 

Note  If you did not create your backup in a generic format, you may not be able to 
restore it to a different operating system. You should either restore it on a similar 
operating system or create a new backup. 

1. Access the backup job’s Options tab. 

2. Click the Advanced options button. The Advanced Options window for the job 
appears. 

3. Deselect the Native data streams format option. When you run the backup job, 
TapeWare decompresses the data and strips the information specific to the operating 
system before backing it up. 

Note  You may lose security information under certain operating systems. 

For additional information, see Moving Data Between Operating Systems in Chapter 10 
— Tips, Techniques and Strategies. 

How can I restore data to a different file name? 
Select the file, directory or volume you wish to restore with a different name. Then open 
the properties sheet for that object. On the General tab, type in the new name and press 
OK. 

For additional information, see Restoring Files with New Names in Chapter 10 — Tips, 
Techniques and Strategies. 



Appendix B — Troubleshooting Guide 299 

 

How can I restore data to another location? 
To restore data to another location, open the Selection tab of the restore job. Click on the 
directory or file you want restored to a different location, then drag that object to the new 
target location. To use the keyboard, use CTRL+C to copy the object and CTRL+V to move 
the object to its new location. 

If you have not backed up the target directory, that is, the directory to move the files to, it 
will not be displayed. In this case, right-click the files or directories to move and then 
select Move from the shortcut menu. In the Confirm Move window, click Browse to 
select a new target location. 

How can I restore all the files from a single instance? 
Every instance of a file or directory backed up during a single job has the same instance 
date. You can use this information to select all the files from a single backup job. 

On the Selection tab of the restore job, highlight the file, directory or volume to restore. 
Press the Select Instance button on the tool bar to open the Instances of… window. 
Select the date of the instance you want restored. All children (objects) having the same 
instance will also be selected. 

For additional information, see Selecting Instances from a Specific Job in Chapter 10 — 
Tips, Techniques and Strategies. 

How can I determine which files are on particular media? 
Click on the Wizard tab and select Media Content. Follow the tree and pick the media 
you want information about. 

When restoring, I get many alerts. What is wrong? 
If you select many devices or set the Device field on the Options tab of the job to 
Network (the default setting), TapeWare will attempt to complete the restore job using 
all the devices listed or found. If a device does not contain media or the device contains 
the wrong media, an alert is sent. This alert informs you to put the desired media into the 
appropriate device. 

For example, suppose you are restoring from a single media but the Device field on the 
Options tab lists four devices. If the target media is in the third device listed, TapeWare 
will issue two alerts, one for each of the first two devices. These alerts can be ignored. 

Also note that you do not have to insert the requested media into the device. To fulfill the 
request, you can place any media required by the job into the device. TapeWare will then 
use the media that you actually did put into the device. 
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If you want the job to use a specific device, first delete the Network object in the Device 
field. Then click Add and add the specific device you want the restore job to use. 

Does TapeWare back up files as compressed? 
TapeWare will copy files to tape in compressed format without decompressing them first. 
This significantly enhances the speed of the backup. 

Troubleshooting Verify Jobs 

I occasionally get a ‘stream sync error’ when verifying media. 
This is usually caused by a physical read problem from the backup device. The data 
TapeWare expected from the media was not found. This can be caused by: 

• Bad media: Try replacing the media. 

• Read errors on the drive: Try cleaning the drive heads. 

• SCSI errors: Try checking the SCSI termination. 

• Driver errors: Try checking to see that you are not using a real mode ASPI drive. 
Check your config.sys file for something like: 

 device=ASPI4DOS.SYS, ASPI8DOS.SYS... 

Troubleshooting the Storage Management Database 

How do I select the location of the storage management database in a 
network installation? 

The network location of the storage management database can be very important. On 
larger networks, to minimize the time required to perform disaster recovery, install the 
storage management database on a dedicated storage management server. This server 
performs no operations except the storage management processing. Then install the tape 
devices to the servers to be backed up. If the storage manager server fails, no data is lost 
and recovery of the server can proceed in a non-critical manner. If any other server fails, 
recovery can be quickly performed because the storage server is still operational. 
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On smaller networks, you can install the storage management database on the same 
server as the tape devices. Recovery does not take as much time because the databases 
are smaller. 

For additional information, see Managing the Storage Management Database in Chapter 
10 — Tips, Techniques and Strategies. 

How do I create a storage management zone? 
When you install TapeWare, you can choose to either join an existing storage 
management zone or create a new zone. The storage management zone is associated with 
the same computer on which its database is installed. 

To create a new storage management zone, run the TapeWare installer. When prompted, 
enter the name for the zone and the disk location for the zone database. The default 
location is the TapeWare directory on your system, e.g., c:\Program Files\TapeWare 
on a Windows computer. 

For additional information, see Chapter 2 — Windows Operating Systems and Chapter 3 
— Non-Windows Operating Systems in the TapeWare Installation Guide. 

When recovering from a storage server failure, does TapeWare recover all 
of the database information? 

Most of the database information is restored when you restore the storage management 
database. The only thing that will not be restored is the complete log of the job that was 
running when the database was backed up. The reason for this is that the log is not 
written until after the job has completed. Jobs are not completed until the database is 
written to the media. 

Troubleshooting Error Messages 

Error 51 – Database corrupt appears during a backup or when adding a 
new object. 

Normally, if the database is corrupted, TapeWare automatically repairs it during 
initialization. However, the quick check used during initialization may not detect any 
errors. To force TapeWare to repair the database: 

1. Stop the TapeWare service. 
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2. Edit the TapeWare.ini configuration file in the directory where you installed 
TapeWare. Change the line that reads repairDatabase=No in the [configuration] 
section to repairDatabase=Yes. 

3. Start TapeWare. 

4. When the database repair message appears, click Yes. TapeWare automatically 
repairs the database and changes the configuration file line back to 
repairDatabase=No. 

Error 212 – Unknown error appears when I restore files under Windows. 
Windows stores security information in the data stream on the backup media. This 
information depends on the registry from the file’s original location. If you are restoring 
to a different system or are restoring files to the same machine with a new registry, the 
security information on the media is no longer valid. 

To prevent this problem, open the Advanced Options window from the Options tab of 
the restore job and clear the Parent security and Child security options. This causes 
TapeWare to restore the data in the file, but not the security information, such as the 
owner or access control lists for the file. 

Error 630 – Unable to create a directory appears when I restore files under 
Windows. 

This message appears if you do not have the appropriate Windows rights to the hard drive 
during the restore. Make sure you have full control on the CREATOR OWNER and 
SYSTEM rights on the Local Disk Properties screen for the hard drive. Then try again. 
After you have restored the files, you can change the Windows rights to their original 
settings. 
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